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Safety Information

General
The Waters Micromass Q-Tof Premier™ is designed solely for use as a mass 
spectrometer; any attempt to use it for any other purpose is liable to damage 
the instrument and will invalidate its warranty.

The mass spectrometer conforms to European standard EN61010-1:2001, 
Safety Requirements for electrical equipment for measurement, control, and 
laboratory use - Part 1: General requirements.

The instrument has been designed and tested in accordance with recognized 
safety standards. If the instrument is used in a manner not specified by the 
manufacturer, the protection provided by the instrument may be impaired.

Whenever the safety protection of the instrument has been compromised, 
disconnect the instrument from all power sources and secure the instrument 
against unintended operation.

The instrument must be installed in such a manner that the user can easily 
access and isolate the power source.

Biological Hazard
When you analyze physiological fluids, take all necessary precautions and 
treat all specimens as potentially infectious. Precautions are outlined in “CDC 
Guidelines on Specimen Handling,” CDC – NIH Manual, 1984.

Chemical Hazard
Good Laboratory Practice should be followed when using potentially toxic, 
biohazardous, caustic, or flammable solvents and analytes.

Flammable Solvents Operation Hazard
Caution: If the nitrogen supply pressure falls below 4 bar, the instrument will 
switch off the nitrogen supply and admit air into the source. If flammable 
solvents are used, there is a potential ignition hazard.

If flammable solvents are used, you should ensure that the nitrogen supply 
pressure will not fall below 4 bar during the analysis. Also ensure that the gas 
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fail connection is connected to the HPLC system to ensure that the LC flow is 
stopped if the nitrogen supply fails.

Eye Protection

High Voltage Hazard

Certain areas of the instrument may have high voltages present when the 
instrument is in Operate. These areas are shown in the Figure titled “Q-Tof 
Premier High Voltage Hazards - ESI Operation” on page v, showing the 
instrument configured for ESI operation.

Waters recommends that any columns, T-pieces, and other metal fittings 
connected to the ESI probe should be earthed. Eluent (which may be highly 
conductive) travels from a column and/or splitter to the probe. Any splitters 
and columns may become live and a small static-like shock may result if the 
user handles them.

High temperature hazard

The source enclosure assembly may be at high temperature, as shown in the 
Figure titled “Q-Tof Premier High Temperature Hazards - ESI Operation” on 
page vi, showing the instrument configured for ESI operation.

Warning: Wear suitable eye protection at all times when operating the 
instrument.

Warning: Certain areas of the instrument may have high voltages 
present when the instrument is in Operate. To avoid non-lethal electric 
shock make sure the instrument is in Standby before touching these 
areas.

Warning: To avoid electric shock (non-lethal), any equipment 
connected to the ESI probe (including columns) should be earthed.

Warning: To avoid burns, take care when working with the instrument 
as the source enclosure assembly may be at high temperature.
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Q-Tof Premier High Voltage Hazards - ESI Operation

Ion Block assembly

ESI and Reference probe tips

Motor and Capillary
connectors
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Q-Tof Premier High Temperature Hazards - ESI Operation

Safety Symbols
Warnings in this guide, or on the instrument, must be observed during all 
phases of service, repair, installation, and operation of the instrument. 
Failure to comply with these precautions violates the safety standards of the 
design and intended use of the instrument.

Waters Corporation assumes no liability for failure to comply with these 
requirements.

Source Enclosure assembly
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The following safety symbols may be used in this guide or on the instrument. 
A Warning is an instruction that draws attention to the risk of injury or death. 
A Caution is an instruction that draws attention to the risk of damage to the 
instrument

Consignes de sécurité

Généralités
Le Q-Tof Premier de Waters Micromass est destiné exclusivement à être 
utilisé comme spectromètre de masse. Tout usage détourné du Q-Tof Premier 
risquerait d’endommager l’instrument et invaliderait sa garantie.

Le spectromètre de masse Q-Tof Premier de Waters Micromass est conforme à 
la norme européenne EN61010-1 (2001) : Règles de sécurité pour appareils 
électriques de mesurage, de régulation et de laboratoire. - Partie 1 : 
prescriptions générales.

Cet instrument a été conçu et testé dans le respect de normes de sécurité 
approuvées. Toute utilisation de l’instrument non conforme aux instructions 
du fabricant risque de remettre en cause la protection assurée par 
l’instrument.

Dans le cas où la sécurité de l’utilisateur se trouverait compromise, 
débranchez le cordon d’alimentation de l’instrument et assurez-vous qu’il ne 
pourra être mis en marche par mégarde.

L’instrument doit être installé de façon à faciliter l’accès de l’utilisateur au 
bloc d’alimentation électrique.

Risques liés à l'usage de solvants inflammables
Attention: Si la pression d’alimentation en azote tombe en dessous de 4 bars, 
l'instrument bloque automatiquement l'arrivée d'azote et déclenche une arrivée 
d'air dans la source. L'usage de solvants inflammables implique l'existence d'un 
risque d'ignition.

Lorsque vous utilisez des solvants inflammables, assurez-vous que la pression 
d'alimentation en azote ne tombe pas en dessous de 4 bars en cours d'analyse. 
De plus, assurez-vous que la connexion Gas Fail est correctement raccordée au 
système HPLC, de sorte que le débit LC soit interrompu en même temps que 
l'alimentation en azote.
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Protection des yeux

Risques d’électrocution

Lorsque l'instrument est en mode de fonctionnement ou « Operate », certaines 
parties de l’instrument sont soumises à des tensions très élevées. Ces parties de 
l’instrument sont indiquées dans les figures 1 et 2. La Figure titled “Q-Tof 
Premier High Voltage Hazards - ESI Operation” on page v montre 
l'instrument configuré pour un usage en mode d’ionisation electrospray (ESI).

Waters recommande que toutes les colonnes, raccords en T, et autres pièces 
métalliques reliées à la sonde ESI soient mis à la terre. L'éluant (qui peut être 
fortement conducteur) va d'une colonne et/ou d'un diviseur de débit à la sonde. 
Les diviseurs et les colonnes peuvent se charger et provoquer une petite 
décharge électrostatique si l'utilisateur les manipule. 

Risques de brûlure

La source, représentée aux figures 3 et 4, peut atteindre des températures très élevées. La 
Figure titled “Q-Tof Premier High Temperature Hazards - ESI Operation” on page vi 
montre l'instrument configuré pour un usage en mode ESI.

Avertissement:  Portez à tout moment des lunettes de protection 
appropriées lorsque vous utilisez l'instrument..

Avertissement:  Certaines parties de l'instrument peuvent être 
soumises à des tensions électriques élevées lorsque l'instrument est en 
mode de fonctionnement. Pour éviter toute électrocution accidentelle, 
veuillez placer l'instrument en mode veille.

Avertissement:  Pour éviter toute décharge électrique (non-mortelle), 
les équipements reliés à la sonde ESI (à ionisation par électrospray), 
colonnes y compris, devraient être mis à la terre.

Avertissement:  Pour éviter toute brûlure, faites attention lorsque vous 
travaillez à proximité de la source car elle peut atteindre des températures 
très élevées.
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Pictogrammes de sécurité
Les avertissements présents dans le manuel de l’utilisateur ou sur 
l’instrument-même doivent être scrupuleusement pris en considération, et ce 
à tout moment, que ce soit pendant l’entretien, la réparation, l’installation ou 
le fonctionnement de l’instrument. Tout défaut d’application de ces règles de 
sécurité serait considéré comme une violation des normes de sécurité relatives 
à la conception et à l’usage prévu de l’instrument.

Waters ne saurait voir sa responsabilité engagée en cas de manquement de 
l’utilisateur à respecter les consignes de sécurité.

Vous pourrez rencontrer les pictogrammes qui suivent dans le manuel de 
l’utilisateur ou sur l’instrument. Est appelée Avertissement toute instruction 
destinée à attirer l’attention de l’utilisateur sur l’existence d’un risque de 
blessure ou de mort. Est appelée Attention toute instruction destinée à 
informer l’utilisateur de la présence d’un risque d’endommagement de 
l’instrument.

Warning: This is a general warning symbol, indicating that there is a 
potential health or safety hazard; the user should refer to this operators 
guide for instructions.

Avertissement:  Risque de blessure de l’utilisateur ou risque 
d’endommagement de l’instrument. Consultez le manuel de l’utilisateur 
pour instructions.

Warning: This symbol indicates that hazardous voltages may be 
present.

Avertissement:  Présence de lignes haute tension.

Warning: This symbol indicates that hot surfaces may be present.

Avertissement:  Ce pictogramme indique la presence de surfaces 
chaudes.

Warning: This symbol indicates that there is danger from corrosive 
substances.

Avertissement:  Substances corrosives.
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Caution: Indicates care must be taken to avoid damaging the equipment or 
affecting its operation.

Attention: Utilesez l’intrument en faisant preuve de beaucoup de précaution 
pour éviter de l’endommager et ainsi nuire à son fonctionnement.

Warning: This symbol indicates that there is danger from toxic 
substances.

Avertissement:  Substances toxiques.

Warning: This symbol indicates that there is danger from flammable 
substances.

Avertissement:  Substances inflammables.

Warning: This symbol indicates that there is danger from laser 
radiation.

Avertissement:  Risque de radiations laser.

Warning: This symbol indicates that there is a danger from UV 
radiation.

Avertissement:  Risque de radiations UV.

Warning: This symbol indicates danger of contamination by a biological 
agent that constitutes a threat to humans.

Avertissement:  Ce pictogramme indique la présence d’un risque de 
contamination par un agent biologique constituant un danger potentiel 
pour l’utlisateur.
x



Symbols commonly used on the instrument
Direct current

Alternating current

Protective conductor terminal

Frame or chassis terminal

Warning, refer to the manual

Warning, risk of electric shock (high voltage)

Warning, hot surface or high temperature

Warning, risk of needle-stick puncture

Warning, ultraviolet radiation

Fuse

Electrical power on

Electrical power off

Keep upright, handling label

Keep dry, handling label

Fragile, handling label

l
0
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Q-Tof Premier Mass Spectrometer Information

Intended Use
The Waters Micromass Q-Tof Premier Mass Spectrometer can be used as a 
research tool to deliver authenticated exact mass. It is not for use in 
diagnostic procedures.

Calibration
Follow acceptable methods of calibration with pure standards to calibrate 
methods. Use a minimum of five standards to generate a standard curve. The 
concentration range should cover the entire range of quality-control samples, 
typical specimens, and atypical specimens.

Quality Control
Routinely run three quality-control samples. Quality-control samples should 
represent subnormal, normal, and above-normal levels of a compound. Ensure 
that quality-control sample results are within an acceptable range, and 
evaluate precision from day to day and run to run. Data collected when 
quality-control samples are out of range may not be valid. Do not report this 
data until you ensure that system performance is acceptable.
xii
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Overview

The Q-Tof Premier™ is a hybrid orthogonal acceleration Time-of Flight 
(oaTof) mass spectrometer that enables automated exact mass measurement 
of precursor and fragment ions to yield the highest confidence in structural 
elucidation and databank search results.

Source
The Q-Tof Premier combines the high transmission efficiency of ZSpray source 
technology with the latest in T-Wave ion optics. The built in LockSpray™ or 
optional NanoLockSpray™ capability enables routine exact mass 
measurement in MS and MS/MS modes. Equipped with a standard 
electrospray ionization (ESI) and with atmospheric pressure chemical 
ionization (APCI), atmospheric pressure photoionization (APPI) available as 
options, the Q-Tof Premier offers a wide range of atmospheric pressure 
ionization (API) techniques:

• ElectroSpray ionization

Pusher Detector

Quadrupole

DRE Lens

Reflectron

T-Wave
Collision Cell

Transfer Optics

T-Wave
Ion Guide

Lockmass
Reference Sprayer

Analyte
Sprayer

Flight Tube
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Electrospray ionization (ESI) takes place as a result of imparting a 
strong electrical charge to the eluent as it emerges from the nebulizer. 
An aerosol of charged droplets emerges from the nebulizer. These 
undergo a reduction in size by solvent evaporation until they have 
attained a sufficient charge density to allow sample ions to be ejected 
from the surface of the droplet (ion evaporation).

A characteristic of ESI spectra is that ions may be singly or multiply 
charged. Since the mass spectrometer separates ions according to their 
mass-to-charge ratio (m/z), compounds of high molecular weight can be 
determined if multiply charged ions are formed.

Eluent flows up to 1 mL/min can be accommodated although it is often 
preferable with electrospray ionization to split the flow such that 5 to 50 
µL/min of eluent enters the mass spectrometer.

The optional NanoLockSpray interface allows electrospray ionization to 
be performed in the flow rate range 5 to 1000 nL/min.

For a given sample concentration, the ion currents observed in nanoflow 
are comparable to those seen in normal flow rate electrospray. Due to 
the great reduction in sample consumption, there are great gains in 
sensitivity when similar scan parameters are used.

• Atmospheric pressure chemical ionization

APCI generally produces protonated or deprotonated molecular ions 
from the sample via proton transfer (positive ions) or proton abstraction 
(negative ions). The sample is vaporized in a heated nebulizer before 
emerging into a plasma consisting of solvent ions formed within the 
atmospheric source by a corona discharge. Proton transfer or abstraction 
then occurs between the solvent ions and the sample. Eluent flows up to 
2 mL/min can be accommodated without splitting the flow.

• Atmospheric pressure photoionization

APPI uses photons generated by a krypton discharge UV lamp 
(~10.2 eV) to produce sample ions from vaporized LC eluent. Direct 
photoionization of the sample molecule occurs when the photon energy is 
greater than the ionization potential of the sample molecule.

The APPI source option incorporates a UV lamp. The sample is 
introduced into the source via the APCI IonSABRE probe. This produces 
a stream of sample and solvent species that undergo photon-induced 
ion-molecule reactions. 
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An electrode, known as a repeller, is used to deflect and focus the sample 
ions produced towards the sample cone for introduction into the mass 
spectrometry system for analysis.

Analyzers
Q-Tof technology provides both quadrupole (MS1) and Time-of-flight (ToF) 
mass analyzers, with an intermediate collision cell for fragmentation, if 
required. This powerful combination allows ions to be selected, individually 
fragmented, and then measured to a high degree of mass accuracy by the 
oaToF.

Quadrupole

The quadrupole is available with 4, 8 and 32 kDa mass range options, and can 
can be operated:

• With the quadrupole resolving DC off (wide bandwidth mode). In which 
case ions can pass through MS1 and be accurately measured by the ToF 
in what is known as a Tof MS acquisition.   

• With the quadrupole resolving DC switched on. The quadrupole can 
either be parked on one specific mass (Tof MS/MS) or can be made to 
scan through a wide mass range in search of candidate ions for 
fragmentation (parent ion scanning). 

• With the instrument automatically switching between Tof MS and Tof 
MS/MS modes depending on the ions are detected during the Tof MS 
scan. This is known as data directed analysis (DDA) and is a very 
powerful diagnostic tool when combined with an LC system. 

Tof analyzer

The ToF analyzer uses a high voltage pulse to orthogonally accelerate the ions 
down the flight tube and a reflectron to reflect them back again towards the 
detector (V-optics). Ions of different mass-charge ratio will have different 
flight times and hence a mass spectrum can be created with a resolution of 
10 000 (FWHM). The mass range of the ToF analyzer is dependent on the 
frequency of the pusher pulse with a maximum m/z of 100 000 in V mode. 
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Ion Optics in V-mode:

The Q-Tof Premier Tof analyzer is also equipped with a second reflectron that 
enables the beam to traverse the flight tube twice. This doubling of the flight 
path (W-Optics) enables resolution of 17,500 (FWHM). 

Ion optics in W-mode:

W lens
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Detectors
The Q-ToF Premier is equipped with two detectors:

• A photomultiplier tube (PMT).

The PMT is situated in the head behind the pusher stack and is 
designed to record ion arrivals from the MS1 analyzer without the ions 
being fired down the ToF. 

• A micro-channel plate / time-to-digital converter (MCP/TDC). 

The MCP/TDC detector accurately records the ion arrival time after they 
have travelled the flight tube.
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Front panel

The front panel of the Q-Tof Premier includes instrument and vacuum status 
LED indicators. Gas connections are color-coded for easy connection. 
Electrical connector types differ according to function, preventing errors.

There is also an embedded PC (EPC) reset button and a Standby button.

Q-Tof Premier front view:

Syringe pump

Modular source

ESI probe

EPC Reset button
Standby buttonLED indicators

Front panel door
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Removing instrument covers

Front panel connections
The front cover connections are located on the top right of the instrument 
behind the Front panel door

Warning: Removing instrument covers will expose hazardous voltages. 
These covers should only be removed by a Waters field service 
engineer. No user serviceable parts are inside.
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Front panel connections:

Connection Description
Heater/Interlock This is the desolvation heater socket and it also 

provides the interlock connection for source options.

Desolvation This is the desolvation gas connector. It is color-coded 
yellow, and should be attached to the yellow gas line 
from the probe adjuster.

NanoSpray This is the NanoFlow™ gas connector: It is color-coded 
blue and should be connected to the NanoFlow sprayer.

Capillary These are the capillary voltage sockets. The cables 
from the ESI probe, NanoFlow sprayer LockSpray 
reference probe and the reference sprayer flange 
should be plugged in here. It is not used in APCI mode.
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Modular LockSpray source
You can easily configure the LockSpray™ modular source for several source 
configurations.

Nebuliser These are the nebulizer gas connections. They are 
color-coded red, and should be attached to the red gas 
line from the ESI or APCI probes. A blank plug should 
be inserted if the connectors are unused.

Motor This is the motor drive socket. The cable from the Lock-
Spray and NanoLockSpray motors should be plugged 
in here.

Syringe This is the earthing point for the syringe. Plug the 
ground cable from the syringe into this socket.

APPI This is the UV lamp socket. The cable from the UV 
lamp should be plugged in here. This socket is only 
used in APPI mode.

MALDI This is the MALDI socket. The cable from the MALDI 
assembly should be plugged in here.

Connection Description
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Modular source schematic:

APPI assembly

Blank side flange

Reference assembly

Ion Sabre APCI probe

APCI baffle

Standard 
baffle

ESI Probe

Special corona pin
Standard corona pin
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To change the source configuration:

Caution: Check that the probe Interlock Active is not displayed in the bottom 
right of the Tune window when changing a source. If it is, refit each flange so 
that it is flush with the source housing.

1. Switch the instrument to Standby mode. Check that the operate LED 
turns red.

2. Switch off the API gas flow.

3. Disconnect modules from the gas and power as necessary.

4. Undo the thumbscrews and remove the appropriate modules.

5. Fit the required modules, by tightening thumbscrews.

6. Connect the gas and power to modules as necessary.

7. Switch on the API gas flow.

8. Switch the instrument to Operate. Check operate LED goes green.

Modular LockSpray source configuration guide:

Ionization mode Configuration
ESI LockSpray ESI probe + ESI baffle + LockSpray motor

APCI LockSpray IonSabre probe+ special corona pin + APCI baffle + 
LockSpray motor

APPI IonSabre probe + UV lamp

Dual APPI IonSabre probe + special corona pin +UV lamp

ESCi ESI probe + standard corona pin + blank side flange

Warning: The side flange is protected by micro-switches. These 
are intended to protect the operator from potential exposure to 
high voltages and UV radiation. Never attempt to override these 
micro-switches.

Warning: To avoid possible burns and/or contamination, be 
aware that modules removed from the source may be hot 
and/or contaminated with toxic substances.
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Tip:  If operate LED is flashing green, the source interlock is active. 
Check that all modules are securely fitted and that the source door is 
closed. Check that the probe adjuster is connected to the interface panel.

Installing the electrospray probe

If not already fitted the instrument requires the installation of a probe. In this 
case we shall install the electrospray probe. The use of other probes is 
described in later chapters.

To install the electrospray probe:

1. Remove the protective sleeve, if fitted, from the electrospray probe tip.

2. Carefully slide the probe into the hole in the probe adjuster.

Warning: The probe and source may be contaminated with 
biohazardous and/or toxic materials. Always wear nitrile gloves 
while handling these components

Warning: The probe and source are liable to be hot. To avoid burns, 
take great care while working with the instrument’s front access door 
open.

Warning: To avoid electric shock, ensure that the instrument is in 
standby before commencing tis procedure.
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Probe adjustment flange:

3. Secure the probe by tightening the two thumbscrews.

4. Connect the probe adjustment flange electrical cable to the 
Heater/Interlock on the front panel.

5. Connect the probe adjustment flange PTFE tubing to the yellow 
Desolvation gas connection on the front panel.

6. Connect the probe PTFE tubing to the red Nebulizer gas connection on 
the front panel.

7. Connect the probe electrical lead to the Capillary connection on the front 
panel.

ESI probeProbe adjuster
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Status displays

The vacuum and operate status light emitting diodes (LEDs) are located to the 
right of the main panel on the instrument. The LEDs indicate the status of the 
pperate and the vacuum systems. 

Warning:  A green or flashing green Operate LED indicates the 
presence of high voltages.

Warning:  A flashing amber or flashing red Operate LED indicates an 
abnormal condition, where high voltages may be present.

Operate LED display

Color Status

Green Operate.

Flashing Green Operate, probe interlock active. Capillary voltage, cone 
voltage, and desolvation heater off.

Amber Over-pressure trip.
Voltages switched off because Tof vacuum is out of 
range.

Red Standby.

Off Power off.

Flashing Amber Unexpected error - invalid state.

Flashing Red Quadrupole RF Trip.
Press standby to reset.

Flashing Red, 
Green

API Gas has failed, source voltages have been tripped 
out. Restore gas then press operate to reactivate source 
voltages.

Vacuum LED display 

Color Status

Green Vacuum OK

Flashing Green Pumped (all turbo pumps at >80%) but Tof vacuum out 
of range.

Amber Turbo Pump on, one or more at <80% speed

Flashing Amber Turbo pump off, one or more at <80% speed
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Pump-Down sequence

The Pump-down sequence as indicated by the vacuum LED lights as follows.

1. Flashing amber

Rough pump on, soft vent off.

2. Amber

Turbo pumps on, one or more at <80%.

3. Flashing Green

All turbo speeds are >80%, the Tof Penning gauge turns on. 

4. Green

When the Tof pressure falls below 3.9 x. 10- 6 mbar

Vent sequence

The vent sequence as indicated by the vacuum LED lights is as follows.

1. Flashing Green / Amber

Turbo pumps off, Tof Penning Gauge off.

2. Off

All Turbo speeds <80%, soft vent and rough pump off.

Off Vented / pumps off

Multi color Abnormal operation

Vacuum LED display (Continued)

Color Status
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Rear panel

Mains power unit

Connections on mains power unit:

Vacuum

This is the vacuum power switch. When in the off position (1 = on, 0 = off), 
power is disconnected from vacuum pumps.

Electronics 

This is the control electronics power switch. When in the off position (1 = on, 
0 = off), power is disconnected from the main control electronics, the EPC, and 
auxiliary components.
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EPC & Auxiliary

This is the EPC power switch. When in the off position (1 = on, 0 = off), power 
is disconnected from the embedded PC.

Pump Control

This is the pump control socket. The cable from the scroll pump should be 
plugged in here. This allows the instrument to switch the scroll pump on and 
off.

Supply Inlet

This is the mains power input socket. The cable from the laboratory mains 
power supply should be plugged in here.

Pump Override

This is for service use only and should always be left in the Auto position

Isolating the instrument from the mains
Before switching off the instrument it is advisable to vent the instrument in a 
controlled manner.

To isolate the instrument:

1. Set the Electronics and Vacuum power switches to Off.

2. Disconnect the mains supply inlet cable from the rear panel.

Connecting the instrument to the mains
Before connecting the instrument to the mains power, ensure that the mains 
supply meets the requirements on the instrument ratings plate. Connect 
using the appropriate supply cable to an earthed mains supply outlet.

Gas connections
All the gas connections are found on the bottom-right on the rear of the 
instrument.
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Gas connections on rear panel:

Nitrogen Gas In

Caution: To avoid chemical contamination of the source, use only PTFE 
tubing, or clean metal tubing, to connect between the nitrogen supply and the 
instrument. Using other types of plastic tubing will result in chemical 
contamination of the source.
Caution: If the nitrogen supply pressure falls below 4 bar, the instrument will 
switch off the nitrogen supply and admit air into the source. If flammable 
solvents are used, there is a potential ignition hazard.

Warning: To avoid injury from high pressure nitrogen, ensure nitrogen 
gas is switched off when changing gas connections.
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Connect the nitrogen supply (100 psi, 7 bar) to the Nitrogen Gas In push-in 
connector using 6-mm PTFE tubing. If necessary, this tubing can be connected 
to ¼-inch tubing using standard ¼-inch fittings.

Exhausts

Caution: Do not connect source and scroll pump exhausts as, in some 
circumstances, scroll pump exhaust could be admitted into the source 
chamber producing severe contamination.

Source

Connect the gas exhaust using 12-mm plastic tubing connected to the push-in 
fitting.

Source waste and LC waste

Waste liquid from the top of the instrument and the source is drained from the 
instrument via the Source Waste and LC Waste outlets. The liquid must be 
passed to a suitable container, which you must empty at regular intervals.

The 2-L waste bottle must be connected to the 12-mm Source Waste Port on 
the instrument rear panel to capture any liquid leaking into the source.

Connecting the waste bottle

This waste system involves the use of a single continuous waste line between 
the source and the source waste outlet on the instrument rear panel. This 
then connects directly to a solvent waste trap bottle assembly that also 
includes a series of one-way valves.

Warning: Due to the potential hazardous nature of the exhaust 
gasses, the source gas exhaust and drain, which also contains 
solvent vapors, should be vented via a separate fume hood, 
industrial vent or cold trap.

Warning: The waste liquid from the source enclosure and the LC 
comprises solvents and analytes. Always wear nitrile gloves while 
handling the container, and ensure that waste liquid is correctly 
disposed of according to local environmental regulations.
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Waste bottle connections:

Valve 1 on the 10 mm exhaust line connects to the nitrogen exhaust. Under 
normal operation this valve opens to allow source gases and vapor to escape. 
However, when no API gas is supplied, this valve is closed and stops back flow 
of gas from the customer’s exhaust line. There is an exhaust valve between the 
nitrogen exhaust and Valve 1. This is closed during source pressure testing 
but left open at all other times.

Valve 2 is connected so air will be admitted into the instrument waste system 
if a partial vacuum is formed in the source or instrument’s drain. However, if 
the waste line is at a positive pressure, then the valve is held closed.

Exhaust

Instrument

Valve 2

Valve 1

Exhaust valve
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Scroll pump

Side panel

External IO board
The IO board is found on the left-side of the instrument.

IO board:

Analog Channels

Eight analog input channels are available, for acquiring simultaneous data 
such as a UV detector output. The input differential voltage is 0 to 2.5 V.

Warning: Due to the potentially hazardous nature of exhaust 
gasses, the exhaust from the scroll pump should be vented to 
atmosphere outside the laboratory.

Warning: Do not apply more than 2.5 V to any of the ANALOG 
CHANNELS connections.
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Contact Closure

Two types of contact closure are available:

• In – Four inputs, Events I/P, allow external devices to start acquisition. 
Each event input signal can be transistor-transistor logic or contact 
closure. The maximum voltage is 5 V.

• Out – Four outputs, Events O/P, allow the mass spectrometer to trigger 
an external event. The maximum rating is 25 V, 100 mA.

GAS FAIL

If the nitrogen pressure falls below 4 bar, while in Operate, the instrument 
goes into a “gas fail” state and a contact closure signal is generated. This 
signal can be used to stop solvent flowing into the source by connecting this 
GAS FAIL connection to the Stop Flow of the HPLC system. In the event of a 
nitrogen supply failure, any solvent from an LC will be drained automatically 
from the source enclosure. The maximum rating is 25 V, 0.25 A.

To return to Operate:

Restore the gas supply and click Operate.

CE Int (Capillary Electrophoresis Interlock)

This connector interfaces with a capillary electrophoresis power supply so that 
the instrument is safely interlocked against high voltages. The maximum 
rating is 25 V, 0.25 A.

Warning: To avoid electric shock and damage to the instrument, do 
not apply more than 5 V to any of the Events I/P connections.

Warning: To avoid electric shock and damage to the instrument, do 
not apply more than 25 V to any of the Events O/P connections.

Warning: To avoid electric shock and damage to the instrument, do not 
apply more than 25 V to the GAS FAIL connection.

Warning: To avoid electric shock and damage to the instrument, do not 
apply more than 25 V to the CE Int connection.
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Comms for EPC Link

This RJ45 connector links the instrument’s embedded PC to the MassLynx 
workstation using the network cable supplied.

COM1 and COM2

These connections can be used by a Waters Field Service Engineer to 
communicate with the embedded PC.

Service Bus

This connection can be used by a Waters Field Service Engineer to 
communicate with the instrument electronics.

LEDs

Top panel
Caution: Do not use the instrument top panel to store solvents.

Type Description
SPEED Green indicates normal operation.

Red or Off indicates a fault

DATA Flashes yellow during data transfers.
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2 Instrument Operation

This chapter will introduce the operator to the basic functional operation 
of the instrument; including basic software control, tuning and acquiring 
data. At this point the instrument should be pumped down and correctly 
installed.

Contents:

Topic Page
MassLynx 2-2

Tuning 2-7

RF settings 2-21

Acquiring data from the Tune window 2-23
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MassLynx

To open MassLynx and the Tune window:

1. From the Windows® desktop, double-click the MassLynx icon.

2. If applicable enter your logon name and password, and then click OK.

Tip: The Login dialog box appears only when you enable MassLynx 
security. Otherwise, the MassLynx Main window appears after you click 
the MassLynx desktop icon. See the MassLynx Security User’s Guide for 
details about enabling MassLynx security.

Result: The MassLynx main window appears.

Tip: After initiating, the main window displays “Instrument Present” in 
the status bar.

3. The shortcut bar should appear in the MassLynx main window, and 
Instrument should appear at its top. If it fails to appear, click Shortcut, 
in the toolbar, to open it. Then click Instrument, at the left edge of the 
shortcut bar. 

4. Select MS Tune to open the Tune window.

MassLynx window
The MassLynx window contains:

• A Banner, which displays the names of the current Project and Sample 
List.

• A top-level Menu bar.

• A Tool bar.

• An Information bar (below the Tool bar); this normally shows the status 
of the sample currently being acquired or processed.

• The MassLynx bar, with associated tabs, at the left-hand-side of the 
window. The contents of the MassLynx bar can be swapped between the 
Shortcut bar, Queue bar and Instrument Status bar, each of which has 
its own set of associated tabs and options.

• The Sample List Editor.

• A Sample List Menu bar (above the Sample List Editor), containing 
commands associated with the Sample List.
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• A Status bar, at the bottom of the window.

MassLynx window:

Tune window
The Tune window is the interface for instrument control, it is used for the 
following.

• Tuning the instrument

• Turning gases on and off

• Monitoring vacuum pressures

Menu bar

Sample List Editor

MassLynx Shortcut barStatus bar

Information barTool bar Sample List menu bar
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• Monitoring Acquisitions

• Calibrating the instrument for accurate mass

Tune window in “Tuning view”:

The Tune window contains:

• A Menu bar

• A tool bar

• Parameter tabs

• Status bar

• Peak display

Peak Display

Status bar

Menu bar
Tool bar
Parameter
tabs

Operate
Standby
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Peak display

The peak display allows real-time spectral data to be observed without 
acquiring or making a data file.

Quad and Tof peak display:

There are two Peak displays:

• Quad Peak display

This displays the signal on the photomultiplier tube using the 
quadrupole as the mass filter.

Tip: This is only used for diagnostic purposes and would not normally be 
used by anyone other than a Waters Field Service Engineer.

• Tof Peak Display

This displays the signal on the MCP detector using the Tof as the mass 
analyzer.

To switch between peak displays:

Select View > Quad Peak Display or Tof Peak Display

Quad Display

Tof Display
MassLynx 2-5



Resolution and ions per push

The peak display now indicates the resolution or the number of ions per push 
(IPP) for the largest peak in the window.

The resolution is indicated for continuum data and IPP is shown for centroid 
data.

Note: The resolution display will not be available until MassLynx 4.1.

Instrument control pages

Controls necessary for setting up the Q-TOF Premier are accessible in the 
Tune window from either toolbar or instrument control pages.

The source and instrument tabs are always visible: 

• Source page - controls source voltages, temperatures, gas flows, and 
syringe pump control.

• Instrument page - controls the quadrupole, collision cell and detector.

Note: The Source tab is labelled with the source type and instrument polarity, 
e.g. ES+ means electrospray source and positive ion mode.

Additional pages are available when you, select View > Tuning controls:

• Tuning page - controls voltages that affect instrument resolution. These 
controls are optimized on installation, and should not require further 
adjustment. 

• Diagnostics page - displays turbo pump information, pressures and 
selected instrument voltages.

Many more pages are available when you select View > Engineering controls. 
These additional pages are provided for use by Waters Field Service 
Engineers. This option is password protected and requires the password 
‘access’ to be entered.

Caution: The source and instrument pages provide sufficient control for 
day-to-day use of the Q-Tof Premier. The adjustment of parameters in any of 
the additional tabs is likely to degrade instrument performance.

To change the Tune window style:

1. Click View from the Tune window.

2. Select Tuning Controls, Extended Controls or Engineer Controls.
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Tuning

The following sections describe how to tune your instrument in two ways:

• Routine optimization for sensitivity using the source and instrument 
parameters.

This needs to be carried out on a sample by sample basis. This assumes 
that the complete tuning of the Tof has already been carried out and is 
saved in the currently loaded tune file.

• Complete tuning of the Tof from default settings. 

Your instrument will already have been tuned optimally from the 
factory set default settings by the installation engineer. You should only 
have to tune from these settings if MassLynx has to be reinstalled.

The purpose of the following tutorials is to show you how to get a mass 
spectrum from each of the Q-Tof Premier’s four modes using 2 standard 
compounds.

Important: All tuning in this chapter is done using the Tof and MCP detector. 
Click View > Tof Peak Display, to ensure that the Tof Peak Display is enabled.

Prerequisites: MassLynx on page 2-2.

Requirement: Ensure than analyte is selected if running in LockSpray mode.

Compounds and benchmark tests
Before using the Q-Tof Premier for routine analysis it needs to be “tuned”, in 
all four of its operating modes, to give maximum resolution and sensitivity. It 
is good practice to use a sample that is representative of the samples that will 
be analyzed.

The Q-Tof Premier, in Tof MS and MS/MS, can operate in the following ways 
and consequently requires tuning in each mode:

• V positive

• W positive

• V negative

• W negative

All four modes are saved to one tune file (*.ipr).
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The following procedure can be used to tune all ESI Tof MS modes of 
operation. It is a quick tuning method and not intended to be a performance 
specification. The tables below outline the compounds to use and the 
sensitivity and resolution that can be expected from them.

Routine optimization for sensitivity - Tof MS
This section is intended to demonstrate tuning for good sensitivity from a 
previously saved tune file.

Important: Keep the ion counts below the deadtime threshold (see Deadtime 
Correction on page 3-3 for more information).

Initial considerations

The following should be taken into account:

• Ensure that samples are fully dissolved in a suitable solvent. Either 
filter or centrifuge the sample to avoid blocking the transfer line.

• Syringes should be thoroughly cleaned to minimize sample carryover.

• An appropriate tune file, containing the optimized Tof parameters, 
should be loaded.

Warning: Use extreme care when working with formic acid. Use a fume 
hood and appropriate protective equipment.

Compounds for tuning:

Operating mode Compound to use

V and W positive Leucine enkephalin (m/z 556) 50 pg/µL 
(50:50 acetonitrile:water 0.1% formic acid)

V and W negative Raffinose (m/z 503) 500 pg/µL (50:50 
acetonitrile:water)

Sensitivity and Resolution for quick tuning:

Test V + V - W + W -

Sensitivity (cps) 200 200 50 50

Resolution (FWHM) 8000 8000 15000 15000
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Initial Setup

To set up the syringe:

1. From the Source page click  to open a drop down list of syringe types.

2. Select the appropriate syringe type e.g, Hamilton 250 µL.

3. Load the syringe with an appropriate compound and click  to switch 
the syringe on.

4. Enter a syringe rate of 5 µL/min to ensure a uniform, continuous spray 
that will last for a relatively long period.

Important: Some level of cyclical variation, due to the syringe drive unit, in 
signal strength should be expected. This should be limited to less than 10%, 
any more is a fault and should be reported for repair.

To set source tuning parameters for sensitivity:

1. From the Tune window click  to switch the instrument into Operate. 
Check that the adjacent instrument status indicator turns green. 
Ensure the syringe pump is on and the API and Collision gasses are on. 

Important: If the Q-Tof Premier has been in Standby for more than 2 
hours it should be left in Operate for 1 hour to allow the instrument to 
stabilize.

2. Click File > Open and select a tune file that contains the optimized Tof 
parameters.

Tip: The engineer will have left a tune file that contains the optimized 
Tof parameters, usually with the name HAAxxx.ipr where xxx is the 
instrument serial number

3. Specify these two settings to set the instrument mode:

• Click Mode > Positive Ion for or Negative Ion

• Click V or W to specify instrument mode.

4. Click  to switch the API gas on.

5. Click Setup > Tuning Settings to set the scan time and mass range.

6. In the Tuning Setup dialog box, enter the following values and click 
Update.
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Tuning Setup dialog box:

Tip: It may take a while for the sample to appear in the peak display 
window as any dead volume will need to be cleared first. Increase the 
syringe rate for a short period to push the sample through.

7. There will be a response in the peak display. Zoom in the relevant mass 
range, the peak display will resemble that shown in Figure titled “Tuned 
peak display:” on page 2-11.

Tip: The parameters on the Instrument page should not need changing 
at this time. 

Recommendation: To return the peak display to full span click .

8. Adjust the source and instrument settings up or down for maximum 
sensitivity. Refer to the Table titled “Source ES page parameters:” on 
page 2-12 and the Table titled “Instrument page parameters:” on 
page 2-13 for more details on each parameter. Ensure that you press 
enter after adjusting each parameter.

The Peak display should resemble the following figure.
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Tuned peak display:

9. Select File > Save As to save the tune settings and enter an appropriate 
name.

Important: The mass position may vary since the instrument has not 
been calibrated.

Tip: The tune settings are saved as a *.ipr file in the Acqudb folder of the 
current MassLynx project. 

See also: 
• A quick guide to the Source page settings on page 2-12

• Complete tuning of the Tof from default settings on page 2-15

Resolution
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• Acquiring data from the Tune window on page 2-23

• Calibration on page 3-1

A quick guide to the Source page settings

The tuning parameters on the Source ES window are used to optimize the 
ionization in the source, and control the introduction of ions into the 
instrument. They should be tuned for maximum sensitivity for each sample 
and infusion condition. These parameters do not influence Tof resolution 
except when the detector saturation limit has been exceeded, in which case 
the capillary voltage should be used to control the ion count. 

Source ES page parameters:

Parameter Description 
Capillary (kV) The voltage on the ESI probe tip. Normally tuned for 

maximum sensitivity. Can be used to decrease ion count to 
acceptable levels. Best sensitivity at 3 to 3.5 kV in positive 
ion mode, ~ 2.5 kV in negative ion mode.

Sampling Cone (V) Tune for best sensitivity. Sample and charge state 
dependent, usually best at 25 to 50 V. 

Extraction Cone (V) Tune for best sensitivity, usually 2 to 5 V.

Ion Guide (V) Tune for best sensitivity, usually 1 to 3 V. 

Source 
Temperature (°C)

 Usually left at 80 to 100 °C. 

Desolvation 
Temperature (°C)

Set high enough for complete desolvation of analyte spray. 
Solvent flow rate and solvent dependent. For a solvent flow 
rate of 300 µL/min, this usually 250 to 400 °C. 

Cone Gas (L/hr) Often left at zero, but can aid desolvation in some 
circumstances, e.g. nanoflow. Tune for maximum 
sensitivity, usually 0 to 50 L/h. 

Desolvation Gas 
(L/hr)

Used in combination with desolvation temperature to 
achieve complete desolvation of analyte spray. Tune for 
maximum sensitivity, usually 400 to 800 L/hour. 

Syringe Pump Rate 
(µL/min)

Set to desired flow rate. For ESI reference sprayer, this is 
usually 5 to 20 µL/min. 
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A quick guide to the Instrument page settings

The tuning parameters on the Instrument window are used to optimize the 
passage of the ions through the rail section of the instrument. They should be 
tuned for maximum sensitivity and may require adjustment when moving 
from Tof MS to Tof MS/MS modes. These parameters do not influence Tof 
resolution. 

Instrument page parameters:

Parameter Description 
LM Resolution The ‘low mass resolution’ slider controls the width of 

quadrupole transmission window, i.e. it controls the 
selectivity of the MS1 analyser. It is only applicable in 
MSMS mode. It is normally set to 4.7 (4000 Da quad) or 
4.9 (8000 Da quad). The transmission window will be 
about 4 Da. See Quadrupole resolution settings on 
page 2-14.

HM Resolution The ‘high mass resolution’ slider controls the width of 
quadrupole (MS1) transmission window at higher 
masses. Usually left at 15. 

Ion Energy (V) Controls the energy of the ions passing through the 
quadrupole. Will stop beam completely if set at less than 
approximately -1 V. Usually set to 0 to 1 V. 

Pre-Filter (V) Tune for maximum sensitivity, usually 5 to 10 V. Higher 
values will decrease the mass transmission window in 
MS mode. 

Collision Energy (V) Controls the energy of ions entering the collision cell. In 
MS mode this is usually set to 5 V, in order to avoid any 
fragmentation. In MSMS mode increase to give optimum 
fragmentation, usually 20 to 30 V. 

Cell Entrance 
(mL/min)

Always set to 2 V.

Cell Exit (mL/min) Always set to -10 V.

Collision Cell Gas 
Flow (V)

Adjust to give a collision cell pressure of 4 x 10-3 mbar. 
Usually about 0.45 L/min.

Ion Guide Gas Flow 
(V) 

Research applications only. Usually set to zero.
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Quadrupole resolution settings

The ‘low mass resolution’ (LM Resolution) slider controls the width of 
quadrupole transmission window, i.e. it controls the selectivity of the MS1 
analyser. It is only applicable in MSMS mode. It is normally set to 4.7 
(4000 Da quad) or 4.9 (8000 Da quad). In this case the transmission window 
will be about 4 Da, allowing transmission of isotopes.

If a monoisotopic MSMS spectrum is required, it is necessary to increase the 
LM resolution setting to about 15. The exact setting required is best 
determined by acquiring MSMS data and adjusting the LM Resolution setting 
while monitoring the spectrum in real time. The actual quad resolution 
required to select just one isotope is a function of charge state. The resolving 
capability of the quadrupole is a function of mass; low mass peaks can be more 
easily resolved than high mass peaks.

Tuning for Tof MS/MS
During MSMS acquisitions the quadrupole selects a mass to be fragmented. 
Instrument tune settings are identical to MS except apart from the following:

• LM and HM Resolution controls are active, and are used to set the 
required selectivity

• Collision energy is increased in order to induce optimal fragmentation. 

The amount of collision energy required will depend on the charge state and 
the stability of the ion. The Q-TOF Premier can be set to ramp between 
collision energy values, allowing efficient fragmentation over a range of 
different ions.

For details on how to set up Tof MS/MS experiments and Collision energy 
ramping experiments see Chapter 4 and Chapter 6.

Detector (V) Set for optimum ion detection, see Setting the Detector 
Voltage on page 3-8.

Mass Range The mass range of the TOF can be varied by changing the 
pusher frequency. Usually left on auto.

Instrument page parameters: (Continued)

Parameter Description 
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Complete tuning of the Tof from default settings
This section is intended to demonstrate tuning for good sensitivity and 
resolution from a default tune file.

Important: Keep the ion counts below the deadtime threshold see Deadtime 
Correction on page 3-3 for more information

Initial considerations

The following should be taken into account:

• Ensure that samples are fully dissolved in a suitable solvent. Either 
filter or centrifuge the sample to avoid blocking the transfer line.

• Syringes should be thoroughly cleaned to minimize sample carryover.

To tune from default settings:

Prerequisites: Initial Setup on page 2-9

1. From the Tune window, click  to switch the instrument into 
Operate. Check that the adjacent instrument status indicator turns 
green. Ensure the syringe pump is on and the API and Collision gasses 
are on.

Important: If the Q-Tof Premier has been in Standby for more than 2 
hours it should be left in Operate for 1 hour to allow the instrument to 
stabilize.

2. Click File > Open and select default.ipr that contains the default Tof 
parameters.

3. Select Views > Tuning Controls. Specify these two settings to set the 
instrument mode:

• Click Mode > Positive Ion or Negative Ion

• Click V or W to specify instrument mode.

4. Click Setup > Tuning Settings to set the scan time and mass range.

5. In the Tuning Setup dialog box enter the following values and click 
Update.
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Tuning Setup dialog box:

Tip: It may take a while for the sample to appear in the peak display 
window as any dead volume will need to be cleared first. Increase the 
syringe rate for a short period to push the sample through.

6. There will be a response in the peak display. Zoom in the relevant mass 
range, the peak display will resemble that shown in the following figure.
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Peak display using default values:

7. With reference to the Table titled “Tuning page parameters:” on 
page 2-19 and the Figure titled “Tuning flow diagram:” on page 2-18 
adjust the various parameters for resolution and sensitivity. Ensure 
that you press enter after adjusting each parameter. 

The peaks in the display should eventually resemble those shown in 
Figure titled “Tuned peak display:” on page 2-11.

Ion Count
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Tuning flow diagram:

Optimize:
Pusher Offset

Pusher
Puller

For best peak shape and resolution

Infuse Sample

Optimize Source ES parameters for Maximum Sensitivity see To 
set source tuning parameters for sensitivity: on page 2-9

Ion count:
< 0.1 IPP

Optimize:
Acceleration1

Aperture 2
Transport1
Transport2

Steering
Tube Lens

For best peak shape, resolution and 
sensitivity.

Finish

Resolution Achieved?No

Yes

Yes

Yes

Adjust Capillary 
voltage

No

Adjust Capillary 
voltage

NoIon count:
< 0.1 IPP

No

Resolution Achieved? Yes
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8. Select File > Save As to save the tune settings and enter an appropriate 
name.

See also: 
• Routine optimization for sensitivity - Tof MS on page 2-8

• Tuning page parameters on page 2-19

• Acquiring data from the Tune window on page 2-23

• Calibration on page 3-1

Tuning page parameters

The Tuning page contains parameters that affect instrument resolution. 
These controls are optimized on installation, and should not require further 
adjustment. If the original settings are lost, new settings can generated from 
the instrument default settings. Maximum instrument resolution can often be 
obtained with most of these settings at their default values. The default 
parameter values are the same in both positive and negative ion modes.

Tip: When optimizing these parameters, start with the pusher offset control. 
Changing the pusher offset from 0 to about -1 V can produce a dramatic 
improvement.

Tuning page parameters:

Parameter Default 
V Mode 

Default 
W Mode Description 

Acceleration 1 (V) 80 50 Tune for maximum sensitivity and 
resolution. Should optimize within 20 V 
of default value. 

Acceleration 2 (V) 200 100 Do not change from default value.

Aperture 2 (V) 70 30 Tune for maximum sensitivity and 
resolution. Should optimize within 10 V 
of default value.

Transport 1 (V) 60 30 Tune for maximum sensitivity and 
resolution. Should optimize within 10 V 
of default value.

Transport 2 (V) 60 30 Tune for maximum sensitivity and 
resolution. Should optimize within 10 V 
of default value. 
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Steering (V) 0 0 Tune for maximum sensitivity and 
resolution. Should optimize between –1 
and 1 V.

Tube Lens (V) 75 24 Tune for maximum sensitivity and 
resolution. Should optimize within 10 V 
of the default value. 

Pusher (V) 905 925 Tune for maximum resolution. Should 
tune within 20 V of default. 

Pusher Offset (V) 0 0 Tune for maximum resolution. Should 
optimize between –3 and 0 V. 

Puller (V) 630 670 Tune for maximum resolution. Should 
tune within 50 V of default.

Tuning page parameters: (Continued)

Parameter Default 
V Mode 

Default 
W Mode Description 
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RF settings

The Q-TOF Premier contains three RF devices: a source ion guide, a collision 
cell and a quadrupole. The RF settings control the sensitivity and mass range 
of the Q-Tof Premier.

To open the RF settings dialog box:

1 Click  to open the RF Settings dialog box.

2 Make any changes required and click Update and then Close.

Note: New settings do not take effect until Update is clicked.

Ion Guide

The default settings for the RF on the Ion Guide should be sufficient for 
normal mass ranges. However, if you wish to increase sensitivity for lower m/z 
values the RF Offset can be decreased. You will have to tune this value for 
your application.

Collision Cell

The default RF settings for the Collision Cell do not need to be changed.
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Quadrupole options
Setting quadrupole options to ‘Auto Profile’ allows fully automatic control of 
the quadrupole RF during MS acquisitions. 

Quadrupole MS Profile
The transmission of the quadrupole in non-resolving (MS) mode is a function 
of the quad RF amplitude, i.e. the ‘quad mass’. 

Typical transmission profile:

The graph defines a transmission window for the quadrupole. The size of this 
transmission window is a function of pre-filter voltage; use a low pre-filter 
voltage to get a wide transmission window.

Option Description
Manual Profile This is, essentially, as described in the previous 

section,

Manual Fixed Enter a m/z for maximum sensitivity at that value.

Auto Profile This calculates the MS profile from the low m/z and 
high m/z that are entered as part of the acquisition. 

Auto Fixed Automatically sets a fixed quad RF dependent on the 
acquisition start mass.
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The graph shows a sharp cut-off in transmission at 0.8. For example, if the 
quad mass is set to 500 Da, no ions will be transmitted below 400 Da (0.8 x 
quad mass). At the higher mass end the cut-off is much more gradual, and can 
change according to instrument conditions. For example, if the quad mass is 
set to 500 Da, the transmission at 2500 is still high (look at 2500/500 = 5). 

The Quadrupole MS Profile settings allow the quad mass to be ramped, 
enabling the acquisition of mass ranges wider than the quad transmission 
window. Appropriate values of Mass, Dwell Time and Ramp Time must be 
entered to suit the acquisition mass range. Alternatively, set Quadrupole 
Options to Auto Profile, allowing MassLynx to calculate the optimum MS 
Profile.

The Quadrupole MS Parameters are defined in the following graph:

Acquiring data from the Tune window

Data can be acquired from single samples directly from the Tune window. 
Multiple samples need to be entered in the Sample List, this is described in 
Chapter 4.

To acquire data from the Tune window:

1. Click  to open the Start Acquisition dialog box and enter the 
parameters as shown below.

Scan Time

Mass 3

Mass 2

Mass 1

Dwell 
time 1

Ramp 
time 1

Ramp 
time 2

Dwell 
time 2
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Tune Acquire dialog box:

Tip: Click Origin to open a dialog box that allows you to enter your own 
details and details of the sample.

2. Click Start. 

Result: The Q-Tof Premier begins to Acquire data and save it to disk.

Monitoring an acquisition
Tip: The progress of your data acquisition can be followed in both Spectrum 
and Chromatogram as well as the peak display. 

See also: MassLynx help for further details on both Spectrum and 
Chromatogram.

Set either 
TOF MS or 
TOF MSMS

Set 
Continuum or 
Centroid

If Tof MSMS is 
selected enter 
the precursor 
mass.

Set an internal 
LockMass

If there is no 
LockMass set 
DXC
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Chromatogram real-time update

To follow an acquisition in Chromatogram:

1. From the main MassLynx window, click Chromatogram from the 
Sample List menu bar.

Chromatogram display during real-time update:

2. In Chromatogram, click  in the menu bar to update the 
chromatogram in real-time display as the acquisition proceeds.

Spectrum real-time update

To follow an acquisition in Spectrum:

1. From the main MassLynx window, click Spectrum from the Sample List 
menu bar to open Spectrum.
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Spectrum display during real-time update:

2. In Spectrum, click  in the menu bar to update the spectrum display in 
real-time as the acquisition proceeds .

Spectrum will show each new scan.

Checking the resolution

The resolution of a peak is defined as the ratio of its mass to its peak width 
(measured at half height).

Use the following equation to calculate the resolution:

The resolution in V-mode will be about 10 000 when measured on a multiply 
charged ion, or about 8000 when measured on a singly charged ion.

The resolution in W-mode will be about 17 500 when measured on a multiply 
charged ion, or about 15 000 when measured on a singly charged ion.

To check the resolution:

1. Acquire data as described on page 2-23.

2. Click Start.

3. Open Chromatogram from the MassLynx Sample List menu.

4. Click  in the menu bar.

Resolution Mass( ) PeakWidth( )÷=
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5. Combine data from at least 30 scans. On completion the Spectrum 
window will open

6. In the Spectrum window zoom in on the main peak (556 Da if running 
leucine enkephalin).

Tip: To ensure that a grid is shown on the Spectrum. Select 
Display > View to open the Spectrum Display dialog box and then select 
Grid ‘Dot/Dash/Solid’.

Rule: Select Display > Peak Annotation to open the Spectrum Peak 
Annotation dialog box and ensure that 4 decimal places are entered.

7. With the aid of the grid, right-click and drag the mouse pointer across 
the width of the peak at half maximum height. The width is shown in 
the bottom-left corner of the Spectrum window. Calculate the resolution 
using the equation at the beginning of this section.
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The resolution calculation follows:

If the resolution is not achieved, optimization of tune parameters may be 
necessary.

Note: From MassLynx 4 the resolution will be displayed in the peak display 
window.

See Also: 
• MassLynx Help, for details on how to use Chromatogram, Spectrum and 

Combine.

See also: Acquiring data from the Tune window on page 2-23.

Resolution 556.37 0.0643⁄( ) 8653==
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Overview

Before using the Q-Tof Premier for exact mass measurement work the 
instrument requires calibrating. It is recommended that the calibration is 
checked regularly with an appropriate quality control standard. A new 
calibration should be performed after:

• Cleaning, maintenance

• Changing the Veff value

• Changing the TOF mass range

• Changing any analyzer tune settings

The Q-TOF Premier has four basic modes of operation: V+, V-, W+ and W-. 
Each of these has a separate TOF calibration, but all can be saved in a 
common calibration file.

Nominal Mass Measurement
The instrument mass scale is set up to give nominal mass measurement 
without a calibration. This requires the setting of the Veff and T0 parameters 
in the acquisition settings window.

Quad Calibration
The quad mass scale is set up via the control electronics. A separate software 
calibration is not always necessary. The quad mass scale has to be set up 
correctly in order to accurately select precursor ions. The quad calibration has 
no effect on the mass measurement of the Q-TOF Premier.

TOF Calibration
For all accurate mass work, calibrating the TOF is a critical part of the 
instrument set-up process. MassLynx uses a polynomial equation in order to 
calibrate precisely over a wide mass range.

Lock Mass
Temperature variations in the laboratory surroundings will cause mass shifts. 
This can be corrected for by the use of a single reference peak, i.e. a lock mass. 
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This lock mass can be either internal, i.e. in the sample solution, or external, 
in a separate reference spray, i.e. LockSpray. 

Dynamic External Calibration
Dynamic External Calibration (DXC™) is a method of compensating for mass 
drift due to temperature fluctuations. It is not suitable for accurate mass 
work, and is only used in the absence of a suitable lock mass.

TOF Mass Range
The TOF Mass Range of the instrument is set via the instrument tab on the 
Tune window. It can be set either to auto, or to one of the masses on a drop 
down list (1000, 2000, 4000 etc.). These different upper mass limits correspond 
to different pusher frequencies. Doubling the mass range reduces the 
instrument sensitivity by a factor of 1/√2 (i.e. 0.71). For optimum mass 
measurement performance, the TOF mass range (or pusher frequency) must 
be set to the same value when calibrating the instrument as used during the 
analysis. 

In auto mode, the mass range is automatically set according to the upper mass 
range of the acquisition, e.g. for an acquisition high mass of between 1001 and 
2000 the TOF mass range will be set to 2000.

Deadtime Correction
The data acquisition system for the instrument is a time to digital converter 
(TDC). This is an ion counting system which generates a mass spectrum by 
histograming the arrival times of ions in memory. After the arrival and 
registration of an ion by the TDC there is a minimum time interval before a 
subsequent ion arrival can be registered. This is called the 'dead time' of the 
TDC and is of the order of 5 ns. If more than one ion arrives in the same "bin" 
then only one count is registered. 

At high ion currents, some of the ion arrivals are not registered, this leads to a 
shift to lower mass centroids, and also lower measured areas on reported 
peaks. However, MassLynx incorporates Digital Dead Time Correction 
(DDTC™), which compensates for these effects and enables accurate mass 
measurement and quantitation to be achieved over a large range of ion 
currents.

The effectiveness of DDTC does, however have its limits, and it is important to 
keep ion counts well below these limits when doing calibrations. The range 
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over which DDTC operates is defined in terms of the ions-per-push (IPP) of a 
peak. To find the intensity of a peak in ions-per-push, set the peak display to 
centroid mode. The IPP value displayed will be that corresponding to the 
largest peak on the display. To find the IPP value of a particular peak, zoom in 
on that peak until it is the largest in the displayed mass range. 

The maximum peak intensity that can be corrected by DDTC corresponds to 
an IPP value of 0.85. Peaks with intensities in excess of this will not be 
corrected. Peaks with IPP values of less than 0.1 will not show any dead-time 
distortion effects, and the application of DDTC to such peaks will make little 
or no difference.

For optimum calibration accuracy, reduce peak intensities; avoiding IPP 
values much above 0.1.

The effect of IPP on mass accuracy:

Dynamic Range
Dynamic range should be set to normal during the acquisition of instrument 
calibrations. Signal intensities are always kept low while calibrating the 
instrument. Extended and normal dynamic range acquisitions use the same 
calibrations.

Mass error increases with intensity, not
correctable without pDRE

Accurate mass obtained only with DDTC

Accurate mass obtained with or without
DDTC

0.10

0.60

IPP
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Acquisition Setup
Many of the parameters that are vital to good mass measurement are entered 
via the Acquisition Setup dialog box. 

To open the Acquisition Setup dialog box:

From the Tune window select Setup > Acquisition Settings.

Acquisition Setup dialog box:

Parameter Description

Centroiding Parameters (only used when collecting centroid data):
Threshold The intensity threshold for peak detection. Usually set to 1.

Minimum Points Sets the minimum peak width for peak detection. Usually set 
within the range 2 to 6. Increase if peak splitting is observed.

DDTC:
Np Multiplier A value of 0.7 gives optimum mass measurement on intense 

peaks.

Resolution For optimum dead time correction, set to the actual 
resolution of the instrument. A precision ± 500 is adequate.
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pDRE:
Transmission (%) Sets the percentage of ions transmitted by the DRE lens 

while active. 

DXC Temperature Compensation:
Drift (ppm/oC) Sets the size of correction to be applied to mass 

measurements to compensate for the effect of temperature 
drift.

TDC Threshold Settings
Trigger Sets the trigger pulse level that will trigger the TDC. Leave 

at the default value of 700 mV, or that set at instrument 
installation, if different.

Signal Sets the signal level that will cause the TDC to record an ion 
arrival event. Leave at the level set at installation, usually 
about 50 to 100 mV. 

Nominal Mass Measurement:
Veff Used to set up the instrument nominal mass scale. Default 

values are 5840 in V-mode and 5870 in W-mode.

T0 An offset time used to calculate nominal mass. Usually left at 
the default value of - 50 ns.

EDC Delay:
Coefficient Used to calculate the correct pusher timing when in EDC 

mode. Usually left at default value of 1.3.

Offset Used to calculate the correct pusher timing when in EDC 
mode. Usually left at default value of - 1.

Parameter Description
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Before calibrating

Before attempting to calibrate the TOF there are several tasks that have to be 
completed first. These are described in the following section.

Nominal Mass setup

Nominal mass accuracy can be achieved by setting up the Veff and T0 values 
in the Acquisition Settings dialog box. Once set, these values will not normally 
need to be changed. The default value for Veff is 5480 in V mode and 5870 in 
W mode. The default values for T0 is -50. This T0 value should not be 
changed. The Veff values will need to be determined for each of the four modes 
of operation: V+, V-, W+ and W-.

To set the Nominal Mass:

1. From the Tune window click Calibration > Calibrate TOF.

2. In the Calibration window click Calibrate> Remove Calibration.

3. Infuse leucine enkephalin (or any suitable reference compound).

4. Click  to open the Start Acquisition dialog box and enter the 
acquisition parameters. Click Start.

5. Zoom into the leucine enkephalin molecular ion at around 556.3 Da on 
the peak display.

6. Click .

7. In the Acquisition Settings dialog box enter a new value of Veff and click 
Update.

8. Observe the peak movement and then enter another Veff value.

9. Repeat until the peak is at the correct mass (± 0.1 Da accuracy is 
acceptable).

Tips: 
• Increasing Veff will move the peak to the right, i.e. to higher mass. 

Change in steps of 10 or less.

• Using a reference mass of greater than 500 Da will improve the accuracy 
of this determination.
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• A Veff value only has to be determined once. It will not change over 
time.

• Changing Veff will invalidate any existing calibration files.

• Setting an accurate Veff will not improve the calibrated mass accuracy 
of the instrument, but will ensure the correct assignment of calibration 
compound peaks, allowing easier calibrating.

Setting the Detector Voltage

You should do a detector (MCP) gain test every month to check whether you 
are getting maximum sensitivity.

This ensures that the correct voltage is applied to the micro-channel plate 
(MCP) optimizing ion detection and minimizing potential electronic artefacts. 
You will increase the MCP voltage until a plateau is reached i.e. the ion count 
stops increasing. It is important for accurate mass that all ions are counted.

Prerequisite: You will need to have a suitable reference compound, in this 
example leucine enkephalin at 50 pg/µL is used.

To set the correct Detector voltage:

Tip: Ensure peak intensity remains below 0.1 ions per push. If this value is 
exceeded, adjust capillary voltage and repeat the detector setup. 

1. Make a 10 minute acquisition from the Tune page with a scan time of 
5 s.

Tip: This is so you will have enough time to ramp the MCP voltage 
during the acquisition without running out of data.

2. Click the Instrument page and enter 1700 into the Detector text box.

3. From the main MassLynx window open Chromatogram and click real 
time update.

4. Right-click and drag across the acquisition to combine a minutes worth 
of data.

Result: Spectrum opens with the combined data displayed.

5. In the Spectrum window zoom in on the main peak and right-click across 
this peak.

Result: This gives an extracted mass chromatogram of the selected 
mass.
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6. Increase the MCP voltage in 100-V steps, waiting one minute after each 
increment.

Result: The chromatogram should plateau at, or before 2100V. The last 
reading before reaching this plateau provides the optimum detector 
voltage. In the Figure titled “MCP Gain chromatogram:” on page 3-9 you 
can see how the sensitivity increases sharply from 1700 to 1800 V and 
then begins to plateau. In this case 1800 V is the optimum detector 
voltage.

7. When the plateau is reached, stop the acquisition.

Tip: The detector voltage should be set so that at least 90% of ions are 
detected.

MCP Gain chromatogram:

1700 V

1800 V

1900 V 2000 V
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Accurate mass basics
• ·The Q-TOF Premier must be calibrated before accurate mass 

determination is possible. 

• Separate calibrations are required for each instrument mode: V+, V-, 
W+ and W-. 

• All four of these calibrations are stored in the same calibration file. 

• Instrument calibration is normally done in ESI source mode; the 
calibration produced is valid across all source configurations. 

• Accurate masses cannot be obtained outside the range of masses covered 
by the calibration.

• The same TOF mass range must be used for the calibration as for the 
subsequent mass determinations. 

• Calibrations for maximum sensitivity (EDC) acquisitions must be 
acquired using a TOF mass range of 4000 Da. 

• A LockMass is required to compensate for mass measurement drift, 
caused mainly by ambient temperature fluctuations.

• LockMasses can either be internal (in the analyte solution) or external 
(LockSpray).

• Accurate masses can only be obtained from centroid data; continuum 
data must be first converted to centroid.
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Calibrating for accurate mass

The purpose of the following is to show you how to calibrate the instrument 
using sodium formate over a mass range of 100 - 1000 Da.

Prerequisites: 
• The instrument is tuned to give adequate resolution

• Nominal mass is correct

• The detector voltage is set correctly

• The instrument has been in operate for at least one hour

Calibration overview:

Reference files

Reference files are tab delimited files which you can edit. They are stored in 
the Ref folder of the main MassLynx folder. Reference files are text files 
containing a list of numbers in mass/intensity pairs (average or monoisotopic 

1. Infuse reference compound.

2. Adjust capillary voltage to give less than 0.1 
ions per push.

3. Acquire continuum data.

4. Combine and center data.

5. Save spectrum.

Acquire data

Create 
calibration

1. Select reference file in calibration window.

2. Create calibration from saved spectrum.

3. Set calibration parameters and accept 
calibration.

4. Save calibration.
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masses and relative intensities). The two columns of numbers are interpreted 
by MassLynx as a line graph for calibration and processing.

Acquiring data

To acquire data for calibration:

1. From the Tune window click Calibration > Calibrate Tof.

2. From the calibration window select Calibrate > Remove Calibration. 

3. Infuse a solution of sodium formate (see Calibration solution on 
page 3-21 for preparation details).

4. Adjust the capillary voltage to give a maximum peak intensity of 0.1 
ions per push (switch peak display to centroid to check this)

5. Acquire 2 minutes of MS continuum data from 60 to 1000 Da, 1 s scan, 
0.02 s interscan.

6. From the main MassLynx window, open Chromatogram and click .

7. When the acquisition has finished, right-click and drag across the whole 
acquisition to combine the data.
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Spectrum of sodium formate:

8. From the Spectrum window click Process > Center

9. From the Tof Spectrum dialog box, enter the values as shown in the 
following figure and click TOF. In the TOF accurate Mass dialog box 
enter the values as shown. The resolution should be set to the actual 
instrument resolution (±500). Make sure that Lock Mass is set to zero.
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10. Click OK, OK to create a centroid spectrum.

11. Click File > Save to save the spectrum.

Making the calibration

To make a calibration:

1. From the Tune window click Calibrate > Calibrate Tof.

2. From the Calibration window select NaFormatePosES.ref from the 
reference file drop down list.

3. Click Calibrate > Create Calibration.

4. From the “Select File for Calibration dialog box” navigate to the raw 
data file you saved in Acquiring data on page 3-12.

5. Click History, and from the History Selector dialog box select the saved 
Accurate Mass centered spectrum.

Tip: The saved spectrum will be listed in a line starting ‘AccMass’.
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History Selector dialog box:

6. Click OK, OK.

Result: MassLynx performs the calibration calculations. When the 
calibration is complete the data appears in a new Calibration window.
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Calibration window showing residual errors:

7. Click Edit > Calibration Parameters and set the parameters as shown 
and click OK.

Hints: 
• As a general rule, the residual (in mDa) on each individual 

calibration point should be less than 1.5 mDa. Ideally the majority 
of calibration points will have residuals of less than 0.5 mDa. A 
measure of the 'fit' of the calibration line to the experimental data is 
given in the error of the residual.

• The RMS residual should be less than 1x10-3 amu

• To check for outliers set the Polynomial order to 1. Outliers can be 
removed from the calibration curve by right-clicking the outlying 
peak in the reference file spectrum and right-clicking the associated 
peak on the data file spectrum. After removing outliers return the 
Polynomial order to 5.

• Click display > Switch Residuals Graph Axis to ppm for an 
alternative view of the residuals. The RMS residuals should be less 
than 1 ppm.
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Caution: Always save the calibration with a new name. Do not overwrite 
Uncal.cal.

8. Click Finished > Accept Calibration when you are satisfied with the 
results. If the data is not satisfactory, slick Finished > Reject 
Calibration. 

9. Click File > Save As, to save the calibration

Tip: It is good practice when saving a calibration to use the date as the 
filename.

10. Repeat the calibration, as desired, for all other modes.

Note:  Calibrations for all four MS modes, V +, V -, W +, and W - can be 
stored within one calibration file.

See also: Editing the Calibration graph on page 3-17.

Editing the Calibration graph
The Calibration graph has four sections:

• Data file 

• Reference file

• Mass difference

• Residuals

Data File and Reference File

Matched peaks are highlighted red, with the mass displayed above, other 
peaks are displayed in blue. 

To zoom in on peaks:

1. Click and drag horizontally between the first two peaks to see a detailed 
view. 
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Calibration graph detail view:

2. Zoom in closer to see the horizontal mass difference plotted on a vertical 
mass scale.
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The following figure shows that this has been done along the mass scale.

Line of best fit:

MassLynx has also drawn a ‘line of best fit’ through the mass difference 
points, but not necessarily touching any of them.

This line is the calibration, the amount by which future mass data is 
corrected if the calibration is accepted.

Residuals

The residuals plot (below) shows you how the reference masses appear if the 
acquisition is done with the current calibration in place. 

Calibration residuals:

A perfect calibration puts all masses along the baseline, but any calibration is 
a compromise, and the mean residual mass value is displayed at the right. 

Minor deviations are normal, but in this example the obvious discontinuity 
between mass 2000 and 2100 suggests this calibration is not satisfactory.
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The following figure shows why this has happened:

Incorrect peak matching:

At reference mass 2022.18 MassLynx has matched the data peak 2022.46, and 
this is also the monoisotopic peak. However, reference mass 2066.21 has been 
matched with 2067.35. This is the highest peak but not the monoisotopic peak 
- hence the discontinuity seen in the Figure titled “Calibration residuals:” on 
page 3-19. 

To produce an acceptable calibration all the peaks to the right of mass 2022.46 
must be reassigned to the monoisotopic peaks. 

Reassigning Peaks

The following figure shows how you reassign reference peaks to the correct, 
monoisotopic peaks.

Wrong Peak 
Matched
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Reassigning peaks:

To reassign peaks:

1. Right-click to the left of the reference peak, then right-click to the left of 
the wrongly assigned data peak. 

The peak changes from red to blue, and the mass value disappears. 

2. Right-click to the left of the appropriate monoisotopic peak. 

The peak is highlighted red and the mass is displayed.

The mass differences are now more evenly placed around the calibration 
curve. 

Calibration solution
The sodium formate calibration solution produces cluster ions (i.e., multimers) 
of sodium and formic acid in electrospray mode. When compared to other 
similar calibration solutions, such as sodium iodide and caesium iodide, this 
calibration solution has a more even distribution of ion intensity and a smaller 
difference in mass between ions.

The distribution of higher mass cluster ions is governed mainly by the 
concentration of formic acid in the solution and dilution may result in the 
disappearance of the higher mass ions.
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The instrument calibration produced from the sodium formate calibration 
solution is superior to sodium iodide solution over shorter mass ranges (e.g. 
100 to 1000 m/z or 100 to 600 m/z) because there are a greater number of 
calibration points and consequently there is less chance of an interpolation 
error when a high-order polynomial is fitted.

To prepare the sodium formate solution:

The target solution constituent concentration is 0.05 M sodium hydroxide + 
0.5% formic acid in 90:10 2-propanol:water.

1. Take 1 mL of formic acid and add to 9 mL of water to produce a 10% 
formic acid aqueous solution. Label this as Formic Acid Solution.

2. Add 500 µL of 0.1 M sodium hydroxide and 500 µL of Formic Acid 
Solution to 9 mL of 90:10 2-propanol:water solution. Label this as 
Sodium Formate Solution 1.

Warning: To avoid chemical burns take great care when handling 
formic acid. Always add to water not water to formic acid.
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Acquiring Accurate Mass Data with LockSpray

Temperature variations in the laboratory environment can cause drifts in 
mass measurements of a few hundred parts per million (ppm) over the course 
of a day. For accurate mass work, the instrument should be kept in OPERATE 
at all times to enable stabilization of the power supplies. The use of a lock 
mass enables mass drift, from whatever source, to be accurately corrected. 
The Q-TOF Premier's LockSpray source enables a suitable reference 
compound to be introduced into the source independently of the analyte 
solution.

To enable LockSpray:

From the Tune window Click Mode > LockSpray On.

Result: The Lock Spray frame is enabled on the Source page.

To add a user specified lock mass:

1. From the Tune window Click Setup > Edit Lockmasses. 

2. Click New to add the name and mass of the lock mass.

To use LockSpray with a Sample List acquisition:

Prerequisites: You will require two syringe pumps to perform this procedure. 
Ensure that ESI positive, V or W mode and LockSpray are enabled.

1. Using the same Tune window settings as those in Chapter 2:

– Infuse a solution of 50 pg/µL of leucine enkephalin at 10 µL/min 
into the reference sprayer. View the ion beam by selecting 
Reference from the Tune window.

– Infuse a solution of 50 pg/µL of raffinose at 10 µL/min into the 
analyte sprayer. View the ion beam by selecting Analyte from 
the Tune window.

Tip: Raffinose forms a sodium adduct in positive mode at m/z 527.

2. In the Sample List in the main MassLynx window, enter values in the 
File Name and File Text columns as shown below.
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Sample List:

3. Right-click in the MS File column and select Edit from the pop-up menu 
to open the MS Method Editor.

4. Click MS Scan to open the TOF MS Scan Function editor. On the 
Acquisition Page enter a 10 minute acquisition in ES positive W or V 
mode. Leave the Sensitivity page at Normal. On the Tof MS page and 
LockSpray page enter the following values:

Tof MS Acquisition Parameters:

Parameter Value

Tof MS page
Start (m/z) 100

End (m/z) 1000

Scan Time (s) 1

Inter Scan Delay (s) 0.02

Data Format Centroid

Cone Voltage 35

LockMass page
Scan Time (s) 0.5

Interval (s) 10

Sampling Cone 35

Collision Energy 5 V
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5. From the MS Method Editor select File > Save As. Choose a suitable 
name, e.g., LockSprayMS. 

6. Select File > Exit to return to the Sample List.

7. Right-click in MS File column, select Browse from the pop-up menu and 
select the method file (*.exp) you have just saved

8. Click  to start the acquisition. This will open the Start Sample List 
Run dialog box. Leave the settings as they are and click OK. 

9. Check that both the reference and analyte samples are acquiring data:

– Select Chromatogram from the Sample List.

– Select Display > TIC to open the TIC Chromatogram dialog box.

TIC Chromatogram dialog box:

10. Select both traces to display and select  for Real-Time Update.

Lock Mass Leucine Enkephalin 
[M+H]+

Mass Window 0.5 Da

Scans to average 10

Tof MS Acquisition Parameters: (Continued)

Parameter Value
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Reference and Analyte Spray Data in the Chromatogram Window 
(annotated to distinguish between each trace):

11. Double-click in a region of each chromatogram to open up a spectrum for 
each spray in the Spectrum window.
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Analyte and Reference Spray Data in the Spectrum Window annotated 
to distinguish between each trace):

To Calculate the Mass Accuracy

1. Return to the Chromatogram window and Select Process > Combine 
Spectra to open the Combine Spectrum dialog box.

2. Right-click and drag across at least 30 seconds of data. The scan 
numbers will appear in the Average text box.

3. Click OK to open the combined spectra in the Spectrum window.
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4. Use the following equation below to calculate the ppm error.

Where:

mind is the indicated mass

mact is the actual mass

See Also: Combine in MassLynx help.

ppmError
mind mact–

mact
------------------------------- 106×=
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Demonstrating pDRE

The Q-Tof Premier has the ability to detect ions over four orders of magnitude 
when extended dynamic range is selected. The following procedure shows a 
method for demonstrating this.

Rationale: Without extended dynamic range switched on the maximum 
intensity of ions that the Q-Tof Premier will detect accurately is limited by the 
deadtime correction model. This varies according to the mode and mass range. 
Centroid peaks that fall outside the model are flagged with “?”. The figure 
below shows leucine enkephalin with its main peak flagged since its intensity 
is >20,000 cps.

Example of peak flag in centroid mode:

To demonstrate four orders of magnitude of spectral intensity:

1. Infuse a solution of 20 ng/µL leucine enkephalin at 5 µL/min.
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2. Tune for best sensitivity, using the relevant parameters provided in 
Routine optimization for sensitivity - Tof MS on page 2-8. If necessary, 
move the probe closer to the cone to increase sensitivity.

3. Detune the Capillary and Cone voltages to give 80 cps

4. Acquire data with the following parameters with no lock mass and select 
Extended Dynamic Range.

5. From Chromatogram, enable real-time update and combine several 
scans. 

6. Gradually step up the voltage combining several scans for each voltage 
setting. You will be able to show more than 800,000 cps before the main 
leucine enkephalin peak is flagged.

Tof MS acquisition parameters for DRE

Parameter Value
Start (m/z) 100

End (m/z) 1000

Scan Time (s) 1

Inter Scan Delay (s) 0.02

Data Format Centroid
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Leucine enkephalin peak with and ion intensity > 800,000:
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Demonstrating EDC

Positive Ion Enhanced Duty Cycle (EDC) Sensitivity (V Mode)
The sample is 10 pg/µL leucine enkephalin in 50:50 ACN:water + 0.1% formic 
acid, infused at a flow rate of 5 µL/min.

With the mass range set to a maximum at 556 Da, the resulting 
singly-charged peak should display an intensity greater than 2400 cps. The 
parallel experiment with no EDC selected will be significantly lower.

To demonstrate EDC:

1. From the MassLynx window, click MS Method > MS Scan. Create a MS 
Scan Method with a total acquisition time of 10 minutes in V positive 
mode and normal dynamic range and the following Tof MS parameters

2. On the Sensitivity page select Maximum and type 556 into the Mass 1 
maximum sensitivity box.

3. Save the experiment as edc.exp. 

4. Create another with identical settings but with minimum selected on 
the Sensitivity page. Save this experiment as no_edc.exp.

5. From the MassLynx window, set up a sample list as shown below.

6. Infuse 10 pg/µL leucine enkephalin at a flow rate of 5 µL/min.

Tof MS acquisition parameters for EDC:

Parameter Value
Start (m/z) 100

End (m/z) 1000

Scan Time (s) 1

Inter Scan Delay (s) 0.02

Data Format Continuum
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7. Tune for best sensitivity, using the relevant parameters provided in 
Routine optimization for sensitivity - Tof MS on page 2-8. If necessary, 
move the probe closer to the cone to increase sensitivity.

8. Acquire the data files set up in the sample list.

9. For both acquisitions, combine 10 consecutive scans, calculate the 
resolution at 556 m/z (resolution must be greater than 8000) and center 
the data using the following parameters. 

10. On the TOF Accurate Mass dialog box, in the Resolution (**) field, type 
the resolution value calculated from the spectra in the above step.

11. Compare the intensities of the two 556 peaks from each acquisition. The 
intensity of the 556 m/z peak with EDC will be significantly greater than 
the 556 m/z peak without EDC.
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Setting Up an LC Inlet

Rationale: The Q-Tof Premier will predominantly be used with an LC system, 
this is set up using the Inlet Configuration Wizard (see MassLynx Help for 
further details). 

To set the instrument configuration:

1. From the MassLynx Status Shortcut bar select Inlet Method from the to 
open the Inlet Method Editor.

2. Click Tools > Instrument Configuration to open the Inlet Configuration 
dialog box.

3. Click Configure to open the Inlet Configuration Wizard.

4. Follow the on screen instructions and choose the configuration of pumps, 
samplers and detectors you require.

5. Configure the GPIB page (or, for Agilent instruments, HPIB page)
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Rule: GPIB settings should not be changed if set by a Waters Field 
Service Engineer.

6. Close the Inlet Configuration wizard

To set Events and Triggering:

Rationale: Use this wizard to configure input and output events and 
triggering methods for certain pumps and detectors.

1. From the Inlet Configuration dialog box click Events & Triggering to 
open the Events and Triggering Wizard. 

2. Click Next to open the Choose Events page.

3. Click the Event In that corresponds to the HPLC cable connection on the 
back panel of the Q-Tof Premier (see Rear panel on page 1-17).

4. If required, select an Event Out. 
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5. Click Next to open the Choose Triggering Method page.

6. Click Trigger by Software and then click Next to open the Configuration 
Successful page.

Tip: Triggering allows the definition of how the LC or detector run is 
triggered, whether by contact closure or software.

7. Click Finish to close the Events and Triggering Wizard.
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8. Click Finish to close the Inlet Configuration window and return to the 
Inlet Method Editor.

Tip: The inlet method can be chosen from the Sample List by right-clicking the 
Inlet File cell.

MS Method editor

The MS Method editor is the where you can set up particular types of 
experiment/functions that the mass spectrometer uses to scan the instrument 
during an acquisition. You can setup simple MS Scan and MS/MS Scan 
experiments (described in this chapter) and also Data directed analysis (DDA) 
experiments (described in Chapter 6).

A Function List is created, saved on disk, and then referenced by name in the 
MassLynx Sample List when an acquisition is started.

The figure below shows a simple Function List containing only one function: 
Tof MS scan, between 100 and 1000 amu using ES+ ionization. Immediately 
above the function bar display is a time scale that shows from when the 
function is active, and for how long it runs. In this case, the function starts 
after 0 minutes and then runs for 10 minutes.

The currently selected function is highlighted and enclosed in a rectangular 
frame. If the display shows more than one function, a different function can be 
selected either by clicking with the mouse or by using the keyboard arrow 
keys.

See also: Applying a Single-Point Lock Mass Correction on page 4-2.
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Acquisition functions
There are six different acquisition function types:

These functions are set up by entering parameters into a series of tabbed 
pages. Many of these pages are common to several functions.

To set up a function:

1. Click the MS Method icon in the MassLynx window to open the MS 
Method Editor.

2. In the MS Method Editor, click the appropriate function button or select 
Functions > MS Scan to open the relevant function.

3. Enter the required parameters. 

Note: Regardless of the experiment type the same basic parameters 
need to be set; such as the mass range, the total acquisition time, 
ionization mode etc.

See also: 
• Acquisition page on page 4-19

• Function parameters on page 4-18

• Data-Directed Analysis on page 6-1

Types of Data Acquisition

In the Function editor, the Data format parameter specifies the type of data to 
be collected and stored on disk. There are two options:

Function Name Description
MS Scan Standard MS acquisition

MSMS Standard MSMS acquisition

Survey Automatic selection of precursors by MS/MS)

PID Product Precursor Ion Discovery via product ion detection

PID Neutral Precursor Ion Discovery via neutral loss detection

Expression Protein Expression (an available option)
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• Continuum 

The TDC acquires up to 22,000 complete spectra per second. These 
spectra are summed in the embedded PC for a time period defined in the 
experiment function, the "Scan Time". The result is that one complete 
spectrum is saved to disk per scan. With continuum data peak shape is 
preserved and resolution can be calculated. Post-processing is required 
to determine exact mass information. A disadvantage is that file sizes 
can be very large.

• Centroid

The raw spectra from the TDC are summed for the duration of the scan, 
and then the data is then converted to "stick" form. This preserves mass 
and intensity information, but peak shapes are lost. With the use of a 
lock mass, real-time exact mass is possible, with exact mass data being 
saved to disk. An advantage is that file sizes are much smaller than with 
continuum data.

Function parameters

Basic Function pages
The MS Scan and MS/MS functions are set up via the following tabs:

The Survey, PID Product, and PID Neutral functions are covered in 
Chapter 6. The Expression function is described in the Expression System 
Guide.

Page Use
Acquisition Configures the initial acquisition parameters.

TOF MS MS scan only.

TOF MS/MS MS/MS only.

Collision Energy Not usually used for MS (use default settings).

Sensitivity Configures enhanced duty cycle.

LockMass Configures LockSpray. 
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Acquisition page
The Acquisition page is used for setting the initial acquisition parameters for 
the experiment. It is common to all the acquisition functions.

Acquisition Times 

Enter the total time for the acquisition.

Acquisition Ionization Mode

Enter the source type, the type of acquisition, positive / negative, V Mode / W 
Mode and normal or extended Dynamic Range.

Tip: Dynamic Range is only an option for MS Scan, MS/MS Scan, and Survey 
Scan.
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Probe Temperature

When API is chosen from the Source drop down list in the Acquisition 
Ionization Mode frame the Probe Temperature frame appears. You can use 
this frame to override the IonSabre probe temperature specified in the tune 
file.

Tof MS page 
Using the Tof MS page, you can configure the following parameters:

• The m/z range over which to acquire data. 

• The conditions at which the instrument will scan.

• The instrument conditions
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m/z range

Scanning Conditions

Parameter Description
Start m/z The start m/z value over which data is 

acquired.

End m/z The end m/z value at which data acquisition 
stops.

Parameter Description
Scan Time Specifies the duration of each scan in seconds.

Inter-Scan Delay Specifies the time between a scan finishing and the next 
one starting, in seconds. No data are stored during this 
period.
Recommended minimum inter-scan time: 0.02 s

Data Format Specifies the type of data to be collected and stored on disk 
Centroid or Continuum.
See also: Types of Data Acquisition 4-17
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Instrument Conditions

Select “Override Cone Voltage Specified in ipr file” if you want to use a cone 
voltage other than that specified in the tune file.

Select “Ramp the Cone Voltage during the scan” if you want to increase the 
Cone voltage during the scan. Enter the start and end values and MassLynx 
will linearly increase the voltage.

Tof MS/MS page
Using the Tof MS/MS page, you can configure the following parameters:

• The m/z range over which to acquire data (described below). 

• The conditions at which the instrument will scan. These are identical to 
those described Scanning Conditions on page 4-21.

• The instrument conditions These are identical to those described 
Instrument Conditions on page 4-22. 
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MS/MS m/z range

Parameter Description
Start m/z The start m/z value over which data is 

acquired.

End m/z The end m/z value at which data acquisition 
stops.

Set Mass Specify the precursor mass to be selected by the 
quadrupole for fragmentation.
Tip: Care should be taken when ions that have 
a multiple charge are being analyzed, to ensure 
that the mass range is sufficient to include 
product ions with a lower charge but a higher 
m/z value than the precursor.
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LockMass page
Using the LockMass page, you can specify the frequency of the reference data 
for accurate mass and the conditions at which to acquire that data.

Parameter Description
Scan Time Sets the scan time for the reference scan. Usually set to 0.5 

or 1 s.
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Sensitivity page
From this page you can select Normal or Maximum. Select Maximum, for 
Enhanced Duty Cycle, to enable Maximum Sensitivity Masses. Up to five 
masses can be selected at which the sensitivity will be increased.

Tip: This page is also common to MS/MS Scan.

Interval The time period between LockSpray reference scans. 
Usually set to 10 s.

Sampling Cone Sets the sampling cone voltage for the reference scan. 
Sample dependent, but usually 30 to 50 V.

Collision Energy Sets the collision energy for the reference scan. Usually set 
to 5 V.

Set Mass The set mass is present in MS/MS only. It sets the precursor 
mass for MSMS and also the maximum sensitivity mass 
(EDC).

Lock Mass Select the lock mass from the drop-down list. If the required 
lock mass is not on the list, then add by clicking Setup > Edit 
Lockmasses in the Tune window. Only available if centroid 
data is selected. 

Mass Window +/- Sets the window size to enable the correct lock mass peak to 
be located in the spectrum. Usually set to 0.5 Da.

Scans to average Sets the number of scans to be averaged before calculating 
the lock mass correction. Usually set to 10.

Parameter Description
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Collision Energy page
• Use Tune Page Collision Energy 

This is the least sophisticated option since it just uses the value for the 
collision energy that is taken from the Tune window.

• Use a Fixed Collision Energy Value

This allows one fixed value to be entered, that will override the collision 
energy set in the Tune window.

• Use Collision Energy Profile 

This option allows the selection of up to 5 collision energies. The collision 
energy will cycle around the selected values, using one collision energy 
per scan, in an attempt to produce optimal fragmentation. 

• Use Collision Energy Ramp 

This allows the Collision Energy to be ramped from an Initial Energy to 
a Final Energy.
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Method Editor basic functionality

To add a new function to the List:

1. Click one of the toolbar buttons or select the required function from the 
Functions menu. The editor for the function type selected opens, 
showing default values.

2. Make any changes required to the parameters and click OK. The new 
function is added to the Function List.

To modify an existing function in the list:

1. Select the function in the Function List.

2. Click  or double-click on the function to open the appropriate editor 
for the function type and allows changes to be made.

The Function List display is updated to show any changes.

To Copy an existing function in the list:

1. Select the function in the Function List.

2. Select Edit > Copy.

3. Select Edit > Paste. A copy of the function appears in the Function List.

4. Modify the parameters as described in To modify an existing function in 
the list: 4-27.

To Remove a function from the list:

1. Select the function in the Function List.

2. Click , select Edit > Delete, or press the Del key.

To change the function order in the list:

Functions appear in ascending Start Time and End Time order; this order 
cannot be changed. For functions with the same start and end time, you can 
change the order in which they are performed as follows:

1. Select the required function.

2. Repeatedly click  or  until the function is in the required position.
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To Set the maximum retention time:

1. Enter the required value in the Total Run Time text box.

2. Click .

The ratio of the functions defined is maintained. For example, if two functions 
are defined, one from 0 to 5 minutes, and the other 5 to 10 minutes, then a Total 
Run Time of 10 minutes is displayed. If this value is changed to 20, the first 
function now runs from 0 to 10 minutes and the second from 10 to 20 minutes.

Setting a solvent delay

To set a solvent delay for a Function List, select Options > Solvent Delay on 
the MS Method Editor to open the Solvent Delay dialog box.

No data is stored during the solvent delay period, which means that solvent 
peaks that would normally be seen eluting on the TIC chromatogram are no 
longer seen.

Solvent Delay dialog box:

For APCI functions, the APCI probe temperature is set to the value specified 
in the APcI Probe Temp field for the period of the solvent delay.

To enable the divert/injector valve to be used as a divert valve, select Enable 
Divert Valve. This diverts the flow of solvent during a solvent delay period 
either to, or away from, the source for the time period shown in the solvent 
delay timetable.

Up to four solvent delays can be programmed.
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Acquiring Analog Data

You can acquire up to eight channels of analog data, which are stored with the 
data acquired from the mass spectrometer. 

Analog channels are typically used to collect data from external units such as 
UV detectors, which must be connected to the ANALOGUE CHANNEL 
connectors described in Analog Channels on page 1-22.

A reading is made from the external channel at the end of each scan and 
stored with the data for that scan. The resolution of the chromatography for 
an analog channel is therefore dependent on the scan speed used to acquire 
the mass spectrometry data.

To open the Analog Data dialog box, select Options > Analog Data on the MS 
Method Editor.

Analog Data dialog box:

To store data for an analog channel:

1. Select the box(es) for the channel(s) required.

2. Enter a textual description for each selected analog channel.

This description is used on the analog Chromatogram dialog box as the 
channel description. See MassLynx Help.

3. Enter an Offset (minutes) to align the external unit with the mass 
spectrometer.

4. Click OK.
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Saving and Opening a Function List

To save a Function List file:

1. On the MS Method Editor, select File > Save As to open the Save As 
dialog box.

2. Enter a new file name or select an existing file from the displayed list.

3. Click Save.

If the file already exists on disk, confirmation is requested to overwrite 
the existing information.

4. Click Yes to overwrite the file or No to select a different name.

When the editor closes, a prompt is displayed to save any changed 
Function Lists.

To open a saved Function List file:

1. From the MS Method Editor, select File > Open to open a standard Open 
dialog box.

2. Select the name of the Function List file to open, either by typing its 
name or by selecting it from the displayed list.

3. Click Open.
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Overview of NanoLockSpray

The NanoLockSpray interface mounts directly onto the standard ZSpray 
source. It provides a low flow capability NanoSpray probe (< 2 µL/min) 
orthogonal to the analyte NanoSpray probe for introduction of the reference 
compound. This probe has the same capillary voltage applied as the standard 
probe and the nebulizing gas lines are coupled. Also, on the NanoLockSpray 
interface, is a baffle attached to a position indexed stepper motor. This admits 
the spray from either the standard analyte NanoSpray probe or the reference 
probe to the sampling cone for acquisition. 

Schematic Representation of NanoLockSpray:

Spray indexing allows the analyte and reference data to be acquired into 
separate data files and the design of the baffle produces negligible cross talk 
between the two sprays. Data from the reference spray are used to calculate a 
correction factor for the mass scale calibration, which is then applied to the 
analyte data to provide exact mass information. 

Reference InletBaffle

Analyte Inlet

Ion Block
Sampling Cone

Transfer
Optics
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NanoLockSpray installation

To remove the source enclosure:

1. In the Lock Spray frame of the Source page set the baffle to Reference.

2. Disconnect the Desolvation Heater electrical connection on the 
instrument front panel.

3. Disconnect the PTFE tubing at the Desolvation gas connection on the 
front panel.

4. Use an Allen key to loosen the three captive source enclosure securing 
screws and remove the source enclosure from the instrument.

To install the NanoLockSpray interface:

Use the following figure as a guide.

Warning: The source is hot, so allow it to cool down for at least 
30 minutes before proceeding.

f

Warning: To avoid contamination with toxic and 
biohazardous materials, wear rubber gloves at all times 
while handling the components.
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NanoLockSpray connections:

1. Loosen the two thumbscrews and remove the adjuster assembly from 
the NanoLockSpray assembly.

2. Slot the NanoLockSpray interface on the source locating pillars and 
secure the three captive screws.

Motor

Adjuster assembly Nano LC Sprayer

Reference sprayer

Camera

Motor cable

Capillary voltage cable

Capillary voltage cable
NanoFlow gas line

Video socket

Interlock cable

Thumbscrew
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3. Refit the adjuster assembly and secure the two thumbscrews.

4. Connect the interlock cable, which hangs from the bottom of the 
NanoLockSpray interface, to the socket marked Heater/Interlock on the 
front connection panel.

5. Connect the reference probe cable to one of the sockets marked Capillary 
on the front connection panel.

6. Connect the sprayer platform cable to one of the sockets marked 
Capillary on the front connection panel. 

Tip: If a glass capillary sprayer is to be used, connect the sprayer 
platform cable to the NanoLockSpray Capillary Voltage Divider Box. 
Connect the divider box to one of the sockets marked Capillary on the 
front connection panel.

7. Connect the motor cable to the socket marked Motor on the front 
connection panel.

8. Connect the camera power cable from the socket on the end of the motor 
housing to the socket marked Power on the camera.

9. Connect the video cable from the socket on the camera marked Video 
Out to the MALDI connector on the front panel and connect the video 
socket on the rear of the instrument to the MassLynx PC.

10. Slide the sprayer platform out from the source, remove the sprayer 
cover, and fit the desired sprayer, securing with the thumbscrew under 
the mounting plate.

Captive screws
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11. Connect the nebulizer gas lines from both the reference probe and 
analyte sprayer to the 1/16 inch Swagelock tee piece provided. Connect 
to the NanoSpray connector on the front connection panel, via the 
provided adapter assembly.

Nebulizer gas line assembly:

12. Refit the cover over the sprayer, and carefully slide the sprayer platform 
towards the source, making sure that the sprayer tip does not collide 
with the source or baffle.

13. Insert blank plugs into the two Nebuliser gas connectors on the front 
connection panel.

NanoLockSpray capillary voltage divider box

The NanoLockSpray Capillary voltage divider box is designed for use with the 
glass capillary option. It divides the capillary voltage applied to the glass 
capillary sprayer by a factor of two, e.g. if you set the capillary voltage to 
2.4 kV in the tune page, the actual voltage on the glass capillary sprayer will 
be 1.2 kV. The voltage on the reference sprayer is unaffected. The use of this 
divider box is necessary as the glass capillary sprayer optimizes at a much 
lower voltage than the reference sprayer. 

1/16" Swagelok Tee

1/16" o.d. x 0.8 mm i.d. PTFE tubing 

Adapter assembly
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Divider box:

Adjusting the NanoLockSpray camera lens

The NanoLockSpray camera is fitted with a macro zoom lens. There are three 
adjustment rings on the lens barrel, each of which is fitted with a locking 
screw. An adjustment ring will not rotate while its locking screw is tight.

Camera controls:

Aperture
This controls the brightness of the image. It is usually set to 22. 

Note: The camera has an automatic gain control that attempts to 
compensate for changes in image brightness.

Aperture
Focus

Zoom

Locking screws
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Zoom 
The lens has a x3 zoom range. Adjust the zoom to control the field of 
view. At the maximum zoom the sprayer tip can be examined closely. At 
the minimum zoom the relative positions of the sprayer, baffle and 
sampling cone can be observed.

Focus
Adjust this control to focus the image. Focus on the probe tip for optimal 
spray imaging. The depth of field is a function of the aperture setting; a 
wide open aperture will produce a very small depth of field.

The NanoLockSpray baffle

The NanoLockSpray source is supplied with two types of baffle:

• The nano-baffle - this baffle is optimized for use with the Nano-LC 
sprayer.

• The pico-baffle - this baffle is optimize for use with the PicoTip and glass 
capillary sprayers. This baffle allows the sprayer to be positioned closer 
to the sampling cone.

Nano-baffle:

Thumbscrew

Nano-baffle
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Pico-baffle:

To remove a baffle:

1. Set the instrument to standby

2. Set the source temperature to 20°C. Wait for it to cool.

3. Set LockSpray to the reference position

4. Disconnect the sprayer platform cable.

5. Loosen the two thumbscrews and remove the adjuster assembly from 
the nanoLockSpray interface.

6. Loosen the thumbscrew on the baffle and remove the baffle.

Warning:  To avoid burns, take great care while working with the 
source as it is liable to be hot.

Thumbscrew

Pico-baffle
Baffle support
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Baffle in analyte position:

To assemble the pico-baffle:

The baffle is made up of four pieces (shown below).

Pico-baffle components:

1. Attach the baffle to the baffle support with the locating screw. Observe 
the correct orientation: the baffle edges fold towards the screw head.

2. Insert the thumbscrew into the baffle support, from the same side as the 
locating screw.

Nano-baffle

Thumbscrew

Motor arm

Thumbscrew

Locating screw

Pico-baffle
Baffle support
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Pico-baffle fitted:

Nano reference probe assembly instructions

Caution: Wear gloves whenever handling parts from the inside of the 
instrument. Check all of the parts are present. Refer to the shipping document 
for part numbers and descriptions.

To assemble the reference probe:

1. Remove the two screws holding the reference assembly to the source 
enclosure.

2. Carefully lift the reference assembly from the source enclosure.

3. Make a sleeve for the 20-µm fused silica (page 5-12).

4. Prepare the 20 µm fused silica (page 5-12) and the 75 µm fused silica 
(page 5-13).

5. Prepare the Valco tee piece (page 5-14).

6. Prepare a gas tight fitting and a nebulizing capillary (page 5-14).

Warning: Wear suitable eye protection at all times when handling or 
preparing fused silica and borosilicate tips.

Warning: To avoid injury from trace chemicals on the probe, always 
wear gloves.

Sample cone

Reference sprayer

Pico-baffle

Baffle support
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7. Prepare the nebulizing gas connector (page 5-16).

8. Thread the tube through the assembly (page 5-17).

9. Prepare the nebulizing PTFE tube (page 5-18).

To make a sleeve for the 20-µm fused silica:

1. Cut approximately 30 mm of the 1.6 x 0.12 mm PTFE tubing and insert 
it into one side of the Valco metal union. 

Rule: Ensure that the PTFE has been cut squarely.

2. Hand tighten and push the PTFE tube in as far as it will go.

3. To position the ferrule tighten the union nut to make the ferrule grip 
onto the PTFE tube, but do not overtighten

4. Remove the tube from the union and cut it down in length such that it is 
just flush with the edge of the union nut. 

To prepare the 20-µm i.d. fused silica: 

1. Using the ceramic cutter, cut approximately 15 cm of 20-µm i.d. fused 
silica (6028621) and thread into the sleeve made above.

Warning: Eye protection should always be worn when cutting fused 
silica.

SleeveFerrule
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2. Insert the sleeve and silica into the union. 

3. Push the silica through the union and progressively tighten the union 
nut and test the tightness of its grip on the silica. 

4. Once the grip is sufficient to restrict movement, remove the nut and 
move the silica so it is flush with the edge of the PTFE sleeve. 

5. Tighten up the nut to lock the fused silica in place.

Tip: This may require some force.

To prepare the 75-µm i.d. fused silica and make the union with the 20-µm 
assembly:

1. Cut a long length (>30 cm) of 75 µm i.d. fused silica (6490512) and make 
a sleeve using a green PEEK tubing sleeve (6070190). 

2. Ensure that the silica has been cut squarely to reduce dead space. 
Thread the sleeve into a headless seal-tight nut and ferrule and thread 
the 75-µm i.d. fused silica through the sleeve making sure that the fused 
silica end is flush with the end of the sleeve. 

3. Push the PEEK as far as it will go to ensure minimum dead space and 
insert the silica and nut into the other side of the Valco union. Tighten 
using the nut extender tool.
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To prepare the Valco tee-piece:

1. Use a 1.5-mm key to loosen the grub screw locking the Valco tee-piece 
onto the probe assembly. 

2. Remove the Valco tee-piece. 

To prepare a gas-tight fitting and nebulizing capillary:

1. Take 30 mm of the 0.12 x 0.8 mm PTFE tubing and make a sleeve to 
form a gas tight seal at the tee piece, using the tee piece nut and ferrule. 

2. Tighten the nut to make sure that the ferrule grips, taking care not to 
over-tighten. Remove the nut from the tee and cut down the PTFE 
tubing so that approximately 4 mm of sleeve protrudes from the nut of 
the tee. 
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3. Attach 20-µm id fused silica by threading the 20-µm i.d. fused silica 
attached to the union through this nut and sleeve, but do not tighten the 
tee nut as the silica needs to be mobile.

4. Thread the fused silica through the tee-piece

5. Push the nebulizing tube as far as it will go into the Valco tee-piece and 
tighten the tee nut until the ferrule grips.

Tip: Depending on which baffle is used, there are two lengths of tube see 
The nebulizer tube on page 5-19.

6. Thread the 20-µm i.d. fused silica through the nebulizing capillary. 

7. Tighten the tee nut holding the PTFE sleeve so that it is finger tight and 
make sure that the fused silica is free to move though the tee. 

8. Thread the fused silica through the Valco tee until the fused silica 
protrudes from the nebulizer tube.

Nebulizing Capillary

Fused Silica

PTFE Sleeve
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9. Thread the 75-µm i.d fused silica up through the probe body and clamp 
the Valco union into position by tightening the grub screw behind it.

10. Clamp the Valco tee into position by tightening the grub screw. The 
excess length of 20-µm i.d. fused silica should form a loop.

11. Adjust the length of 20-µm i.d. fused silica protruding from the nebulizer 
tube to between 0.5 to 1 mm, and tighten the nut on the PTFE sleeve to 
clamp it in position.

To prepare the nebulizing gas connection:

1. Remove the reference sprayer outer cover.

2. Remove the PEEK bulkhead union. 

20-µm i.d. fused silica

75-µm i.d. fused silica

Fused Silica Loop

Nebulizing Capillary
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3. Cut approximately 12 cm of the PTFE gas tube (6063066).

4. Insert the nebulizing gas tube (6063066) through the small PEEK nut 
and ferrule and tighten until the ferrule grips. 

To thread the tube through the assembly.

1. Thread the tube through the plastic nut and the rest of the assembly. 

Threading the tube through the probe assembly

Gas Tube Ferrule

Bulk Head Union
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2. Tighten the nut so that the bulkhead union is held securely. 

3. Bend the tube so that it fits into the tee and tighten the nut so that the 
ferrule grips the tube securely.

To prepare nebulizing PTFE tube: 

1. Cut a length of PTFE tube and insert it into the larger of the PEEK 
bulkhead union nuts and tighten until the ferrule grips the tube 
securely. 

2. Using the 1/16 inch tee split the nanoflow gas supply into two feeds. 
Attach the end of the reference probe PTFE tube to the tee and tighten 
until the ferrule grips. 

PTFE Tube
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3. Attach the other end of the nanoflow gas supply to the analyte probe. 

4. Attach the probe casing to complete the assembly. 

The nebulizer tube

Rationale: The pico-baffle should be used in conjunction with a longer 
nebulizer tube. The pico-baffle nebulizer tube is 24-mm long, whereas the 
nano-baffle nebulizer tube is 20-mm long. The use of the correct nebulizer 
tube will prevent crosstalk between the reference and analyte sprays.

To install the nebulizer tube:

1. Remove the reference probe from the source.

2. Remove the Valco screw from the bottom of the Valco tee piece and 
withdraw the nebulizing capillary.

3. Slide the Valco nut and a ferrule over the 24-mm long nebulizer tube. 
Carefully slide over the 20-µm fused silica, and screw into the Valco 

Warning: The Nanoflow assembly should not be operated without 
the probe casing attached.
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tee-piece, pushing the nebulizer tube in as far as it will go. Tighten the 
nut until the ferrule grips the nebulizer tube.

4. Loosen the nut on the top of the Valco tee-piece and adjust the length of 
the 20-µm fused silica so that about 0.5 to 1 mm of protrudes. Retighten 
the nut.

5. Refit the reference probe.

Operation overview

The operation of the nanoLockSpray source is very similar to the standard 
LockSpray source. See Chapter 2 for general information about how to tune 
the instrument, and see Chapter 4 for a description on how to acquire 
accurate mass data from a LockSpray source.

Source type selection

To select the source:

1. From the Tune window, click Source > Nanoflow.

2. Click Mode > LockSpray On.

Reference sprayer
The reference sprayer is normally run off the instrument's syringe pump, 
fitted with a 100 µL syringe, at a flow rate of 0.5 µL/min. There is no 
positional adjustment for the reference probe. The concentration of the 
reference solution should be chosen to give a suitable ion intensity.

The concentration of the reference solution should be chosen to give a suitable 
ion intensity, i.e. between 0.05 and 0.2 ions-per-push (IPP)
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Analyte sprayer
The NanoLockSpray source can be used with a range of different nanoflow 
sprayers. Refer to the sprayer-specific instructions on how to set up these 
sprayers.

See also: 
• Set capillary back to previous voltage. on page 5-33

• Glass capillary option on page 5-29

NanoSpray gas supply
The reference and analyte sprayers share a common NanoSpray gas supply. 
The pressure of this supply is electronically controlled over the range 0 to 3 
bar. The optimum pressure is sprayer dependent, but usually lies within the 
range 0.5 to 1.5 bar.

Important: The Nebulizer gas connections must be blanked off, using blank 
plugs, while the NanoLockSpray source is in use.

Sprayer platform adjuster assembly
The sprayer platform adjuster assembly allows precise XYZ positioning of the 
sprayer tip. It also allows the sprayer to be withdrawn from the source to 
allow sprayer access.

There are two thumbscrews on the base of the adjuster assembly that are used 
when moving the platform in and out of the source.

To withdraw the sprayer platform from the source:

1. Unscrew the front thumbscrew.

2. Pull out the side thumbscrew while pulling the sprayer platform out 
from the source.

3. Release the side thumbscrew, locking the platform in the out position.

4. The Operate LED will flash green if the platform is pulled out while the 
instrument is in operate. The tune page will show the status message 
‘Operate - probe interlock active’. The probe interlock sets the capillary 
voltage to zero, removing the voltage from the sprayer.
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To slide the sprayer platform into the source:

1. Check the sprayer safety cover is installed

2. Pull out the side thumbscrew while pushing the sprayer platform into 
the source.

3. Release the side thumbscrew, locking the platform into position.

4. Tighten the front thumbscrew, securing the adjuster assembly rigidly to 
the source.

5. The operate LED will show steady green if the instrument is in operate.

Caution: While the operate LED is a steady green, there is a high voltage on 
the sprayer. The safety cover should always be installed, and care should be 
taken not to touch the sprayer.

Sprayer tip position

To adjust the tip position:

1. Adjust the X, Y and Z controls on the adjuster assembly in order to 
position the sprayer tip close to the sampling cone and baffle. 

2. Adjust the height of the sprayer so that the tip is level with the center of 
the baffle.

3. Adjust the horizontal position of the sprayer so that the tip is towards 
the left end of the baffle. 

Tips: 
• If electrical discharge between the sprayer tip and baffle is observed, 

either move the tip further away from the baffle, or reduce the capillary 
voltage. The capillary voltage must be maintained high enough to 
maintain a good spray.

• The position of the sprayer should be fine-tuned while acquiring a 
spectrum of a standard compound. Small adjustments to the sprayer 
position can make large differences to the source sensitivity.
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Setting up the camera

To enable the camera:

1. From the Tune window click Source > Nanoflow to enable the NanoFlow 
tuning parameters.

2. Click .

Result: The Camera Control dialog box opens.

Camera Control view of sprayers and sample cone:

3. Using the camera controls described in Adjusting the NanoLockSpray 
camera lens on page 5-7, focus on the analyte sprayer. If necessary 
manoeuvre the stage so that the camera can view the capillary tip.

Adding NanoFlow Options

You can fit the NanoLockSpray interface with several sprayer options, two of 
these are:

Analyte spray

Reference sprayer

Baffle

Sample cone
Adding NanoFlow Options 5-23



• Nano-LC Option (page 5-24)

• Glass Capillary Option (page 5-29)

Nano-LC Option

Nano-LC Assembly

Warning:  To avoid contamination from hazardous chemicals wear 
gloves when handling the sprayer assembly

Valco Ferrule

PTFE Sleeve

Low pressure PTFE connectorColumn or silica cap from injector
Fused silica capillary

Microvolume insert

Make-up flow 
only (3-way 
insert required)

Nebulizer gas

90 µm fused silica
O-ring

Nebulizer gas 
via NanoFlow 
gas regulator

Nano-LC body

Chamber

Nebulizing tip
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The sprayer assembly contains a microvolume-insert that couples the flow 
from an injector, syringe pump or nano-HPLC system to a length of fused 
silica that acts as the spray nozzle at the end of the nebulizing tip.

A length of PTFE tubing supports the fused silica within the chamber. The 
PTFE fits into the microvolume insert and is retained using a metal ferrule, 
along with the thread on the end of the chamber.

To assemble the fused silica and PTFE support:

1. Cut a 50-mm length of PTFE support sleeve tubing (1/6 × 0.12).

2. Cut a 70-mm length of capillary (TSP020090).

3. Thread the capillary through the prepared length of support sleeve.

4. Align the support sleeve and capillary flush at one end.

5. Thread the supplied plug cap nut and 1/16 metal Valco ferrule over the 
support sleeve.

Support sleeve 
and capillary 
aligned flush
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6. Fit the plug cap over the end of the support sleeve.

7. Push the support sleeve tubing to the end of the plug cap nut to set the 
“pilot” depth (see Figure titled “Fused Silica Capillary and PTFE 
Support Sleeve Assembly:” on page 5-27).

8. Engage the plug cap nut in the plug cap thread and tighten so that the 
1/16 metal Valco ferrule just grips the support sleeve. 

Tip: Do not fasten the ferrule too tight at this point as you are required 
to re-thread the silica capillary through the PTFE support sleeve later in 
the procedure.

9. Unscrew the plug cap nut and remove from the support sleeve.

10. Remove the capillary and plug cap from the support sleeve, leaving the 
ferrule behind.

Plug cap

Plug cap nut
1/16 metal Valco ferrule
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11. Cut the support sleeve so that only 10 mm protrudes through the back of 
the ferrule.

Fused Silica Capillary and PTFE Support Sleeve Assembly:

12. Re-thread the capillary through the 10-mm length of support sleeve and 
align flush with end of the tubing.

13. Using the plug cap and nut again, tighten the ferrule so that the 
capillary is firmly gripped within the support sleeve.

14. Remove the plug cap and nut from the support sleeve.

To fit the capillary in the Nano-LC chamber:

1. Thread the capillary and the PTFE support sleeve through the Nano-LC 
chamber.

2. Fit the microvolume insert into the Nano-LC body. Rotate the insert so 
that the ferrule seats line up with the column and chamber connections.

3. Fit the Nano-LC chamber into the body and tighten.

4. Pull gently on the PTFE support sleeve to confirm that the support 
sleeve is gripped firmly.

10 mm

Nebulizer
tipMicrovolume

1.5 mm pilot depth

T-insert
Adding NanoFlow Options 5-27



To fit the nebulizing tip:

1. Slide the nebulizer tip over the capillary and tighten into the chamber, 
(see Figure titled “Nano-LC Assembly” on page 5-24).

2. Continue tightening until approximately 3 mm of tip protrudes.

Fitting the nebulizer tip:

3. Using a silica cutter cut the exposed silica capillary flush with the end of 
the nebulizer tip.

4. Continue tightening until approximately 1 mm of silica capillary 
protrudes through the tip. 

Fitting the silica capillary:

To Operate the Nano-LC Option

The operation of the Nano-LC sprayer should be tested by infusing a known 
sample.

1. Set the NanoSpray pressure to about 1 bar.

2. Check for leaks of gas on the sprayer.

3. Mount the sprayer on the adjuster platform. Fit the safety cover.

4. Slide the sprayer platform into the source.

3 mm

Trim flush

2 mm

Trim flush
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5. Adjust the sprayer position.

6. Fill a 10 mL syringe with a known sample (e.g. leucine enkephalin 
50 pg/µL)

7. Set the syringe pump to 0.5 µL/min

8. Set the capillary voltage to about 3 kV.

9. Open the camera control window to view the spray. A fine spray should 
be observed. Try varying the nanospray pressure and the capillary 
voltage. It may be necessary to adjust the nebulizing tip - the sprayer 
will have to be removed to do this. The nebulizer tip can be screwed in or 
out adjusting the length a fused silica capillary protruding from the tip.

10. Carefully adjust the sprayer position to get the maximum ion count on 
the sample.

Glass capillary option
The glass capillary option sprayer is designed for use with metal coated 
borosilicate glass capillaries (nanovials). These allow extremely low flow rates 
of less than 100 nL/min. 

Installation of pico-baffle

The glass capillary option should be used with the pico-baffle. See The 
NanoLockSpray baffle on page 5-8.

To install the glass capillary option:

1. Pull the sprayer platform assembly back from the source.

2. Remove the safety cover.

3. Place the sprayer (with gas line fitted) on the platform and secure with 
the thumbscrew.

4. Refit the safety cover.

5. Connect the sprayer platform cable to the nanoLockSpray capillary 
voltage divider box. Connect the divider box to one of the sockets marked 
capillary on the front connection panel.
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To load the capillary:

1. Unscrew the union at the front of the sprayer, and remove the front 
section of the sprayer.

2. Carefully remove the capillary from its case by lifting vertically while 
pressing down on the foam with two fingers.

Warning: Do not touch the sharp end of the capillary. As well 
as the risk of injury by a sliver of glass, the capillary may 
contain toxic samples.

Warning: The capillaries are extremely fragile and must be 
handled with great care. Always handle using the square end of 
the capillary. The needle may become inoperable if the sharp end 
is touched.

Glass capillary

7 mm

Blue conductive elastomer

Knurled nutUnion

Ferrule

PTFE “Back Pressure” tubing
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3. Over the blunt end of the capillary, pass the knurled nut, approximately 
5 mm of conductive elastomer, and finally the union.

4. Slide the glass capillary into the union and gently tighten the nut. The 
tip should protrude about 7 mm from the front of the knurled nut. This 
distance is measured from the end of the nut to the shoulder of the glass 
capillary.

Tip: You can remove and replace the capillary without undoing the nut, 
just slide the old one out and carefully slide the new one in.

5. Load sample into the capillary using either a fused silica syringe needle 
or a GELoader tip.

Tip: Shake the loaded capillary in order to move the liquid to the tip of 
the sprayer

Union
Knurled nut

Elastomer

Tip holder

Sprayer body
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6. Screw the holder back into the assembly - finger tight is sufficient. This 
done when the sprayer is mounted on the adjuster platform.

7. Ensure that Capillary is set to 0 V on the Tune window.

8. Push the sprayer platform into the source. 

To operate the glass capillary sprayer:

1. Set the nanospray pressure to 0.3 bar, and the cone gas to 40 L/h.

2. Check for sample flow by observing a droplet on the tip. If no droplet is 
observed, increase pressure briefly, up to a maximum of 1.5 bar. Return 
pressure to 0.3 bar. 

3. If a spray is still not observed, then break off a small piece from the end 
of the tip, as described below in To restart the spray: on page 5-33 

4. Set the capillary voltage slider to between 1.0 and 3.0 kV.

Note: With the voltage divider box in use, a Capillary voltage slider 
range of 1 to 3 kV corresponds to an actual sprayer voltage of 0.5 to 1.5 
kV.

5. An ion beam should now be visible on the peak display.

6. Optimize sprayer position and capillary voltage for maximum signal 
intensity.

See also: Spray optimization on page 5-34.
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To restart the spray:

1. Set capillary voltage to zero.

2. Move the sprayer back and to the left until the tip aligns with the groove 
on the cone; this is best done while viewing from the front of the source.

3. While watching the camera image, carefully move the tip forwards 
towards the groove until it touches and a small piece of the glass hair 
shears off.

4. Return sprayer to previous position.

5. Set capillary back to previous voltage.

Glass capillary

Groove
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Spray optimization

The spray will optimize between 1.0 and 3.0 kV. The following diagrams 
indicate the shape of the spray at too low, optimal, and too high voltages.

Liquid is emitted from the tip
as a narrow jet:

Capillary voltage is too low

Liquid is emitted from the tip
as a wide stable spray: 

Capillary voltage is optimal

Liquid is emitted from the tip
as two or more unstable
sprays: 

Capillary voltage is too high
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Overview

For the automated MS/MS analysis of unknown compounds, the Micromass 
Q-Tof Premier has a powerful software control system to enable the 
instrument to perform data-directed analysis (DDA), switching from the MS 
to MS/MS mode and then returning to the MS mode using data criteria. The 
advantage of this method is that it removes the requirement to analyze the 
sample in MS mode to identify the target precursor ions and then re-run the 
sample in MS/MS mode to acquire the MS/MS data from each of these 
precursors. This is particularly valuable in the analysis of unknown samples 
using on-line chromatography where the target precursor ions and their 
retention times may well be quite different for each sample.

During acquisition, the instrument is controlled by the MS file in the 
MassLynx Sample List. DDA can only be acquired using the Sample List and 
may not be started by acquiring from the Tune window.

Precursor Ion Discovery

Precursor ion discovery allows specific targeting of molecules containing a 
common structural motif, e.g. post translationally modified peptides. It allows 
both identification and structural information to be obtained during the 
course of an HPLC experiment on the Q-Tof Premier. During the HPLC run 
the instrument is switched alternately at one-second intervals between low 
and high collision energy with argon in the collision cell. The quadrupole, MS1 
is not mass selective, operating in the rf only mode. The first data set at low 
energy (4 eV) shows only the normal pseudo molecular ions. The second at 
higher energy shows their fragments. Wherever a precursor ion of interest 
occurs in the high-energy data, all its possible precursors are revealed by the 
corresponding 4 eV data. 

Since the two data sets contain the entire set of product and precursor ions 
that can be formed, it is also clearly possible to generate the equivalent of a 
constant neutral loss scan. 

Example: This is invaluable in the case of phosphorylated peptides where the 
neutral loss of 98da (H3PO4) occurs via ß-elimination from the phosphoserine 
and phosphothreonine residues. This allows the Q-Tof Premier to switch from 
the MS mode to the MS/MS mode of operation when a potential pseudo 
molecular ion exhibits a neutral loss of 98 Da between the high energy and 
low energy data sets. The precursor ion MS/MS spectrum can then be acquired 
on the phosphorylated precursor ion.
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Setting-up an Experiment 

DDA experiments are set up from the MS Method editor. There are three 
different types od DDA acquisitions:

• Survey - Automatic selection of precursors for MSMS

• PID Product - Precursor Ion Discovery by product ion detection

• PID Neutral - Precursor Ion Discovery by neutral loss detection

Experiment parameters and MS > MSMS > MS switching criteria are entered 
into a series of pages that are largely common to all three DDA experiment 
types. These are shown diagramatically in the Figure titled “DDA flow 
diagram:” on page 6-4.

The simplest Survey experiment can be set up using just the Acquisition page, 
MS Survey page and MS/MS page. More advanced selection criteria can be 
entered on other pages. For PID and PID Neutral further criteria have to be 
entered into Product Ion page and Neutral Loss page respectively.
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DDA flow diagram:

Open the MS Method Editor

Acquisition page

Set the survey 
range, acquisition 
conditions, and 
conditions to 
switch to MS/MS

Set the initial 
acquisition 
Parameters

MS Survey page

Set Product ion 
criteria

Set Neutral Loss 
criteria

Set the range to 
acquire data, 
conditions to 
acquire, and 
conditions to 
switch back to MS

MS/MS page

Configuration 
criteria for peak 
detection

Peak Detection page

Configuration 
criteria for peak 
detection

Adducts page

Configuration 
criteria for peak 
detection

Collision Energy page

Configuration 
criteria for peak 
detection

LockMass page

Set the m/z to 
exclude from 
MS/MS

Exclude page

Set predefined 
m/z to include in 
MS/MS

Include page

Configuration 
criteria for peak 
detection

Cone Voltage page

Configuration 
criteria for peak 
detection

Variable Flow page
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Product Ion page

Neutral Loss page
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To Create a DDA Experiment:

1. From the MassLynx window click the MS Method icon to open the MS 
Method Editor.

MS Method Editor:

2. Select the default entry that appears in the MS Method Editor.

3. Click , to delete the selected entry.

4. Select the type of experiment you want to perform, click either:

• Survey 

• PID Product 

• PID Neutral 

Result: The relevant DDA dialog box opens.

5. Set the experiments parameters on the pages.

6. Save the *.exp method file.
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Acquisition page

The Acquisition page is used for setting the initial conditions for the 
experiment. It is common to all Function scans and is described in Chapter 4 
on page 4-19.

MS Survey page

Using the MS Survey page, you can configure the following parameters:

• The m/z range over which to acquire data. (MS Survey m/z Range on 
page 6-6)

• The conditions that the data will be acquired (MS Survey Scanning 
Conditions on page 6-7).

• The conditions at which the survey scan is stopped and the acquisition 
switches to MS/MS mode (Stop the MS Survey on page 6-8).

MS Survey m/z Range
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MS Survey Scanning Conditions

Parameter Description
Inter-Scan Delay Normally set to 0.02 s.

Data Format The data format used to save the scans:
• Centroid
• Continuum
Important: MaxEnt3 and PLGS require data in 
continuum format.
See also: Types of Data Acquisition on 
page 4-17.
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Stop the MS Survey

MS/MS page

Using the MS/MS page, you can configure the following parameters:

• The m/z range over which to acquire data. (MS/MS m/z Range on 
page 6-9)

• The conditions that the data will be acquired (Scan rates and 
Instrument Conditions for MS/MS on page 6-9).

• The conditions at which the MS/MS acquisition is stopped and the 
acquisition switches back to MS Survey (Stop MS/MS (Survey 
experiment) on page 6-10).

Tip: The parameters that are used to stop the acquisition are different 
depending whether you are doing a Survey or PID experiment

Parameter Description
TIC rising above threshold When selected, the MS scan stops and the 

MS/MS scan starts when the Total Ion Current 
(TIC) of the scan rises above the specified 
threshold value.

Intensity of individual ion 
rising above

When selected, the MS scan stops and the 
MS/MS scan starts when the intensity of an 
individual ion is above the specified threshold 
value.

Threshold The value at which the switch to MS/MS 
acquisition is made.
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MS/MS m/z Range

Scan rates and Instrument Conditions for MS/MS

Parameter Description
Acquire MS/MS over the range

Start m/z The mass at which the MS/MS scan starts.

End m/z The mass at which the MS/MS scan stops.

Maximum number of ions which can be selected for MS/MS from a single MS 
survey scan

Select (1-8) Specifies the maximum number of simultaneous 
MS/MS functions.

Parameter Description
Scan Time The scan duration of the MSMS scans.

Inter-Scan Delay Normally set to 0.02 s.
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Stop MS/MS (Survey experiment)
The decision to Stop MS/MS can be made using the TIC or individual ion 
intensity. Since multiple precursors may be selected for concurrent MS/MS 
experiments it is usual to set this to Intensity and a “Return to MS Survey” 
after value. 

In the figure above the switch would occur after 6 seconds assuming the 
intensity of the base peak in the MS/MS spectrum had not fallen below 2 cps. 
These rules apply on a per precursor basis. 

Example: If MS/MS were concurrently running on 3 precursors and one 
MS/MS spectrum fell below 2 cps then MS/MS would be terminated on that 
precursor. The MS/MS on the remaining 2 precursors would continue until 
either they fell below the 2 cps threshold or each MS/MS precursor ion had 
been acquired for 6 seconds. If the intensity threshold were set to 0 cps then 

Data Format The data format used to save the scan in:
• Centroid
• Continuum
See also: Types of Data Acquisition on page 4-17.

IPR file for MS/MS When selected, the cone voltage defined in the tune 
file in the adjacent box will be used. Type the file 
name in the box or use  to browse for a file.

Parameter Description
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MS/MS acquisition would continue on all three functions until a total of 18 
seconds had elapsed (6 seconds for each precursor) 

Stop MS/MS (PID Experiment)

Parameter Description
TIC falls below When selected, the MS/MS scan stops and switches to 

MS scan when the TIC of the MS/MS scan falls below 
the specified threshold value.

TIC rises above When selected, the MS/MS scan stops and switches to 
MS scan when the TIC of the MS/MS scan rises above 
the specified threshold value.

Intensity falls below When selected, the MS/MS scan stops and switches to 
MS scan when the Base Peak Intensity (BPI) falls 
below the specified value.

Return to MS Survey 
after

When selected, specifies a time, (in seconds) after 
which, if non of the threshold criteria are met, the 
MS/MS scan stops and returns to the MS scan. 
Typical values are from 3 s upwards, depending upon 
the chromatography and number of concurrent 
MS/MS spectra.

Parameter Description
After Select to specify the maximum time that will pass 

before returning to MS survey
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Include page

The Include tab allows a number of predefined m/z values to be included in the 
decision making process. Once enabled you can either:

• Only select ions that are on the list

Or

• Select the ions preferentially

Tip: The selection criteria entered here only apply to Survey experiments. 
This page is not available for PID experiments.

Include Mass

If the expected Product 
Ion is absent from the 
MS/MS scan

Select this to return to the MS scan if the product 
ion is not found. 
Tip: For a Neutral Loss experiment this 
parameter is the same but “Product Ion” is 
replaced with “Neutral Loss”.

Absent is below Enter the number of counts per second at which 
the software will consider an ion absent.

Parameter Description
Enable MS/MS 
peak selection 
using an include 
list

When selected, allows a number of predefined mass 
values to be used as switching criteria from MS to 
MS/MS. There are two distinct modes of operation.

Parameter Description
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Only select peaks 
that are on the 
include list

When selected, only masses on the Include list will be 
selected for MS/MS analysis.

Preferentially 
select peaks that 
are on the include 
list

When selected, masses include on the Include list have 
priority over any other mass detected for MS/MS.

Include peaks 
within +/-

Specifies the mass tolerance value to be applied to all 
include masses.

Retention Time 
Window +/- ...mDa 
of entries on the 
include list

Specifies a tolerance to apply to the retention times in 
the include list.

Parameter Description
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Include File List

Parameter Description
Include from 
range

Specifies the required masses, or range of masses, to be 
used from those in the Include List. Use commas to 
separate individual masses. Use an underscore to 
denote a range of masses, for example, 510, 520, 
550_600, 700.

Include from file When selected, the name of an existing Include List file 
can be entered in the adjacent text box. Alternatively, 
use  to browse for an existing file. Specific parameters 
(Retention Time, Collision Energy, Cone Voltage, 
Charge State) can be associated with these m/z values, 
that will override parameters set elsewhere.
See Also: Include File List on page 6-14

New Resets all the options and clears the Include List.

Add Opens the Include Masses dialog box, which allows the 
Include List to be edited.
If Add is not enabled, select Include from Range or 
Include of File.
See Also: Include File List on page 6-14

Delete Deletes the selected entry from the list.
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To edit the Include list

1. Click Add to open the Include Masses dialog box.

Include Masses dialog box:

Tip: To edit an existing entry in the Include List, double-click it.

2. Select the check box for the required option and enter the value in the 
adjacent text box.

Tip: The text box becomes available only when you select an option.

The Include Masses dialog box parameters are described below.

Save Saves the Include List details to an existing file.

Save As Save the Include List to a new file. 

Parameters Description
Include Mass Specifies the include mass to be added to the mass list.

Retention Time Specifies the associated retention time, in minutes. If 
the specified mass elutes at the specified Retention 
Time and is within the Include tab Retention Time 
Window (+/-) value, the mass is considered to be on the 
Include List. This allows masses eluting from a column 
to be included as a mass of interest.

Parameter Description
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Collision Energy page

Using the Collision Energy tab, you can configure the collision energy 
parameters that are used during the experiment. There are three possible 
options:

• Use Tune Page Collision Energy (see page 6-16)

This is the least sophisticated option since it just uses the value for the 
collision energy that is taken from the Tune window.

• Use Collision Energy Profile (see page 6-17)

The collision energy profile option allows a range of different collision 
energies to be used depending on the m/z value of the selected precursor. 
In addition from 1 to 5 collision energies may be used for each precursor 
m/z to attempt to produce optimal fragmentation. 

• Use Charge State Recognition (see page 6-20)

This is the most sophisticated option. The decision that the software 
makes, on what collision energy to use, is based upon the m/z and the 
charge state. 

This mode will allow the collision energy to be set according the charge 
state (z) and m/z of the precursor as determined by the software. 
Collision energy files for charge states from 1 to 6 may be created and 
selected. The files specify a list of m/z values and associated collision 
energies. The applied energy is interpolated linearly between the 
specified masses within the file, so each m/z across the mass range will 
have different energies applied 

Collision Energy Specifies the collision energy used to fragment the 
detected mass for the MS/MS scan.

Cone Voltage Specifies the cone voltage value applied during the 
MS/MS scans. 

Charge State Include the mass by the charge state.

Scan Time The scan time, in seconds, used during MS/MS scans 
for the detected mass. 

Inter-Scan Time The inter-scan time, in seconds, used during MS/MS 
scans for the detected mass.

Parameters Description
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Rationale: For peptide analysis collision energy profiling by cycling 
around a number of different energies is less likely to be required. 

• Use Collision Energy Ramp (see page 6-24).

Default Collision Energy pane:

Collision Energy Profile parameters
Using the Collision Energy tab, Collision Energy Profile parameters, you can 
set up a list of collision energy profiles for a range of m/z values.

This option allows a range of different collision energies to be used depending 
of the m/z value of the selected precursor. In addition 1 to 5 collision energies 
may be used for each precursor to attempt to produce optimal fragmentation.

Example: If 4 collision energies are selected, the scan pattern for a single 
MSMS function is as follows:

To enable the Collision Energy Profile Parameters:

Select the “Use Collision Energy Profile” option.

Parameter Description
Override collision 
energy value specified 
in ipr file

When selected specifies the collision energy to be 
used

Scan 1 2 3 4 5 6 7 8 9 10 11
CE 1 2 3 4 1 2 3 4 1 2 3
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Parameter Description
Collision Energy File Enter the file name of the Collision Energy Profile 

file or click  to browse for a file.

New Resets all the options and clears the Collision 
Energy Profile list.

Add Opens the CE Profile dialog box which allows 
collision energy profile lists to be created for 
masses that are being switched on.

Delete Deletes the selected entry from the list.

Save Saves the Collision Energy Profile list to an 
existing file. 

Save As Saves the Collision Energy Profile list to a new 
file.
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To create a Collision Energy Profile list

Using the CE Profile dialog box, you can create new collision energy profiles. 
The CE Profile dialog box parameters are described below.

CE Profile dialog box:

Parameter Description
From Mass (m/z) Start mass for the mass range in which the collision 

energy profile is to be used.

To Mass (m/z) End mass for the mass range in which the collision 
energy profile is to be used.

From Time (min) Start time for the time range in which the collision 
energy profile is to be used.

To Time (min) End time for the time range in which the collision 
energy profile is to be used.

CE1 - CE5 The five allowed collision energy values, which will be 
applied to a relevant mass at a relevant time during 
MS/MS scanning. Selecting the check box for one value 
enables the check box for the following value.

OK Closes the Collision Energy dialog box and enters the 
selected values in the CE Profile dialog box Collision 
Energy Profile list.
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Charge State Recognition parameters
Using the Collision Energy page Charge State Recognition parameters, a 
mass and it’s charge state can be used to obtain a collision energy value from 
the Charge State list. 

Example: When a mass of interest is detected in an MS experiment, its charge 
state is calculated. Using the mass and its charge state, a Collision Energy 
value can be obtained from the entered charge state table. The value is then 
used in the MS/MS experiment.

The Include page’s Include by Charge State and the Collision Energy page’s 
Use Charge State Recognition functionalities can be used independently, or 
both can be configured to combine their individual functionalities.

See also: Charge State Recognition functionality on page 6-23.

Parameter Description
CS1 File - CS6 File Enter the file name of the required charge state 

file, or click  to browse for a file.

Modify Displays the Modify Charge State dialog box; this 
is used to create, or modify charge state files.
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Creating or modifying Charge State files
Using the Modify Charge State dialog box, you can create or modify charge 
state files. The examples shown are a set of suggested collision energy profiles 
for peptides or protein digest applications when selecting M2+ ions for MS/MS 
analysis. 

Tip: Default files are included with MassLynx, which you can edit.

Modify Charge State dialog box:

Use advanced options 
for Charge State peak 
selection

When selected, allows you to specify the following 
advanced settings. If advanced options are not 
selected, the default values are used. See Charge 
State Peak Selection Parameters on page 6-32 for 
more details.

Parameter Description
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To open the modify charge state dialog box

1. On the Survey Scan Collision Energy tab, select Use Charge State 
Recognition.

2. Enter the required Maximum Number of Charge States.

3. Click Modify to open the Modify Charge State dialog box.

Tip: The number of Modify CS tabs displayed in this dialog box 
corresponds with the Maximum Number of Charge States selected in 
step 2.

To add a new Charge State:

1. From the Modify Charge State dialog box, click Add to open the Charge 
State Mass dialog box.

2. Enter a charge state mass value.

3. Enter a collision energy value.

4. Click OK. The new charge state mass is added to the list in the Modify 
Charge State dialog box.

Charge State Mass parameters

Button Description
CS mass (m/z) Specifies the mass of interest.

Collision Energy Sets the correct collision energy value for the 
mass of interest. 

OK Closes the Charge State Mass dialog box and 
enters the selected values in the Modify Charge 
State dialog box Mass List.
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Charge State Recognition functionality
You can apply charge state recognition functionalities from the Survey Scan 
Include and Collision Energy tabs. The functionalities, Include by Charge 
State and Use Charge State Recognition, can operate independently or 
together.

For peptide work the Use Charge State Recognition option is most useful as 
the diversity of peptide charge states and masses requires application of a 
large variation of collision energies. Importantly, the precursor isolated 
switches after each scan, in contrast to the Collision Energy Profile. This 
provides a more efficient profiling of the chromatographic peak.

Using Charge State Recognition with Include by Charge State 
disabled

This allows the software to switch on any peak of interest, but a collision 
energy value will be calculated only for those masses with a charge state that 
matches those set up in the Charge State Recognition frame. For all other 
masses, the default collision energy will be applied; this is either the Tune 
window value, or the value specified in the Survey Scan dialog box MS/MS 
Template tab.

For example, if the Include by Charge State option is disabled, and the Charge 
State Recognition has been configured for Charge States 1 and 2, any detected 
mass of interest switches on in the normal way. Masses switched on with a 
charge state of 1 or 2 will have a collision energy value calculated from the 
Charge State Recognition table. All other masses use the specified default 
collision energy value.

Using Charge State Recognition with Include by Charge State enabled

This restricts the masses that are switched on to those with the correct charge 
state. A collision energy value will be calculated for those masses with a 
charge state that is configured in both Include by Charge State and Charge 
State Recognition. For masses with a charge state which is only on the Include 
by Charge State list, a default collision energy value will be used.

For example, if the Include by Charge State section is configured to allow 
charge states of 2 and 3, and the Charge State Recognition section is 
configured for Charge States 1 and 2, only masses with a charge state of 2 or 3 
are switched on. Masses switched on with a charge state of 2 will have a 
collision energy value calculated from the Charge State Recognition table. 
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Masses with a charge state of 3 will use the specified default collision energy 
value.

Collision Energy Ramp

This function ramps the collision energy between two user-specified limits 
during each individual scan.

To ramp the collision energy:

Enter an initial voltage and a final voltage.

Scan time

Initial
energy

Final 
energy

Time

Collision
energy

Inter-scan
time
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Cone Voltage page

For both MS and MS/MS mode the cone voltage specified in the tune file can 
be over ridden by checking the box and entering a value.

In addition the cone voltage can be ramped during each scan from an initial 
low value to a final higher value, for both MS and MS/MS

To ramp the cone voltage:

1. Check “Ramp the Cone Voltage during scan”

2. Enter an initial voltage and a final voltage.

Exclude page

The Exclude tab allows predefined masses to be excluded from selection for 
MS/MS analysis. There are two types of peak exclusion:

• Dynamic Peak Exclusion on page 6-26

• Fixed Peak Exclusion on page 6-27
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Dynamic Peak Exclusion

Parameter Description
Enable real time 
exclusion of masses from 
MS/MS

When selected, enables real time exclusion 
option.

Acquire once then always 
exclude for the rest of the 
acquisition

When selected, automatically excludes masses 
from MS/MS scans after their first acquisition.

Acquire and then exclude 
for (seconds)

When selected, allows masses to be excluded for 
a specific amount of time. Using the Exclude 
Mass dialog box, you can specify the amount of 
time for which the mass is excluded.

Exclude peaks with +/- 
...mDa of entries on the 
exclude list

Specifies a mass tolerance value which will be 
applied to all exclude masses.

Retention Time window 
+/- (seconds)

Specifies a tolerance to apply to the retention 
times in the exclude list.
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Fixed Peak Exclusion

Parameter Description
Exclude from range When selected, allows mass ranges to be 

specified so that any masses detected within 
these mass ranges will be excluded. Separate 
individual masses with commas. Use an 
underscore to denote a range of masses, for 
example, 510, 520, 550_600, 700.
Tip: This is only suitable for a small number of 
components. For larger numbers use “Exclude 
from file”

Exclude from file When selected, specifies the exclude mass file 
name or click  to browse for a file. 
Tip: This is particularly useful for large numbers 
of components, particularly for components or 
impurities not permanently present.

New Resets all the options and clears the Exclude 
List.
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To edit the Exclude list

1. On the Survey Scan dialog box Exclude page, click Add to open the 
Exclude Mass dialog box.

Tip: To edit an existing entry in the Exclude List, double-click an entry.

2. Enter the values as required.

The parameters in the Exclude Mass dialog box are described below.

Add Opens the Exclude Mass dialog box, which 
allows the Exclude List to be edited.
See also: To edit the Exclude list on page 6-28.

Delete Deletes the selected entry from the list.

Save Saves the Exclude List details to an existing file. 

Save As Saves the Exclude List details to a new file.

Parameter Description
Add/Modify 

Exclude Mass 
(m/z)

Specifies mass to exclude from the acquisition.

Exclude Time When selected, specifies the exclude time in minutes. If 
a mass is within the Exclude tab Retention Time 
Window value, it will be excluded from the acquisition.

Parameter Description
6-28 Data-Directed Analysis



Adducts page

If enabled, adduct masses are excluded from the MS/MS experiment.

If a mass of interest (target mass) on the Include List is detected, the mass 
spectrometer is switched to MS/MS operation and that mass is added to the 
Exclude List, so that it is ignored if detected again. Also, when the target mass 
is detected, any mass in the Adduct page adduct list is added to that target 
mass, and the resulting mass added to the Exclude List, so that the adduct is 
also ignored if it is detected.

Example: If the molecular target mass is (M), the target mass (m/z) on the 
Include List is (M + H+). When detected, a switch to MS/MS operation is 
triggered and the mass is added to the Exclude List.

A typical adduct is sodium (Na, mass 23), for which the target adduct mass is 
M + Na+. Hence the value to be added to the Adduct page adduct list is (M + 
Na+) - (M + H+) = (223 - 201) = 22. 

Similarly, if the adduct is ammonium (NH4, mass 18), the target adduct mass 
is (M + NH4+). Hence the value to be added to the Adduct page adduct list is 
(M + NH4+) - (M + H+) = (218 - 201) = 17.

When a mass of interest is found, and an Adduct list exists, the function 
switching software generates adduct masses on the Exclude list. This is to 
stop the adducts of a mass being switched on in future MS/MS scans.

To add adduct masses to the Adduct List:

1. Select Use Adduct masses to enable the Adduct List

2. Click Add, or double-click an existing mass in the Adduct list to open the 
Adduct Mass dialog box.

3. Enter the required value in the Add/Modify, Step Size (m/z) text box.

4. Click OK to add the value to the Adduct list on the Adduct tab.
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LockMass page

Using the LockMass page, you can specify the frequency of the reference data 
for accurate mass and the conditions at which to acquire that data. The 
LockMass page Reference Scan parameters are described in LockMass 
page on page 4-24. In addition to the Mass Measurement parameters 
described earlier there is the ability to set dual lock masses

Dual lock masses

For best mass accuracy, singly-charged peaks should be lock-massed using a 
singly-charged reference, and multiply charged peaks should be lock-massed 
using a multiply-charged reference.

For example, when analyzing multiply-charged peptides, set the survey lock 
mass to a doubly-charged peak such as Glu-Fibrinopeptide m/z 785.8, and set 
the MSMS lock mass to a singly-charged peak such as leucine enkephalin m/z 
556.3. This ensures optimum mass accuracy on the singly-charged peptide.

Peak Detection page

Using the Peak Detection tab you can specify additional selection criteria. 

Caution: These parameters should only be used by advanced users. They are 
advanced options and would normally be left at the default settings

Parameter Description
Lock Mass Use this lock mass for survey scans

MSMS Lock Mass Us this lock mass for MS/MS scans
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Parameter Description
Apply no criteria other than 
intensity (as specified on the MS 
Survey tab) for peak selection

The default setting. peak selection is by 
intensity only.

Charge State Peak selection When selected, the Charge State Peak 
detection parameters will be used to find 
peaks of interest. 
See also: 
• Charge State Peak Selection 

Parameters on page 6-32.
• How peak detection works on 

page 6-34

Isotope Pattern selection When selected, Isotope Pattern detection 
algorithms will be used to find peaks of 
interest in the MS scan.
See also: 
• Isotopic Pattern selection on 

page 6-34.
• How peak detection works on 

page 6-34

Deisotope Peak selection When selected, a Deisotope Peak filter 
will be added to the Isotopic Pattern 
algorithm.
See also: 
• Deisotope Peak Selection on page 6-33.
• How peak detection works on 

page 6-34
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Charge State Peak Selection Parameters
The Charge State Peak selection parameters are only available when the 
Charge State Peak selection radio button is selected. These are typically used 
for multiply charged proteolytic peptide mixtures.

Peak Detection Window (Da) The window size to be used to detect 
peaks. Typical values for peptides are 2 to 
3 Da. 
See also: How peak detection works on 
page 6-34

Parameter Description
Select Charge State of 
interest 

Select the required charge states. 

Use advanced options 
for Charge State peak 
selection

When selected, enables the advanced parameters. 
When cleared, the default values are used.

Parameter Description
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Deisotope Peak Selection
The Deisotope Peak selection parameters are only available when either 
“Apply no criteria other than intensity for peak selection” or “Charge State 
Peak” selection is selected.

Number of Components Specifies the maximum number of components 
that are allowed to be identified, from a single MS 
survey spectrum. Typically a value such as 60 is 
used.

Tolerance Window +/- Specifies the tolerance window for charge state 
determination, typical value of 0.2 Da is used.

Peak Extraction 
Window

For peptide work a value of 3 Da is recommended.

Parameter Description
Use advanced options 
for Deisotope peak 
selection

When selected, enables the advanced parameters. 
When cleared, the default values are used.

Tolerance Window +/- Specifies the tolerance window for finding the best 
fit for the isotopes to determine their charge state. 
Usually set at half the extraction window i.e., 
3.5 Da.

Peak Extraction 
Window

For Deisotope Peak Selection a typical value is 
7 Da (half the overall peak cluster size).

Parameter Description
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How peak detection works

To prevent the selection of more than one isotope peak from a single 
chromatogram, a peak detection window is set. The size of this window will 
determine which peak of an isotopic cluster is marked as a potential candidate 
for an MS/MS experiment. Using a small peak detection window i.e., 0.5 Da, 
in the case of a doubly charged species, all the peaks in a cluster can be 
individually selected. If the peak window is increased, only the most abundant 
one within the window will be selected for MS/MS. Typical values for peak 
detection window for peptides are 2 to 3 Da.

When Deisotope Peak Selection is selected, an area of spectra is extracted and 
passed to the Charge State Recognition routine. The Extraction Window needs 
to be wide enough to extract all the peaks within the cluster or a false answer 
could be produced. The minimum and maximum number of charges to be 
considered is set by selecting the appropriate Charge State buttons. For 
proteolytic peptides, 2X, 3X and 4X charged components are normally 
considered. The charge state algorithm firstly calculates theoretical isotope 
distributions for the identified component mass for all charge states that have 
to be considered.

In the case of Deisotope Peak Selection the Peak Extraction Window should 
cover all the peaks in the cluster. If the extraction window is too small the 
Deisotope routine would return an incorrect mass.

Isotopic Pattern selection
The Isotopic Pattern parameters allow you to specify the Isotopic peak 
detection algorithm to be used to detect peaks of interest from the MS Survey.

There are two frames of parameters:

• Isotopic Pattern

• Detection Parameters

In the case of Isotope Pattern selection, the peaks are detected as previously 
described and the Peak Detection Window should be set to 2 Da as before. A 
specific isotope pattern can be specified in the Isotopic Pattern field and thus 
only components fulfilling these criteria will be selected for an MS/MS 
experiment. 

Tip: Isotope Pattern selection is particularly useful in case the targeted 
precursors exhibit a specific distribution, such as chlorinated or brominated 
molecules.
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Isotopic Pattern parameters

Detection Parameters

The parameters are only available when the Isotope Pattern selection radio 
button is selected. The Detection Parameters allow the tolerances, of the 
following parameters, be used to detect the presence of the specified isotope 
pattern and subsequently switch to perform an MS/MS experiment. 

Parameter Description
1st Mass Difference Specifies the first mass difference for isotopic 

selection.

Intensity Ratio Specifies the intensity ratio for the first mass 
difference.

2nd Mass Difference Specifies the second mass difference for isotopic 
selection.

Intensity Ratio Specifies the intensity ratio for the second mass 
difference
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Parameter Description
Intensity above Considers peaks that have an intensity above the 

specified value.

Mass within +/- Considers peaks that have a mass within the 
specified range.

Only consider peaks 
within a ratio of

When selected, enables the Intensity Ratio 
Tolerance parameter.

Intensity Ratio 
Tolerance

Considers peaks within the specified intensity 
ratio tolerance range.
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Variable Flow page

Using the Variable Flow tab, you can define the port which is used to connect 
the instrument to the LC. When configured, a pulse is sent to the selected 
port, enabling switching to start and stop.

Variable Flow page:

Parameter Description
Use Variable Flow When selected, allows you to select a port number.

Port Number Specifies the port number to be used for variable 
flow during acquisition, when a scan switch 
occurs.
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Product Ion page

This page is only present in PID experiments. 

Product Ions Criteria

Parameter Description
High Energy (volts) Specifies the collision energy to be used during the 

low energy survey scan.

Low Energy (volts) Specifies the collision energy to be used during the 
high energy survey scan.

Retention Time Window 
+/- (seconds)

Specifies a tolerance to apply to the retention 
times in the product ion list.

Mass Tolerance 
Window +/- (mDa)

Specifies the mass tolerance to be placed around 
each mass on the product ion list.

Peak Threshold The minimum peak intensity that will be selected 
for MSMS.

Ramp High Collision 
Energy

Ramps the collision energy in the high energy 
survey scan between two specified values.
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Product Ions File List

Parameter Description
All product ion entries 
must be present in a 
single MS Survey can 
for a valid mass 
selection

Specifies that all masses in the Product list must 
appear in a single spectrum for a switch to MS/MS 
to occur.

Masses from File Enter the file name or use  to browse for a file.

New Resets all the options and clears the Product Ion 
list.

Add Opens the Product Ion dialog box, which allows 
the list to be edited.

Delete Deletes the selected entry from the list.

Save Saves the Product Ion details to an existing file. 

Save As Saves the Product Ion details to a new file.
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Neutral Loss page

This page is only present in PID neutral experiments.

Neutral Loss page:

There are ten tabs in the Neutral Loss dialog box, which allow you to access 
all the parameters for the analysis experiment. The Neutral Loss dialog box 
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comprises the same tabs as the Product Ions dialog box, with the exception of 
the Neutral Loss page.

Using the Neutral Loss tab, you can configure a list of neutral loss masses to 
search for during the parent switch experiment. The Neutral Loss page 
parameters are described in the following tables.

Neutral Loss Criteria

Neutral Loss File List

Parameter Description
Use Neutral Loss peak 
selection

When selected, allows product ions to be used 
during the acquisition.
Tip: When not selected all the parameters 
described below are greyed out.

High Energy (volts) Specifies the collision energy to be used during the 
low energy survey scan.

Low Energy (volts) Specifies the collision energy to be used during the 
high energy survey scan.

Mass Tolerance 
Window +/- (mDa)

Specifies a tolerance to apply to the retention 
times in the product ion list.

Peak Threshold 
(counts/seconds)

The minimum peak intensity that will be selected 
for MSMS.

Ramp High Collision 
Energy

Ramps the collision energy in the high energy 
survey scan between two specified values.

Parameter Description
All Neutral Loss entries 
must be present in a 
single MS Survey scan 
for a valid mass 
selection

Specifies that all masses in the Neutral Loss list 
must appear in a single spectra for a switch to 
MS/MS to occur.

Masses from File Specifies the include mass file name to be used 
during the acquisition.

New Resets all the options and clears the Neutral Loss 
List.
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To edit the Neutral Loss list

1. On the Neutral Loss dialog box, Neutral Loss tab, click Add, to open the 
Neutral Loss dialog box.

Tip: To edit an existing entry in the Exclude List, double-click an entry.

2. Enter the values as required.

The table below describes the parameters in the Neutral Loss dialog box.

Add Opens the Neutral Loss dialog box, which allows 
the Exclude List to be edited.
See also: To edit the Neutral Loss list on 
page 6-42).

Delete Deletes the selected entry from the list.

Save Saves the Neutral Loss details to an existing file. 

Save As Saves the Neutral Loss details to a new file.

Parameter Description
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7 APCI, APPI and ESCi

The Q-TOF Premier Modular LockSpray source can be configured to 
operate in three different ionization modes: ESI, APCI and APPI. In 
addition it is capable of two combined ionization modes: ESI / APCI 
(ESCi) and APCI / APPI (Dual APPI).

ESI operation is described earlier; this chapter covers the other options.

Contents

Topic Page
About IonSABRE APCI mode 7-2

About APPI mode 7-3

About dual APPI 7-4

About ESCi LockSpray 7-5

APPI and dual APPI operation 7-17
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Creating MS method files for dual mode ionization 7-30
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About IonSABRE APCI mode

Atmospheric Pressure Chemical Ionization (APCI) produces singly-charged 
protonated or deprotonated molecules from a broad range of non-volatile 
analytes.

The Q-TOF Premier modular LockSpray source is configured for IonSabre 
LockSpray APCI by the addition of an IonSabre probe, a special corona pin 
and an APCI baffle. Mobile phase from the LC column enters the probe, where 
it is pneumatically converted into an aerosol, rapidly heated, and converted to 
a vapor/gas at the probe tip.

APCI mode:

Hot gas from the probe passes between the sample cone and the corona 
discharge pin, which is typically operated with a discharge current of 5 µA. 
Mobile phase molecules rapidly react with ions generated by the corona 
discharge to produce stable reagent ions. Analyte molecules introduced into 
the mobile phase react with the reagent ions at atmospheric pressure and 
typically become protonated (in the positive ion mode) or deprotonated (in the 
negative ion mode). The sample and reagent ions pass through the sample 
cone and into the ion block before entering the analyzer.

IonSABRE probe

Sample cone

 Special corona pin

Reference sprayer

APCI baffle
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About APPI mode

Atmospheric Pressure Photoionization (APPI) uses photons generated by a 
krypton discharge lamp (~10.2 eV) to produce sample ions from vaporized LC 
eluent. Direct photoionization of the sample molecule occurs when the photon 
energy exceeds the ionization potential of the sample molecule.

The Q-TOF Premier modular LockSpray source is configured for APPI by the 
addition of an IonSabre probe and a UV lamp. The sample is introduced into 
the source via the IonSabre probe producing a stream of sample and solvent 
species that undergo photon-induced, ion-molecule reactions.

Inside the source, a repeller electrode deflects and focuses the resulting 
sample ions toward the sample cone for introduction into the mass 
spectrometer.

APPI mode:

IonSABRE probe

Sample molecules

APPI lamp 

Repeller electrodeUV lamp

Sample ions

Sample cone

Photons from 
the UV lamp
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About dual APPI

The Q-TOF Premier modular LockSpray source is configured for Dual APPI 
by the addition of an IonSabre probe, a special corona pin and a UV lamp.

Dual APPI/APCI mode enables rapid switching between ionization modes and 
facilitates high throughput (for example, for sample screening). 

APPI dual mode (repeller electrode grounded):

APPI dual mode (repeller electrode on):

Sample cone

IonSABRE probe

Photons from the UV lamp

Repeller electrode grounded

Dual APCI/APPI corona pin with 
voltage applied

Sample cone

IonSABRE probe

Photons from the UV lamp

Repeller electrode with
voltage applied

Dual APCI/APPI corona pin 
grounded
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About ESCi LockSpray

The Q-Tof Premier modular LockSpray source is configured for ESCi 
LockSpray by the addition of a special corona pin. ESCi mode allows the 
simultaneous acquisition of ESI and APCI data, facilitating high throughput. 
A standard ESI probe is used.

The ESCi configuration enables ESI and APCI, as illustrated in the following 
diagrams:

ESI mode:

APCI mode:

ESI probe (-3 kV)

Sample cone

 Special corona pin (grounded)

Reference sprayer

APCI baffle

ESI probe (grounded)

Sample cone

 Special corona pin (-3 kV)

Reference sprayer

APCI baffle
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IonSABRE APCI operation

Installing IonSABRE LockSpray
This procedure assumes, as a starting position, that the instrument is in ESI 
LockSpray mode.

To install IonSABRE LockSpray:

1. Click  to put the instrument into standby. Ensure that the adjacent 
instrument status indicator turns red.

2. Click  to turn off the nitrogen gas flow.

3. Disconnect the LC system from the ESI probe

4. Disconnect and remove the ESI probe

5. Install the IonSabre probe, and plug into the heater/interlock socket on 
the front connection panel

Note: The cable from the probe adjuster is not used while the IonSabre 
probe is in use.

6. Open the source door and, from the Tune window Source page, set the 
LockSpray baffle to the analyte position.

7. Disconnect and remove the LockSpray motor assembly

8. Remove the corona pin socket blanking plug and fit the special corona 
pin.

Warning: To avoid burns, take great care while working with the 
instrument’s source cover removed as the probe and source may 
still be hot.
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Corona pin socket:

9. Replace the standard baffle with the APCI baffle (see APCI baffle 
installation on page 7-8).

10. Refit the LockSpray motor assembly and close the source door.

11. In the Tune window click Source > IonSabre to open the IonSabre Source 
page.

See also: 
• Modular LockSpray source on page 1-10

Corona pin socket

IonSABRE probe

Referene sprayer

Baffle
Special corona pin
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APCI baffle installation

The LockSpray baffle is attached to the rotor shaft by a single screw. 
Changing between standard and APCI baffles is therefore straightforward, 
but pay careful attention to the orientation of the baffle.

Tips: 
• Always set the baffle to the analyte position (from the software) before 

disconnecting the motor assembly cable. 

• When you attach the new baffle to the square-ended rotor shaft, ensure 
the baffle is facing towards the reference sprayer before you place it over 
the end of the shaft. Avoid rotating the rotor shaft.

• After you have fitted the baffle and tightened its holding screw, you 
should plug the motor into the front panel motor socket. Do this before 
you install the motor assembly back onto the source enclosure. Set the 
baffle to the reference position, then set back to the analyte position. The 
baffle may reset itself, doing a full rotation at this point. Now you can 
install the motor assembly onto the source enclosure.

• If the baffle resets itself (does a full rotation) while installed in the 
source, it will push the corona pin to one side. This may happen if the 
embedded PC or instrument electronics are reset. If this occurs, the 
motor assembly will have to be removed, to allow access to adjust the 
corona pin position back to normal.
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LockSpray motor assembly:

Standard baffle

APCI baffle
Holding screw

Reference sprayer

Rotor
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The orientations of the two baffles are illustrated in the following diagram:

Baffle positions:

Standard baffle - Analyte position Standard baffle - Reference position

APCI baffle - Analyte position APCI baffle - Reference position
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Obtaining an ion beam and source optimization for APCI

In this example, a sample 17 α hydroxyprogesterone (concentration 10 ng/µL, 
in 70:30 acetonitrile:water) will be teed into an LC flow of 500 µL/min (70:30 
acetonitrile:water) in APCI positive V mode. You will need to carry out the 
following procedures:

To obtain an ion beam and optimize the source (APCI):

Important: If the Q-Tof Premier has been in Standby for more than 2 hours it 
should be left in Operate for 1 hour to allow the instrument to stabilize.

Tip: Use real-time chromatogram to monitor the acquisition (see To follow an 
acquisition in Chromatogram: on page 2-25).

1. Make connections between the HPLC pump, syringe pump, and 
IonSABRE probe.

Pump and column connections to the IonSABRE probe:

Warning: To avoid possible high-pressure liquid jet spray, wear safety 
goggles when making the connections between the HPLC pump, LC 
column, syringe pump, and APCI probe.

Warning: To avoid the possibility of electric shock, ensure that the 
instrument is in standby mode before making the connections between 
the HPLC pump, LC column, syringe pump, and APCI probe.

LC pump

LC Column

IonSABRE probe

Syringe pump

Zero dead-volume T-piece
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2. Click Source > IonSabre.

3. Click  and  for positive ion in V mode.

4. From the IonSabre Source page, set the corona current to 5 µA, Source 
Temperature to 100 °C and Desolvation gas flow to 100 L/h

IonSabre+ Source page tune parameters:

Tip: For most compounds, Current Mode should be selected so as to 
maintain a constant current. For some compounds, Voltage Mode may 
provide better results.

5. Click  and check that the adjacent instrument status indicator turns 
green.

6. Click  to turn on the nitrogen gas flow.

7. Set the Ion Sabre probe temperature to 500°C and check that the 
readback reaches and stabilizes at this temperature.
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8. Set the LC system to run at 500 µL/min and turn it on. Check that its 
pressure is stable. Allow 15 minutes for the LC column to equilibrate or 
until background levels are constant.

9. Infuse 17 α hydroxyprogesterone (concentration 10 ng/µL, in 70:30 
acetonitrile:water) at 20 µL/min and observe the 
17 α hydroxyprogesterone peak at m/z 331.2 (M+H+) displayed on the 
Tune window.

Tip: For negative ion, sulfadimethoxine could be used.

10. Starting with the probe tip midway between the cone and the end of the 
corona pin, use the probe adjuster to maximize the displayed peak 
intensity. 

11. Use the probe adjuster to move the probe tip as far away from the cone 
as possible, without losing more than 20% of the maximum displayed 
peak intensity obtained in step 10. This will minimize source 
contamination.

12. Use the nebulization adjuster on the probe to give the best displayed 
peak intensity and stability.

13. On the Tune window IonSabre+ Source tab, optimize the Corona (µA) 
current to the value giving the maximum displayed peak intensity. See 
To maximize the Corona current: on page 7-14.

14. Starting from a value of 0, increase the Cone (L/hr) gas flow in 
increments of 50. Allow the pressure to stabilize after each adjustment. 
Set the gas flow to the highest value that does not significantly reduce 
the peak intensity. This minimizes solvent ion cluster formation.

15. Starting from a value of 15, increase the Sample Cone voltage in 
increments of 5. Set the cone voltage to the value giving the highest 
displayed peak intensity. Record this value.

16. Reduce the Ion Sabre Probe Temp (°C) to 300, and then increase its 
value in increments of 50. Allow the temperature readback to stabilize 
after each adjustment. Set the temperature to the highest value that 
does not decrease the displayed peak intensity.

If the probe temperature is too low, the mobile phase may not be 
efficiently desolvated. This can result in chromatographic peak tailing.

17. With the Sample Cone, Corona Cone Gas, and IonSabre probe 
temperature now at their optimum values, the displayed peak should be 
similar to that shown in the following figure.
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Peak display for IonSABRE APCI:

To maximize the Corona current:

1. Starting with a value of 5, decrease the value to 1, in decrements of 1.

2. Decrease the value to 0, in decrements of 0.1.

3. Reset the value to 5, and then increase the value in increments of 5.

4. Set the Corona (µA) current to the value giving the maximum displayed 
peak intensity.

Tip: Typical values will be 5 µA for positive ion and 15 µA for negative ion
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IonSABRE LockSpray reference setup

For IonSABRE LockSpray, a reference solution suitable for electrospray 
ionization is required. Leucine enkephalin is often the preferred choice

To tune the reference solution:

1. On the Tune window IonSabre page select Reference.

Result: The baffle rotates into the reference position. Capillary voltage 
is available in the Lock Spray frame.

IonSabre+ Source page with Reference selected:

2. Click  and change the data format to Centroid.

3. Infuse 2 ng/µL leucine enkephalin at 5 µL/min.

4. Tune on the 556 peak using the Lock Spray Capillary voltage and the 
Sample Cone voltage to give 0.5 ions per push (IPP). This gives a balance 
between ion statistics and detector saturation.
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Tip: Write down the value of the Cone Voltage so that you can enter it in 
the MS Method editor when required.

Centroid peak display for leucine enkephalin:
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APPI and dual APPI operation

For APPI and dual APPI/APCI, both the APPI lamp drive assembly and 
IonSabre probe are required.

APPI lamp assembly

APPI lamp assembly and side plate:

Switching the UV lamp on provides a constant photon output. The intensity of 
incident radiation up the sample molecules is varied by manually adjusting 
the distance between the lamp and probe tip, using the handle on the APPI 
lamp drive assembly to move the whole assembly on its mounting shaft. The 
mounting shaft’s four numbered indexing indents aid in setting this distance.

Indexing Indent 
Identification Numbers

HV Electrical Connection

APPI Electrical Connection

APPI Lamp Drive Assembly

Handle

Thumbscrew

Source Enclosure
Door Securing Clip

Securing Screw

Mounting Shaft

Source Enclosure
Side Plate
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APPI lamp drive assembly fitted to the source enclosure:

To install APPI / dual APPI:

This procedure assumes, as a starting position, that the instrument is in ESI 
LockSpray mode.

1. Click  to put the instrument into standby. Ensure that the adjacent 
instrument status indicator turns red.

2. Click  to turn off the nitrogen gas flow.

3. Disconnect the LC system from the ESI probe

4. Disconnect and remove the ESI probe

5. Install the IonSabre probe, and plug into the heater/interlock socket on 
the front connection panel

Note: The cable from the probe adjuster is not used while the IonSabre 
probe is in use.

6. Open the source door.

7. Disconnect and remove the LockSpray motor assembly.

8. Remove the corona pin socket blanking plug and fit the special corona 
pin (Dual APPI only)

Warning: To avoid burns, take great care while working with the 
instrument’s source cover removed as the probe and source may 
still be hot.

UV Lamp and
Repeller Electrode

IonSABRE Probe

Sample Cone
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9. Fully retract the lamp’s mounting shaft in the APPI lamp drive 
assembly.

10. Fit the UV lamp assembly onto the source enclosure and secure using 
the four thumbscrews (see Figure titled “APPI lamp drive assembly 
fitted to the source enclosure:” on page 7-18).

11. Connect the UV lamp assembly to the front panel APPI and capillary 
sockets

12. Close the source door.

13. In the Tune window click Source > APPI, or Dual APPI.

Lamp status

The APPI lamp can be switched on and off from the APPI and the Dual APPI 
source pages. There are four states:

The lamp button is not visible in standby:

Retracted lampUnretracted lamp
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The lamp button shows ‘On’ with read-back ‘Lamp Failure’ if the lamp is 
requested while the lamp is disconnected:

Lamp button shows ‘On’ with read-back ‘Lamp On’ when lamp switched on:

Lamp button shows off with read-back ‘lamp off’ when lamp is switched off.

Obtaining an ion beam and source optimization (APPI)

Warning: To avoid possible high-pressure liquid jet spray, wear safety 
goggles when making the connections between the HPLC pump, LC 
column, syringe pump, and IonSABRE probe.
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In this example a sample of cholesterol (concentration 10 ng/µL, in 100% 
methanol) will be teed into an LC flow of 500 µL/min in APPI positive V mode.

To obtain an ion beam and optimize the source for APPI:

1. Make connections between LC system, syringe pump and IonSabre 
probe

2. Fill syringe with 10 ng/µL cholesterol in 100% methanol and set-up an 
LC pump with 100% methanol

3. Click Source > APPI.

4. Click  and  for positive ion in V mode.

5. Manually advance the lamp to notch 3 on the mounting shaft. This 
position gives the best compromise when first obtaining an ion beam. 

APPI lamp position:

6. From the IonSabre Source page set source temperature to 100 °C, probe 
temperature to 600 °C and desolvation gas flow to 100 L/h.

7. Click  to switch the instrument into Operate. Check that the 
adjacent instrument status indicator turns green.

8. Click  to turn on the nitrogen gas flow.

Warning: To avoid the possibility of electric shock, ensure that the 
instrument is in standby mode before making the connections between 
the HPLC pump, LC column, syringe pump, and IonSABRE probe.

IonSABRE Probe

Sample Cone Tip

Repeller 
Electrode

Lamp Window
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9. On the Tune window APPI+ Source page, click , and confirm the 
Lamp is on.

10. Start the LC flow (500 µL/min) and the syringe pump (20µL/min)

11. Observe the cholesterol peak at m/z 369.0 (M(-H2O)+H+) on the peak 
display and optimize the lamp position, probe position, probe 
temperature, repeller voltage and sampling cone voltage, to give the 
maximum peak intensity

Caution: Do not to touch the probe with the repeller electrode:

• A short circuit to the electrode would prevent proper ion detection.

• The probe is hot and may damage the lamp assembly.
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Peak display with Cholesterol Peaks

Dual APPI operation
In this example a sample of cholesterol (concentration 10 ng/µL, in 100% 
methanol) will be teed into an LC flow of 500 µL/min in APPI positive V mode. 

To obtain an ion beam and optimize the source for dual APPI:

1. Make connections between HPLC pump, syringe pump and IonSabre 
probe

2. Fill syringe with 10 ng/µL cholesterol in 100% methanol and setup an 
LC pump with 100% methanol
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3. Click Source > APPI. 

4. Click  and  for positive ion in V mode.

5. Manually advance the lamp to notch 3 on the mounting shaft. This 
position gives the best compromise when first obtaining an ion beam. 

Combined APPI/APCI Corona Discharge Pin Alignment:

6. From the IonSabre Source page set source temperature to 100 °C, probe 
temperature to 600 °C and desolvation gas flow to 100 L/h.

7. Click  to switch the instrument into Operate. Check that the 
adjacent instrument status indicator turns green.

8. Click  to turn on the nitrogen gas flow.

9. On the Tune window APPI+ Source page, click , and confirm the 
Lamp is on.

10. Start the LC flow (500 µL/min) and the syringe pump (20µL/min)

11. Observe the cholesterol peak at m/z 369.0 (M(-H2O)+H+) on the peak 
display and optimize the lamp position, probe position, probe 
temperature, repeller voltage and sampling cone voltage, to give the 
maximum peak intensity.

Note: The APPI spectrum is displayed in the left pane and is colored 
orange. The APCI spectrum is displayed in the right pane and is colored 
blue.

APCI probe

Sample Cone tip

 Corona Discharge pin
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The repeller voltage will only affect the APPI spectrum. The corona 
current will only affect the APCI spectrum.

Dual mode APCI/APPI Peal display:

APPI APCI
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ESCi operation

The Q-Tof Premier, with the ESI probe installed and corona discharge pin 
fitted, can alternate between acquiring data in ESI and APCI modes. The 
software switches the voltage to the ESI capillary and the current to the APCI 
corona discharge pin continuously. 

To install LockSpray for ESCi:

This procedure assumes, as a starting position, that the instrument is in ESI 
LockSpray mode.

1. Click  to put the instrument into standby. Ensure that the adjacent 
instrument status indicator turns red.

2. Click  to turn off the nitrogen gas flow.

3. Open the source door.

4. From the Tune window Source page, set the LockSpray baffle to the 
analyte position.

5. Disconnect and remove the LockSpray motor assembly.

6. Remove the corona pin socket blanking plug and fit the special corona 
pin.

Warning: To avoid burns, take great care while working with the 
instrument’s source cover removed as the probe and source may 
still be hot.
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7. Replace the standard baffle with the APCI baffle (see APCI baffle 
installation on page 7-8).

8. Refit the LockSpray motor assembly.

9. Close the source door.

10. On the Tune window click Source > ESCi.

To obtain an ion beam and optimize the source tune for ESCi:

1. Make connections between HPLC pump, syringe pump and IonSabre 
probe

2. Fill syringe with 10 ng/µL cholesterol in 100% methanol and set-up an 
LC pump with 100% methanol

Warning: To avoid possible high-pressure liquid jet spray, wear safety 
goggles when making the connections between the HPLC pump, LC 
column, syringe pump, and ESI probe.

Warning: To avoid electric shock, ensure that the instrument is in 
standby mode before making the connections between the HPLC pump, 
LC column, syringe pump, and ESI probe.

ESI probe

Reference assembly

Special Corona pin

Baffle
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3. Click Source > ESCi. 

4. Click  and  for positive ion in V mode.

5. Click  to switch the instrument into Operate. Check that the 
adjacent instrument status indicator turns green.

6. Click  to turn on the nitrogen gas flow.

7. Start the LC flow (300 µL/min) and the syringe pump (20 µL/min)

8. Observe the cholesterol peak at m/z 369.0 (M(-H2O)+H+) on the peak 
displays

Note: The ESI spectrum is displayed in the left pane and is colored red. 
The APCI spectrum is displayed in the right pane and is colored blue.

9. From the IonSabre Source page optimize the ESI probe position, corona 
current and sampling cone voltage, to give the maximum peak intensity.
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Observe the two peaks in the Tune window. The following figure 
illustrates how the peak display should appear when tuned correctly.

ESCi Peak display:
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Creating MS method files for dual mode ionization

Dual APPI and ESCi data can only be acquired from the sample list. Create 
an MS method file consisting of two parallel functions, differing only in source 
type. Mixed polarity (+/-), analyzer mode (V/W) or data type 
(centroid/continuum) functions are not permitted.

For Dual APPI, select source types API and APPI.

For ESCi, select source types ES and API.

To create dual mode ionization method files:

1. From the MassLynx window, click the MS Method icon to open the MS 
Method Editor.

2. Click  to delete the current entry.

3. Click MS Scan to open the MS Scan Function Editor.

4. On the Acquisition page set the required Source mode (ES, API or 
APPI).

5. Click OK. 

Result: The MS Function Editor closes, and the parameters are now 
included as the APPI/ES/API entry in the MS Method Editor.

6. Add a second MS function this time selecting a different Source mode. 

7. Save the method using a suitable name.

Important: 
• The parameter values entered in the Acquisition Time frame must 

be identical for both functions.

• LockSpray parameters are common to each function. LockSpray 
data will always be acquired in ESI mode regardless of the function 
source type.
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ESCi method:

Dual APPI method:
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Maintenance schedule

The table below lists periodic maintenance schedules that, when followed, 
ensure optimum instrument performance.

The maintenance frequencies shown apply to instruments that normally 
receive moderate use.

Maintenance schedule:

Procedure Frequency
Replace the scroll pump seals Annually (see the Edwards 

document XDS 35i Instruction 
Manual A730-01-880)

Clean the source assembly (see 
Cleaning the source ion guide on 
page 8-20).

When sensitivity decreases to 
unacceptable levels.

Clean the ESI probe tip (see Cleaning 
or replacing the ESI probe tip on 
page 8-26).

When sensitivity decreases to 
unacceptable levels.

Clean the ion block assembly (see 
Cleaning the Source components on 
page 8-5).

When it is visibly fouled.
When background or high peak 
contaminants are unacceptably 
high.

Clean all source components (see 
Cleaning the Source components on 
page 8-5).

When sensitivity decreases to 
unacceptable levels.
When cleaning the cone gas cone, 
sample cone fails to improve 
analytical results.

Replace the ESI probe capillary (see 
Replacing the ESI probe capillary on 
page 8-31).

When sensitivity decreases to 
unacceptable levels.

Perform LockSpray Maintenance (see 
Performing LockSpray 
maintenance on page 8-52)

Perform NanoLockSpray 
Maintenance (see Performing 
NanoLockSpray maintenance on 
page 8-58)
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Safety and handling

Bear in mind the following safety considerations when performing 
maintenance procedures.

Cleanliness and care are very important whenever you remove internal 
assemblies from the instrument.

• Always prepare a clear clean area in which to work.

• Make sure that any tools or spare parts that may be required are close 
at hand.

• Obtain some small containers in which screws, washers, spacers etc. can 
be stored.

• Use tweezers and pliers whenever possible.

• If nylon or cotton gloves are used, take care not to leave fibers in 
sensitive areas.

• Avoid touching sensitive parts with fingers.

Warning: To avoid injury, ensure the jack feet are in the lock position.

Warning: To avoid possible electric shock, do not remove the instrument 
panels. There are no user-serviceable items inside.

Warning: To avoid possible electric shock, ensure that the instrument is 
in standby mode before commencing any maintenance.

Warning: To prevent injury, always observe good laboratory practices 
when handling solvents, changing tubing, or operating the Q-Tof 
Premier. Know the physical and chemical properties of the solvents 
used. See the Material Safety Data Sheets for the solvents in use.

Warning: To avoid burns, take great care while working with the probe 
and source as they are liable to be hot.

Warning: The instrument components are liable to be 
contaminated with biologically hazardous and toxic materials. 
Wear rubber gloves at all times while handling the components.
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• Before reassembling and replacing dismantled components, inspect 
O-rings and other vacuum seals for damage. Replace with new ones if in 
doubt.

Should a fault occur soon after a particular part of the system has been 
repaired or otherwise disturbed, it is advisable first to ensure that this part 
has been correctly refitted and / or adjusted, and that adjacent components 
have not been inadvertently disturbed.
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Cleaning the Source components

Overview
Clean the source components (sample cone and cone gas nozzle when:

• They are visibly fouled.

• LC and sample-related causes for decreased signal intensity have been 
ruled out.

If cleaning these parts fails to increase signal sensitivity, also clean the 
extraction cone, source ion guide, and ion block.

To clean the source components:

1. Disassemble the source components and source ion guide assembly (see 
To remove the probe from the source on page 8-6 to To disassemble the 
ion block: on page 8-13).

2. Clean the source components and source ion guide assembly (see 
Cleaning the sample cone and cone gas nozzle on page 8-19 to Cleaning 
the isolation valve stem on page 8-21).

3. Reassemble the source ion guide assembly and the source components 
(see Reassembling the source ion block on page 8-22 to Fitting the 
sample cone on page 8-24).

Required materials

• Rubber gloves

• Needle-nose pliers

• Set of Allen keys (hex wrench) including 2.5-mm and 6-mm

• Jeweller’s screwdriver

• Large, flat-blade screwdriver

• Glass-fiber pen

• Appropriately sized glass vessels, in which to completely immerse 
components when cleaning. Use only glassware not previously cleaned 
with surfactants.

• HPLC-grade methanol
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• HPLC-grade water

• Formic acid

• Ultrasonic bath

• Source of oil-free, inert gas (nitrogen or helium) for drying (air-drying 
optional).

• Lint-free paper towels

To remove the probe from the source

1. Disconnect the LC system from the probe.

2. On the MassLynx window, click  and ensure that the adjacent 
instrument status indicator turns red.

3. Wait for 3 minutes to allow the desolvation gas flow to cool the probe 
and source.

4. Click  to turn off the nitrogen gas flow.

5. Disconnect the electrical connection(s) on the instrument front panel.

6. Disconnect the PTFE tubing at the Nebulizer gas connection on the front 
panel.

7. Undo the two thumbscrews securing the probe to the probe adjuster.

Caution: To avoid damaging the probe seals when removing an APCI 
probe, ensure that the probe temperature is less than 150 °C [as 
displayed on the Tune windows’s APcI Probe Temp (°C) readback] before 
removing the probe.

8. Carefully remove the probe from the probe adjuster.

Warning:  To avoid burns take care when handling the probe and 
source as they are liable to be hot.

Warning: To avoid contamination from previously sprayed 
sample, wear gloves at all times when handling the probe. 
This also prevents finger-grease contaminating the 
capillary.
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To remove the sample cone

1. Switch the instrument to Standby

2. Set the Source temperature to 20 °C.

3. Wait for the Source temperature to fall below 50 °C.

4. Switch off the API gas flow.

5. Unfasten the source enclosure door’s securing clips and open the door.

6. Remove the baffle and motor assembly by taking off the right-hand 
flange of the Source enclosure.

If using an Ion Sabre APCI probe, carefully remove the corona discharge 
pin.

7. Close the isolation valve by moving its lever fully to the right.

Caution: Failure to close the isolation valve before removing the sample 
cone is liable to damage the instrument.

Warning: The source components are liable to be contaminated 
with toxic and biohazardous materials. Wear rubber gloves at all 
times while handling the components.

Warning: To avoid possible electric shock, ensure that the instrument 
is in standby mode before commencing this procedure.

Warning: The source is liable to be hot. To avoid burns, take great care 
while working with this item.

Isolation valve

Sample cone / 
cone gas nozzle assembly

Cone retaining plate screws
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8. Pull out the PTFE tube attached to the cone gas nozzle.

Tip: Use a flat-blade screwdriver to push the collar back while removing 
the tube.

9. Use an Allen key to remove the two cone retaining plate screws.

10. Remove the cone retaining plate.

11. Carefully remove the sample cone/cone gas nozzle assembly from the 
Source ion block.

12. Use a jeweller’s screwdriver to carefully remove the O-ring from the 
sample cone/cone gas cone assembly.

Caution: The sample cone is very fragile. To avoid damage, never place 
the sample cone on its tip; always place it on its flanged base.

13. Separate the sample cone and cone gas nozzle.

The Figure titled “Sample cone/cone gas nozzle assembly components” 
on page 8-9 shows the sample cone, cone gas cone, and O-ring.
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Sample cone/cone gas nozzle assembly components

14. Clean the sample cone and cone gas nozzle as described in “Cleaning the 
Sample Cone and Cone Gas Cone” on page 1-24.

Ion source enclosure and ion block removal

To remove the ion source and ion block:

1. Vent the instrument as described in Appendix A.

2. Disconnect the Desolvation Heater electrical connection on the 
instrument front panel.

3. Disconnect the PTFE tubing at the Desolvation gas connection on the 
front panel.

Warning: To avoid possible electric shock, ensure that the instrument 
is shut down and is isolated from the mains power supply.

Warning: The source is hot, so allow it to cool down for at least 
30 minutes before proceeding.

f

Warning: To avoid contamination with toxic and 
biohazardous materials, wear rubber gloves at all times 
while handling the components.

O-ring

Cone gas nozzle

Sample cone
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4. Use an Allen key to loosen the three captive source enclosure securing 
screws and remove the source enclosure from the instrument.

5. Use an Allen key to remove the two ion block securing screws.

6. Remove the ion block from the PEEK ion block support.

Source ion guide removal

To remove the source assembly from the instrument:

1. Use a hex Allen key to remove the three PEEK ion block support 
securing screws.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components.

Securing screws

PEEK ion block support

Ion block
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2. Remove the PEEK ion block support from the pumping block.

Tip: Ensure that the three O-rings remain in position on the rear face of 
the support. 

Caution: Take care not to scratch the internal bore of the pumping 
block, as the ion tunnel assembly is withdrawn.

3. Carefully remove the source T-Wave assembly from the pumping block.

PEEK

Securing screws

Pumping block

Source ion guide
assembly

ion block support

Source ion guide 
assembly
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Disassembling the source T-Wave assembly

To disassemble the source T-Wave assembly:

1. Use the jeweller’s screwdriver to remove the three screws securing the 
locating ring to the source T-Wave assembly.

2. Remove the metallized O-ring and locating ring from the assembly.

Warning: The source ion guide components may be contaminated 
with biohazardous and/or toxic materials. Always wear nitrile 
gloves while performing this procedure.

Source Ion guide assembly

Aperture plate

Securing screw

Locating ring

Metallized O-ring
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3. Remove the three screws securing the aperture plate to the assembly.

4. Remove the aperture plate from the assembly. The source ion guide 
assembly components are shown in the figure below.

Result: No further disassembly of the source ion guide assembly is 
required.

Source ion guide assembly components

5. Clean the source ion guide assembly and differential aperture plate.

See also: Cleaning the source ion guide on page 8-20

Disassembling the source ion block

To disassemble the ion block:

1. Remove the two lock nuts from the bottom of the isolation valve body.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components.

Aperture plate
Retaining ring

Metallized O-ring
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2. Remove the washer and retaining ring from the isolation valve stem.

3. Remove the isolation valve stem from the isolation valve body (push the 
stem while repeatedly opening and closing the isolation valve).

Lock nuts

Isolation valve assembly

Washer Retaining ring

Isolation valve stem
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The isolation valve stem components are shown below:

4. Clean the isolation valve stem as described in (see Cleaning the isolation 
valve stem on page 8-21).

5. Use an Allen key to remove the four ion block cover plate securing 
screws.

6. Remove the ion block cover plate.

7. Use an Allen key to remove the two screws securing the heater cartridge 
wires to the PEEK terminal block.

Ion Block Cover Plate
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8. Use the needle-nose pliers to carefully swing the ring terminal tags out 
of the terminal block.

9. Use the needle-nose pliers to gently slide the heater cartridge assembly 
out of the ion block.

PEEK Terminal Block

Cartridge Heater Wire Securing Screws

Ring Terminal Tag
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10. Use a jeweller’s screwdriver to carefully remove the D-shaped seal from 
the ion block.

11. Use an Allen key to remove the PEEK terminal block securing screw.

Heater Cartridge Assembly

D-Shaped Seal
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12. Use the needle-nose pliers to remove the PEEK terminal block from the 
ion block.

13. Use a wrench to remove the blanking plug.

14. Clean the ion block as described in (see Cleaning the ion block on 
page 8-21).

15. Reassemble the ion block as described in (see Reassembling the source 
ion block on page 8-22).

PEEK Terminal Block Securing Screw
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Cleaning the sample cone and cone gas nozzle

Caution: The sample cone is very fragile; to avoid damage, never place the 
sample cone on its tip, always place it on its flanged base.

To clean the sample cone and cone gas cone:

1. Use a glass-fiber pen to remove gross contamination from the cone gas 
cone surface by gentle abrasion.

2. If the sample cone contains debris, place a drop of formic acid on its 
orifice.

3. Immerse the sample cone and cone gas nozzle in separate glass vessels 
containing methanol:water (1:1). 

Tip: If the parts are obviously contaminated, use a mixture of 45% 
methanol, 45% water, and 10% formic acid.

4. Place the vessels in the ultrasonic bath for 30 minutes.

If formic acid was used in the cleaning solution:

– Rinse the parts by immersing them in separate glass vessels 
containing water and placing the vessels in the ultrasonic bath 
for 20 minutes, to remove the formic acid.

– Displace the water by immersing the parts in separate glass 
vessels containing methanol and placing the vessels in the 
ultrasonic bath for 10 minutes.

5. Carefully remove the parts from the vessels and blow-dry them using 
inert, oil-free gas.

Warning:  To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components.

Warning: Use extreme care when working with formic acid. Use 
a fume hood and appropriate protective equipment.

Warning: Handle the container carefully. The exothermic 
reaction caused by the addition of formic acid to water may have 
caused the container to heat up.
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Alternatively, the parts may be placed on lint-free towels and allowed to 
air dry. Wipe off any water spots with a lint-free cloth.

Cleaning the source ion guide

To clean the aperture plate:

Use a glass-fiber pen to gently remove ion burn marks; pay particular 
attention to the inner surfaces of the aperture plate.

Caution: Use only methanol or water as solvents when cleaning the source 
assembly. Use of acetone, chlorinated solvents, or acid will damage the 
assembly.
Caution: Take great care not to damage the assembly’s plates when using a 
wire brush for cleaning.

To clean the source ion guide:

1. Flush-out the assembly, using methanol from a wash-bottle.

2. Immerse the assembly in a glass vessel containing methanol:water (1:1).

3. Place the vessel in the ultrasonic bath for 30 minutes.

Caution: Do not dry the source assembly by any method other than 
blow-drying, otherwise reintroduced contamination may lead to 
difficulty in pumping down the instrument.

4. Carefully remove the assembly from the vessel and blow-dry it using 
inert, oil-free gas.

5. Visually inspect the assembly to ensure that no fibers from the wire 
brush are lodged in the assembly. If fibers are present, repeat the 
procedure from step 1 onwards.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components. 
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Cleaning the ion block

To clean the ion block:

1. Immerse the ion block in a glass vessel containing methanol:water (1:1).

Tip: If the components are obviously contaminated, use a mixture of 45% 
methanol, 45% water, and 10% formic acid.

2. Place the vessels in the ultrasonic bath for 30 minutes.

3. If formic acid was used in the cleaning solution:

– Rinse the ion block by immersing them in separate glass vessels 
containing water and placing the vessels in the ultrasonic bath for 
20 minutes to remove the formic acid.

– Displace the water by immersing the ion block in separate glass 
vessels containing methanol and placing the vessels in the 
ultrasonic bath for 10 minutes.

4. Carefully remove the ion block from the vessel and blow-dry them using 
inert, oil-free gas.

Alternatively, place the components on lint-free towels and allow to air 
dry. Wipe off any water spots with a lint-free cloth.

Cleaning the isolation valve stem

To clean the isolation valve stem:

1. Use a glass-fiber pen to remove carbon deposits by gentle abrasion.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components. 

Warning: Use extreme care when working with formic acid. Use a fume 
hood and appropriate protective equipment.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components.
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2. Rinse the valve stem by placing it in a vessel containing methanol:water 
(1:1) and placing the vessel in an ultrasonic bath for 20 minutes.

Reassembling the source ion block
Tip: Wear clean rubber gloves when reassembling the source components.

To reassemble the source ion block:

1. Check the condition of all O-rings and seals; if damaged, replace with 
new items.

2. Fit the ion block blanking plug to the ion block and tighten.

3. Fit the PEEK terminal block to the ion block and fit and tighten the 
PEEK terminal block securing screw.

4. Fit the D-shaped seal to the ion block, ensuring that it is correctly 
seated.

5. Use the needle-nose pliers to slide the new heater cartridges into the ion 
block.

6. Position the two heater cartridge ring tags onto the PEEK block 
terminals.

7. Use an Allen key to fit and tighten the two screws securing the heater 
cartridge wires to the PEEK terminal block.

8. Refit the ion block cover plate.

9. Fit and tighten the four ion block cover plate securing screws.

10. Fit the isolation valve stem to the isolation valve body.

11. Fit the washer and retaining ring to the bottom of the isolation valve 
stem.

12. Fit and tighten the two lock nuts on the bottom of the isolation valve 
stem.

Reassembling the source ion guide assembly

To reassemble the T-Wave assembly:

1. Fit the aperture plate to the source ion guide assembly.
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2. Fit and tighten the three screws that secure the differential aperture 
plate to the source ion guide assembly.

3. Fit the locating ring to the assembly.

4. Check the condition of the metallized O-ring; if it is damaged, replace it.

5. Fit the metallized O-ring to the assembly.

6. Fit and tighten the three screws that secure the locating ring to the 
source ion guide assembly.

Fitting the source ion guide assembly to the instrument

To fit the ion guide assembly:

1. Ensuring that the Top labels (stamped on the assembly’s PEEK 
supports) are upper most, carefully slide the source ion guide assembly 
into the pumping block.

2. Fit the PEEK ion block support to the pumping block.

3. Fit and tighten the three PEEK ion block support securing screws.

Fitting the ion block and ion source enclosure

To fit the ion block and source enclosure:

1. Check the condition of all O-rings; if damaged, replace with new items.

2. Ensure that all the O-rings are in position on the ion block.

3. Fit the ion block to the PEEK ion block support.

4. Fit and tighten the two ion block securing screws.

5. Fit the source enclosure to the instrument housing.

6. Tighten the three source enclosure securing screws.

7. Connect the Desolvation Heater electrical connection on the instrument 
front panel.

8. Connect the PTFE tubing at the Desolvation gas connection on the front 
panel.
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Fitting the sample cone
Caution: The sample cone is very fragile. To avoid damage, never place the 
sample cone on its tip; always place it on its flanged base.

To fit the sample cone:

1. Fit the sample cone into the cone gas cone.

2. Check the condition of the sample cone/cone gas cone assembly O-ring; if 
damaged, replace with a new item.

3. Fit the O-ring to the sample cone/cone gas cone assembly.

4. Fit the sample cone/cone gas cone assembly to the side of the isolation 
valve body.

5. Fit the cone retaining plate.

6. Fit and tighten the two cone retaining plate securing screws.

7. Connect the PTFE tube to the cone gas cone.

8. Open the isolation valve by moving its lever fully to the left.

9. Refit the LockSpray motor and baffle.

10. If an IonSabre probe is to be used, fit the corona discharge pin.

11. Close the source enclosure door and fasten the clips.

Detector conditioning
Caution: When the instrument has been vented, the detector should be 
reconditioned. Ensure that the Tof vacuum has been at < 3e-6 mBar for at 
least 1 hour before conditioning the detector.

To condition the detector:

1. Select V mode.

2. Click the Instrument tab in the Tune window and set Detector voltage 
to 0. 

3. Switch to Operate.

4. Click Setup > Detector Conditioning.
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5. In the MCP Conditioning dialog box set the following parameters and 
Click Start.
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Cleaning or replacing the ESI probe tip

Clean the ESI probe tip if a blockage occurs in the internal metal sheathing 
through which the stainless steel capillary passes.

Replace the ESI probe tip if the threads are damaged.

Replace the O-ring if gas leaks from the O-ring.

Required Materials

• Rubber gloves.

• ¼-inch (6-mm) Allen key (hex wrench).

• Appropriately-sized glass vessels, in which to completely immerse 
components when cleaning.

• Use only glassware not previously cleaned with surfactants.

• HPLC-grade methanol.

• HPLC-grade water.

• Ultrasonic bath.

• Source of oil-free, inert gas (nitrogen or helium) for drying (air-drying 
optional).

To replace the ESI Probe tip:

Caution: Perform all work on the probe on a clean work bench.

1. Remove the probe from the source (see page 8-6).

2. Use the ¼-inch (6-mm) wrench to unscrew and remove the probe tip.

3. If the probe tip is damaged, replace with a new tip; alternatively clean 
the probe tip.

4. If necessary, remove the O-ring and fit a new O-ring.

5. Fit and tighten the probe tip to the probe.

Warning: To avoid contamination from previously sprayed 
sample, wear gloves at all times when handling the probe. This 
also prevents finger-grease contaminating the capillary.
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6. Adjust the probe tip so that the fully extended capillary (when the probe 
nebulizer adjuster knob is fully screwed down) protrudes by 
approximately 1 to 1.5 mm.

7. Refit the probe to the source.

See also: 
• To remove the probe from the source on page 8-6

• To clean the probe tip: on page 8-27

To clean the probe tip:

1. Immerse the probe tip in a glass vessel containing methanol:water (1:1).

2. Place the vessel in the ultrasonic bath for 20 minutes.

3. Carefully remove the probe tip from the vessel and blow-dry using inert, 
oil-free gas.
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Replacing the ion block cartridge heater

Replace the cartridge heater if it fails to heat the source ion block. 

Required Materials

• Rubber gloves

• 3-mm hex wrench

• 1.5-mm hex wrench

• Flat-blade screwdriver

• Needle-nose pliers

To remove the heater cartridge assembly:

Prerequisite: Ion source enclosure and ion block removal on page 8-9

1. Use an Allen key to remove the four ion block cover plate securing 
screws.

2. Remove the ion block cover plate.

3. Use an Allen key to remove the two screws securing the heater cartridge 
wires to the PEEK terminal block.

4. Use the needle-nose pliers to carefully swing the ring terminal tags out 
of the terminal block.

Cartridge heater wire securing screws

PEEK terminal block
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5. Use the needle-nose pliers to gently slide the heater cartridge assembly 
out of the ion block.

6. Use the needle-nose pliers to slide the new heater cartridges into the ion 
block.

7. Position the two heater cartridge ring tags onto the PEEK block 
terminals.

8. Use an Allen key to fit and tighten the two screws securing the heater 
cartridge wires to the PEEK terminal block.

To refit the ion block:

Prerequisites: 
• Ion source enclosure and ion block removal on page 8-9

Ring terminal tag

Heater cartridge assembly
Replacing the ion block cartridge heater 8-29



1. Refit the ion block cover plate.

2. Fit and tighten the four ion block cover plate securing screws.

3. Check the condition of all O-rings; if damaged, replace with new items.

4. Ensure that all the O-rings are in position on the ion block.

5. Fit the ion block to the PEEK ion block support.

6. Fit and tighten the two ion block securing screws.

7. Fit the source enclosure to the pumping block.

8. Fit and tighten the three source enclosure securing bolts.

9. Connect the PTFE tube to the cone gas cone.

10. If using an APCI probe, carefully refit the corona discharge pin.

11. Connect the Probe electrical connection on the instrument front panel.

12. Connect the PTFE tubing at the Desolvation gas connection on the front 
panel.

13. Fit the probe on the source.
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Replacing the ESI probe capillary 

The stainless steel sample capillary in the ESI probe must be replaced if it 
becomes blocked and cannot be cleared, or if it becomes contaminated or 
damaged.

Required materials

• 7-mm hex wrench

• ¼-inch (6-mm) hex wrench

• 5/16-inch wrench

• Needle-nose pliers

To remove the existing capillary:

Caution: Perform all work on the probe on a clean work bench.

Prerequisite: To remove the probe from the source on page 8-6.

1. Use an Allen key to remove the two probe end cover retaining screws.

2. Remove the end cover.

Warning: To avoid contamination from previously sprayed 
sample, always wear gloves when handling the probe. This also 
prevents finger-grease contaminating the capillary.

End cover retaining screws
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3. Unscrew and remove the nebulizer adjuster knob to reveal a PEEK 
union/UNF coupling assembly and the capillary.

4. Remove the nebulizer adjuster knob, PEEK union/UNF coupling 
assembly and capillary from the probe.

5. Remove the PEEK union/UNF coupling assembly and capillary from the 
nebulizer adjuster knob.

End cover

Capillary

Nebulizer adjuster knob
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6. Unscrew and remove the knurled collar from the UNF coupling to reveal 
a conductive sleeve on the capillary.

7. Remove the knurled collar and conductive sleeve from the capillary.

8. A locknut is used to secure the PEEK union and UNF coupling. Use the 
7-mm wrench to loosen the locknut.

PEEK Union/UNF assembly

PEEK Union UNF coupling

Conductive sleeve

Knurled collar
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9. Unscrew the PEEK union from the UNF coupling (this connection is 
finger-tight only).

This reveals a ferrule and liner sleeve:

7-mm wrench

Locknut
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10. Remove the ferrule and liner sleeve from the capillary.

11. Remove the capillary from the UNF coupling.

Installing the new capillary

To install the new capillary:

1. Insert a square-cut length of red PEEK tubing in the probe inlet 
connector and screw the connector finger-tight into the PEEK union. 
This ensures a minimum dead volume when fitting the capillary.

2. Fit the UNF coupling to the new capillary.

3. Use the needle-nose pliers to slide a new liner sleeve and ferrule onto 
the capillary.

Ferrule

Liner sleeve

Probe inlet connector

PEEK tubing
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4. Insert the capillary in the PEEK union and ensure that it is fully seated.

5. Screw the UNF coupling into the PEEK union, finger-tight only.

6. Pull on the capillary gently, testing to ensure that it stays in place.

7. Use the 7-mm wrench to tighten the locknut against the PEEK union 
until the union can no longer be twisted.

8. Slide a new conductive sleeve and the knurled collar over the capillary.

9. Tighten the knurled collar to the UNF coupling.

10. Check for leaks in the assembly by attaching the free end of the PEEK 
tubing to an LC pump and pumping through 50:50 acetonitrile:water at 
1 mL/min.

If leakage occurs, the connection must be disassembled and remade, and 
the leak test repeated.

Warning: To avoid injury, from possible high-pressure liquid jet 
spray, wear safety goggles when performing the leak test.
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11. When performing the leak test, check the backpressure on the LC pump. 
This will be high if the capillary is blocked. If this is the case, replace the 
capillary with a new one.

12. When the leak test has been performed successfully, disconnect the 
PEEK tubing from the LC pump.

13. Remove the probe inlet connector and PEEK tubing from the PEEK 
union.

14. Refit the PEEK union/UNF coupling assembly to the nebulizer adjuster 
knob.

15. Use the ¼-inch (6-mm) wrench to remove the probe tip from the probe.

Leaking liquid
Replacing the ESI probe capillary 8-37



16. Carefully thread the capillary through the probe assembly.

17. Ensuring that the locating pin on the UNF coupling engages with the 
slot in the head of the probe assembly, fit and screw the nebulizer 
adjuster knob and PEEK union/UNF coupling assembly to the probe 
assembly. Do not tighten the knob fully.

Ferrule

Locating Pin Locating Slot
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18. Refit the probe end cover to the probe assembly.

19. Refit and tighten the two end cover securing screws.

20. Refit the probe tip over the capillary and screw the tip onto the probe 
assembly.

21. If necessary, adjust the probe tip so that the fully extended capillary 
(when the nebulizer adjuster knob is fully screwed down) protrudes by 
approximately 1 to 1.5 mm.

22. Use the nebulizer adjuster knob to adjust the capillary so that the 
capillary protrudes by approximately 0.5 mm from the end of the probe.

23. Attach the nebulizer gas connection and turn on the nitrogen, by 
clicking  on the MassLynx Tune window.

Locating slotLocating pin

Probe tipCapillary
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24. Check the probe tip for nitrogen leaks. If a leak is found, replace the 
probe tip assembly and its O-ring (see Cleaning or replacing the ESI 
probe tip on page 8-26).

25. Refit the probe to the instrument.
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IonSABRE probe maintenance

Cleaning or replacing the corona discharge pin
Clean the corona discharge pin if it appears to be corroded or black, or when 
the signal intensity weakens.

Required materials

• Rubber gloves

• Needle-nose pliers

• Lapping film

• HPLC-grade methanol

• Lint-free tissue

To clean or replace the corona discharge pin:

1. Remove the probe from the source, (see To remove the probe from the 
source on page 8-6).

2. Unfasten the source enclosure door’s securing clips and open the door.

3. Remove motor assembly or UV lamp if fitted.

4. Use the needle-nose pliers to remove the corona discharge pin from the 
source, pulling it straight out.

5. Clean and sharpen the tip of the new pin with the lapping film, then 
wipe it clean with a methanol-saturated tissue. Replace the pin by a new 
pin if it is deformed or otherwise damaged.

6. Reinstall the pin with the tip pointing toward the sample cone apex.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components.

Warning: To avoid possible electric shock, ensure that the instrument is 
in standby mode before commencing this procedure.
Warning: The probe and source are liable to be hot. To avoid burns, 
take great care while working with these items.
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7. Close the source enclosure door and fasten the clips.

8. Refit the probe.

9. Reconnect the front panel gas and electrical connections.

Cleaning the IonSABRE Probe Tip
If a reduction in sensitivity, or an increase in chemical background is noticed, 
the probe tip should be cleaned by running at maximum temperature without 
a liquid flow.

To clean the IonSABRE probe tip:

1. The instrument should be in operate with the LC liquid flow off

2. Set desolvation gas flow to 500 L/h

3. Set IonSabre probe temperature to 650 °C 

4. Wait for 10 minutes. This will remove any chemical contamination from 
the probe tip.

5. Return IonSabre probe temperature to its previous value

6. Set the desolvation gas flow rate to 100 L/h

Corona 
Discharge pin

Sample Cone 
apex
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Replacing the IonSABRE Probe Capillary
Replace the stainless steel sample capillary in the APCI probe if it becomes 
blocked and cannot be cleared, or if it becomes contaminated or damaged.

Required Materials

• 7-mm hex wrench

• ¼-inch (6-mm) hex wrench

• 5/16-inch wrench

• Needle-nose pliers

Removing the Existing Capillary

Caution: Perform all work done on the probe on a clean work bench.

To remove the existing capillary:

1. Remove IonSABRE probe from source and allow to cool completely.

2. Use the Allen key to remove the two probe end cover retaining screws 
and remove the end cover.

Warning: To avoid contamination from previously sprayed sample, 
always wear gloves when handling the probe. This also prevents 
finger-grease contaminating the capillary.

End cover retaining screws
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3. Unscrew and remove the nebulizer adjuster knob to reveal a PEEK 
union/UNF coupling assembly, compression spring, and the capillary.

4. Remove the nebulizer adjuster knob, PEEK union/UNF coupling 
assembly, compression spring, and capillary from the probe.

5. Remove the PEEK union/UNF coupling assembly, compression spring, 
and capillary from the nebulizer adjuster knob.

End cover

Nebulizer adjuster knob

Capillary Compression spring
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6. Remove the compression spring from the PEEK union/UNF coupling 
assembly and capillary.

7. A locknut is used to secure the PEEK union and UNF coupling. Use the 
7-mm wrench to loosen the locknut.

8. Unscrew the PEEK union from the UNF coupling (this connection is 
finger-tight only).

PEEK union/UNF coupling assembly

PEEK union 7-mm wrench

Locknut UNF coupling
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This reveals a ferrule:

9. Remove the ferrule from the capillary.

10. Remove the capillary from the UNF coupling.

Installing the New Capillary

To install the new capillary:

1. Insert a square-cut length of red PEEK tubing in the probe inlet 
connector and screw the connector finger-tight into the PEEK union. 
This ensures a minimum dead volume when fitting the capillary.

Ferrule
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2. Fit the UNF coupling to the new capillary.

3. Use the needle-nose pliers to slide a new ferrule onto the capillary.

4. Insert the capillary in the PEEK union and ensure that it is fully seated.

5. Screw the UNF coupling into the PEEK union, finger-tight only.

6. Pull on the capillary gently, testing to ensure that it stays in place.

7. Use the 7-mm wrench to tighten the locknut against the PEEK union.

8. Check for leaks in the assembly by attaching the free end of the PEEK 
tubing to an LC pump and pumping through 50:50 acetonitrile:water at 
1 mL/min.

Warning: To avoid injury, from possible high-pressure liquid jet 
spray, wear safety goggles when performing the leak test.

PEEK tubing

Probe inlet connector
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If leakage occurs, the connection must be disassembled and remade, and the leak 
test repeated.

9. When performing the leak test, check the backpressure on the LC pump. 
This will be high if the capillary is blocked. If this is the case, replace the 
capillary with a new one.

10. When the leak test has been performed successfully, disconnect the 
PEEK tubing from the LC pump.

11. Remove the probe inlet connector and PEEK tubing from the PEEK 
union.

12. Pull the probe heater off.

Leaking liquid
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Caution: Take great care not to damage the probe heater electrical 
wiring either when removing the probe heater cover or while the probe 
heater is exposed.

13. Refit the compression spring to the capillary and PEEK union/UNF 
coupling assembly.

14. Carefully thread the capillary through the probe assembly.

15. Ensuring that the locating pin on the UNF coupling engages with the 
slot in the head of the probe assembly, fit and screw the nebulizer 
adjuster knob and PEEK union/UNF coupling assembly to the probe 
assembly. Do not tighten the knob fully.

16. Refit the probe end cover to the probe assembly.

17. Refit and tighten the two end cover securing screws.

18. Carefully slide the probe heater over the capillary sleeve, align the probe 
heater connections with the probe body, and then push all the way on.

19. Use the nebulizer adjuster knob to adjust the capillary so that the 
capillary protrudes by approximately 0.5 mm from the end of the probe.

20. Refit the probe to the instrument.

Replacing the IonSABRE Probe Heater
Replace the IonSABRE probe heater if it fails to heat.

Locating pin Locating slot
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To replace the probe heater:

1. Disconnect and remove the probe from the source

2. Pull the probe heater off the probe (pull straight off, do not rotate).

3. Carefully slide the new probe heater over the capillary sleeve, align the 
probe heater connections with the probe body, and then push all the way 
on.

Maintaining the APPI Lamp

Changing the lamp bulb

To change the lamp bulb:

1. Click  and confirm the adjacent instrument status indicator shows 
red

2. Disconnect and remove the UV lamp assembly from the source enclosure

3. Remove the cover cap from the back of the lamp drive assembly (Figure 
titled “Changing the APPI lamp bulb:” on page 8-51).

4. Insert an appropriate tool (for example, a length of nylon tube) through 
the back of the lamp drive assembly, and push the bulb forward.

5. Withdraw the bulb from the lamp drive assembly.

6. Insert the new bulb into the lamp drive assembly.

7. Refit the cover cap to the lamp drive assembly.

Warning: To avoid electric shock, ensure that the instrument is in 
standby mode before commencing this procedure.

Warning: To avoid contamination with toxic and biohazardous 
materials, wear rubber gloves at all times while handling the 
components. 
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Changing the APPI lamp bulb:

Nylon tube

Cover cap (Removed from the 
lamp drive assembly)

APPI lamp bulb
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Performing LockSpray maintenance

Cleaning the oscillating baffle
The baffle will need removing and cleaning at regular intervals particularly if 
you can see that it is dirty. The frequency that you will have to clean the baffle 
will depend on your application.

To clean the oscillating baffle:

1. Unplug the LockSpray motor from the instrument.

2. Remove the LockSpray motor from the source.

3. Put the baffle in a beaker of 50:50 acetonitrile:water or 50:50 
methanol:water with 1% formic acid and place in an ultrasonic bath for 
15 minutes. Rinse with water after cleaning.

4. When replacing the baffle, ensure it locates correctly on the square end 
of the shaft and check that it is oriented such that the reference and 
analyte sprays are selected correctly from the Tune window.

Replacing the reference probe capillary
If the LockSpray reference probe is blocked, replace its stainless steel 
capillary. 

Before carrying out this operation:

1. Switch the instrument into Standby.

2. Disconnect the high voltage cable from the probe.

3. Disconnect the nebulizer gas line, and remove the probe from the source.

To replace the reference spray probe tip:

1. Remove the reference sprayer from the source enclosure.

Warning: Always remove the high voltage connection before 
attempting any probe maintenance.

Warning: Allow the probe to cool down before working on it.
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2. Using the wrench provided, unscrew and carefully remove the probe tip 
from the probe support segment 

3. Carefully slide the new electrospray probe tip over the stainless steel 
capillary and fit it to the probe support segment.

4. Adjust the probe tip so that the sample capillary is protruding by 
approximately 0.5 mm from the end of the tip.

5. Refit the probe to the source enclosure. 

Tip: Tweezers may be used to apply light pressure to the capillary to 
adjust its position.

To replace the sample capillary:

If the sample capillary becomes blocked, or is damaged, it may be replaced as 
follows:

1. Remove the reference sprayer from the source enclosure

2. Unscrew the hexagonal nut from the probe support segment.

Warning: The interface may be contaminated with biologically 
hazardous materials. Always wear rubber gloves while handling the 
components.

Probe TipProbe Support
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3. Unscrew the finger-tight PEEK fitting from the union passing through 
the reference flange.

4. Remove the PEEK fitting and PTFE protective sleeve from the sample 
capillary.

Hexagonal Nut

PEEK Union

PTFE Sleeve

Protective Sleeve

FerruleCapillary

Hexagonal Nut

PTFE Sleeve

Ferrule

Probe Support 
Segment

Sample Capillary
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5. Slide the sample capillary out of the PTFE sleeve seated in the probe 
support segment.

6. Slide the PTFE sleeve out of the probe support segment.

Caution: If using a tool to remove the ferrule from the PEEK fitting, 
take care not to damage the fitting.

Tip: If the graphite ferrule is stuck in the probe support segment, use a 
screwdriver, or similar object, to lever it out.

7. Feed the new sample capillary through the probe tip. Continue feeding 
the capillary through until approximately 0.5 mm of capillary is left 
protruding from the probe tip.

8. Slide a 93 mm length of 1/16 inch o.d., 0.010 inch i.d. PTFE sleeve over 
the free end of the sample capillary. Feed this into the probe support 
segment until it is firmly located in the segment.

9. Slide a graphite ferrule and the hexagonal nut over the PTFE sleeve.

Caution: Ensure that the ferrule is not over-compressed when 
tightening the hexagonal nut onto the probe support segment.

PTFE Sleeve (93 mm long)

PTFE Sleeve (30 mm long)

Sample Capillary

Protective Sleeve

PEEK Fitting

Union
Performing LockSpray maintenance 8-55



10. Ensure that approximately 0.5 mm of sample capillary is protruding 
from the probe tip, then tighten the nut onto the probe support segment 
sufficiently to grip the ferrule onto the sample capillary.

11. Slide the PTFE protective sleeve over the sample capillary and PTFE 
sleeve.

12. Ensure that the 30 mm long 1/16 inch o.d., 0.010 inch i.d. PTFE sleeve is 
located in the PEEK fitting.

13. Slide the PEEK fitting over the capillary.

14. Slide the protective sleeve over the joint between the two PTFE sleeves 
(this prevents the sample capillary kinking at this point) and ensure the 
sample capillary protrudes a few millimeters through the PEEK Union.

15. Locate the PEEK fitting within the union on the reference flange, 
making sure the sample capillary still protrudes through the union.

16. To ensure that the sample capillary is fully butted to the union passing 
through the reference flange, use another PEEK fitting from the other 
side to locate the capillary precisely.

Protective SleevePEEK Fitting

Sample Capillary 
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17. Fit and finger-tighten the PEEK fitting into the union.

18. Refit the reference flange to the source enclosure.

PEEK Fitting

PTFE Sleeve

Sample Capillary

Union
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Performing NanoLockSpray maintenance

Cleaning the oscillating baffle
The baffle will need removing and cleaning at regular intervals particularly if 
you can see that it is dirty. The frequency that you will have to clean the baffle 
will depend on your application.

To clean the oscillating baffle: 

1. Unplug the motor cable from the front panel.

2. Unplug the HV and Interlock cables from the front panel and remove the 
analyte adjuster assembly.

3. Undo the thumbscrew holding it to the shaft. In order to gain access to 
the screw with the NanoLockSpray source still mounted on the 
instrument, the NanoLockSpray should be set in the Analyte position. 

4. Put the baffle in a beaker of 50:50 acetonitrile:water or 50:50 
methanol:water with 1% formic acid and place in an ultrasonic bath for 
15 minutes. Rinse with water after cleaning. 

5. When replacing the baffle, ensure it locates correctly in the baffle holder 
on the end of the shaft. 

Replacing the reference probe capillary 
If the silica reference capillary is blocked, or if it is contaminated or damaged, 
replace it.

In most cases, use the ceramic cutter to remove the end of the capillary and 
feed more of the capillary loop through the Valco tee-piece. When there is no 
loop remaining you will have to replace the whole assembly

To replace the reference probe capillary:

1. Disconnect the probe.

2. Remove the nebulizing gas line from the tee (page 8-59).

3. Build the sprayer as described in (Chapter 5).
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To disconnect the probe: 

1. Disconnect the reference line from the probe and remove the finger-tight 
nut. 

2. Disconnect the HV cable from the reference probe at the instrument 
front panel. 

3. Disconnect the HV cable from the analyte probe at the instrument front 
panel.

4. Disconnect the reference probe nebulizing gas tube. 

5. Remove the reference probe cover and undo the two bolts holding the 
reference probe to the NanoLockSpray housing and carefully withdraw 
the probe. 

To remove the nebulizing gas line from the tee:

1. Loosen the grub screws that secure the Tee and Union, remove the tee 
and union from the probe holder. 

2. Undo the tee nut and union nut marked A and remove the fused silica 
and the PTFE sleeves. 

3. Remove the headless sealtight nut and ferrule and 75-µm i.d. fused 
silica. 

4. Discard both pieces fused silica. 

Warning: Always remove the high voltage connection before 
attempting any probe maintenance.
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9 Fault Finding

Most faults can be traced to a malfunction of the ion source or inlet 
system. On systems equipped with more than one source, this can often 
be confirmed by changing sources to see if the fault moves with the 
source.

Should a fault occur soon after a part of the system has been repaired or 
otherwise disturbed, first ensure that this part has been correctly 
refitted and adjusted, and that adjacent components have not been 
inadvertently disturbed.

Contents

Topic Page
Instrument stops responding to MassLynx 9-2

No Beam 9-4

Unsteady beam 9-4

High back-pressure 9-5

Loss of sensitivity 9-6

Incorrect isotope distributions 9-6

High noise levels 9-6

LockSpray fault finding 9-7

Contacting Waters 9-7
9-1



Instrument stops responding to MassLynx

If the instrument stops responding to commands from MassLynx, the first 
thing to try is to exit MassLynx and then restart the application. If this fails, a 
reboot will be necessary. 

There are three levels of reboot, with the levels required being dependent on 
the nature of the problem. Before rebooting you must determine whether a 
communications (comms) link exists between the MassLynx PC and the 
embedded PC (EPC)

Tip: It iss best to exit MassLynx before doing a reboot.

Testing Communications between MassLynx PC and the EPC
From Windows, select Start > Run and type ping -t epc in the Run dialog box.

The following messages appear if the comms link is OK.

The following messages will appear if there is no PC to EPC comms. This 
indicates a test failure.

Tip: The comms test will fail during an EPC reboot. The comms link will 
recover with the completion of the reboot. If the comms link does not recover 
check the network cable linking the MassLynx PC with the PC Link socket at 
the rear of the instrument.
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Rebooting

There are three level of reboot that you can try.

• From Telnet

• By resetting the EPC

• Switching the instrument off.

However, success depends on the nature of the problem. You should therefore 
try all three in the order listed here, until you succeed

To reboot from TELNET:

1. From Windows, select Start > Run and type telnet epc in the Run dialog 
box.

2. Type reboot at the –> prompt in the telnet epc window. This will reload 
the EPC software.

If the –> prompt is absent, then an embedded PC reset will be necessary.

Tip: The full reboot will take about 3 minutes to complete.

To reboot by resetting the EPC:

Push the EPC reset button on the front of the instrument. This will reboot the 
EPC operating system and reload the EPC software.

The full reboot will take about 3 minutes to complete.

If this doesn't fix the problem, then a full power-off reboot will probably be 
necessary

To reboot by power off:

1. Switch the Pump override switch, on the rear of the instrument, to the 
down position.

2. Switch off the electronics power at the rear of the instrument. Wait 5 
seconds, and switch back on. This will reboot both the embedded PC and 
the control PCB. 

The full reboot will take about 3 minutes to complete.

3. Open MassLynx and the Tune window before resetting the Pump 
Override switch to the up position.
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No Beam

Consult the relevant chapters of this manual and ensure the system meets 
these conditions:

• Normal tuning parameters are set and, where applicable, readback 
values are acceptable.

• All necessary cables have been correctly attached to the source and 
probe.

• Solvent is reaching the probe tip and the solvent flow rate is as required.

Tip: For solvent flow rates below 100 µL/min, it may be necessary to 
temporarily turn off the nebulizing gas and remove the probe from the 
source to allow the solvent to be seen at the probe tip.

• The desolvation and nebulizer gas are flowing and set according to the 
correct flow rates.

• The source has been assembled correctly and is clean.

• The source isolation valve is open.

If, after performing the above checks, the beam is still absent contact Waters.

Unsteady beam

Refer to the relevant chapters of this manual and check that:

• Capillary (electrospray) and Sample Cone are tuned correctly.

• The capillary is not protruding too far from the end of the probe.

• The probe is not too far into the source.

• The flow of solvent from the HPLC pump is correct and steady.

Note: To do this, remove the probe, degas the solvent, increase the flow 
rate for several minutes to purge any trapped air then reset and 
re-measure the flow rate.

• Solvents have been adequately degassed.

• The nitrogen flow of desolvation and nebulizer gas is steady. The 
nitrogen supply pressure should be 7 bar (100 psi) ±10%.

• Desolvation and Source temperatures are not set too high or low for the 
liquid flow rate used.
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Tip: High temperatures can vaporize solvent within the electrospray 
probe.

Should the preceding checks fail to reveal the cause of the problem, proceed to 
the following section.

High back-pressure

For electrospray, a higher than normal back-pressure readout on the HPLC 
pump, together with a slowing of the actual solvent flow at the probe tip, can 
indicate that there is a blockage in the capillary transfer line or injection loop 
due to particulate matter from the sample.

To clear the blockage:

Remove the probe from the source and increase the solvent flow to 50 µL/min 
to remove the blockage.

Tip: Often, injections of neat formic acid help to redissolve any solute which 
has precipitated out of solution.

If the blockage cannot be cleared in this fashion:

1. Remove the finger-tight nut and tubing from the back of the probe.

2. If the back pressure remains high, replace the tubing with new tubing 
(or first try removing both ends of the tube).

3. If the back pressure falls, replace the stainless steel sample tube inside 
the probe (or try reversing the tube to blow out any blockage).

4. Reconnect the tubing to the probe.

The solvent flow can now be readjusted and the probe replaced into the source.

Tip: To check the flow rate from the solvent delivery system, time how long a 
known volume takes to emerge from the probe tip. Once the rate has been 
measured and set, note the back pressure readout on the pump, as fluctuation 
of this reading can indicate problems with the solvent flow.

For APCI, a higher than normal back pressure readout on the HPLC pump 
can imply that, after a long period of use, the filter pad requires replacement.
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Loss of sensitivity

As the ion source becomes dirty after prolonged use, the performance will 
degrade.

Unstable or reduced ion currents indicate that the source needs cleaning. The 
usual remedy is to clean the source as described in Cleaning the Source 
components on page 8-5.

An increase in the analyzer pressure above 4e-6 mbar can also cause loss of 
sensitivity, although the pressure at which this occurs will be sample 
dependent.

Incorrect isotope distributions

Incorrect isotope distributions can be caused by:

• The TDC Signal threshold (mV) threshold being set too high

• A faulty MCP

• Saturated Signal

• A faulty attenuator

High noise levels

High noise levels can either be chemical or electronic in nature.

Chemical noise
Chemical noise usually originates from contaminated samples, solvents, or 
source gases.

It can be distinguished from electronic noise simply by stopping source 
ionization. If no liquid or gases are entering the source and all the source 
voltages are set to zero, then the remaining noise will be electronic in nature.

Electronic noise
Electronic noise can be caused by setting the signal threshold too low. The 
microchannel plate detector can be damaged by failure to properly condition 
the detector after venting of the system to atmosphere. If the detector is 
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producing micro discharges, excessive noise is apparent on the baseline of 
mass spectra in the absence of any ion beam. Reducing the detector voltage 
will reduce the number of discharges and also reduce the noise.

LockSpray fault finding

The following faults and solutions apply to LockSpray and NanoLockSpray:

• If the Tune window “times out” when attempting to find either the 
analyte or reference spray, ensure that the motor cable is connected.

• If the signals from either spray are unstable, or the signal changes when 
operating, it is possible that the baffle may need cleaning (see Cleaning 
the oscillating baffle on page 8-52) or that the sprayer is discharging to 
the baffle(this indicates the need to reduce the capillary voltage). 

General maintenance and fault finding for a ZSpray source operating in the 
electrospray mode are found in the appropriate sections of this chapter.

Contacting Waters

You can easily correct many problems with the Q-Tof Premier. However, if 
this is not the case, you must contact Waters.

Customers in the USA and Canada should report maintenance problems they 
cannot resolve to Waters Technical Service (800 252-4752). All others should 
visit http://www.waters.com and click Offices, or phone their local Waters 
subsidiary or Waters corporate headquarters at 34 Maple Street, Milford, 
MA 01757, USA.

When contacting Waters, have the following information available:

• The nature of the symptom

• The Q-Tof Premier serial number

Depending on the nature of the fault, it may also be useful to have the 
following information available:

• Details about the flow rate, mobile phases, and sample concentrations

• Tune window settings

• The Software version update reference
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A Starting Up and Shutting Down

Contents:

Topic Page
Starting the Q-Tof Premier A-2

Shutting down the Q-Tof Premier A-3

Automatic startup and shutdown A-5
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Starting the Q-Tof Premier

To startup the Q-Tof Premier:

1. Turn on the following Vacuum, electronics Embedded PC, and auxiliary 
breakers on the rear of the instrument. Allow 3 minutes for the 
embedded PC to initialize.

2. Start the MassLynx software. The MassLynx window appears and the 
word Ready appears in the status bar at the bottom of the window.

3. Click the Instrument shortcut bar MS Tune icon to open the Tune 
window.

4. Select Vacuum > Pump.

5. Click the Diagnostics tab.

Tip: If the Diagnostics tab is not present, select View > Extended 
Controls.

6. Monitor the Turbo Speeds. These parameters should reach 98 to 100% 
within approximately 5 minutes of selecting Options > Pump.

7. Ensure that the instrument has pumped sufficiently such that the 
Vacuum LED on the front panel is steady green. The mass spectrometer 
is sufficiently evacuated to enable operation in three hours.

See also: 
• Front panel on page 1-7
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Shutting down the Q-Tof Premier

Emergency instrument shutdown

In the event of having to shut down the instrument in an emergency, switch 
off the power at the wall mounted isolation switch(es), if fitted. If not, switch 
off the System Power switch located on the rear of the instrument and turn off 
all peripherals.

Important: A loss of data is likely.

Tip: If control of the instrument is lost through MassLynx, you can place it in 
Standby by pressing the Standby switch on the front of the instrument.

See also: 
• Rear panel on page 1-17

• Front panel on page 1-7

Overnight instrument shutdown
It is not necessary to switch the instrument out of Operate mode. However, 
this is acceptable provided that the instrument warm-up time is considered 
when restarting analysis.

To shutdown overnight:

When the instrument is to be left unattended for a long time, for example, 
overnight or at weekends, proceed as follows:

1. On the MassLynx Tune window Source tab, switch off the API gas and 
stop the syringe.

2. If required, click Press for Standby to switch the instrument out of 
Operate mode.

To completely shutdown:

1. On the Tune window, click Press for Standby.

Warning: The power switch does not isolate the instrument from the 
mains power supply. Unplug the mains power from the rear of the 
instrument to isolate the instrument from the mains power supply.
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2. Select Vacuum > Vent.

3. Select Vent Instrument, a message confirms the vent command.

4. Click OK. The turbomolecular pump is switched off. When the 
turbomolecular pump has run down to half its normal operating speed, 
the vent valve is opened and the instrument is automatically vented. 
The Vacuum LED will switch off after changing from green to amber.

5. Exit MassLynx.

6. Shut down the PC.

7. Switch off all peripherals.

8. Switch off the vacuum, electronics, Embedded PC / auxiliary breakers 
located on the rear panel.

See also: Rear panel on page 1-17
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Automatic startup and shutdown

MassLynx has automatic Startup and Shutdown files. They are found in the 
C:\MassLynx\Shutdown directory and are called ShutDownxxx.acl and 
StartUpxxx.acl, where xxx refers to the instrument configuration. E.g. 
ShutDownESI_ACE.acl for an instrument configured as an ACE system. 

Shutdown editor 
The Shutdown Editor allows automatic startup and shutdown procedures to 
be modified or created. These can be run automatically before or after a batch 
if you select the relevant check boxes in the Batch Control frame of the 
Shutdown Page.

Select Edit Shutdown or Startup from the MassLynx Instrument Shortcut Bar 
to open the Shutdown Editor. It contains the Shutdown page and the Auto 
Control Tasks page.

See also: 
• Shutdown page on page A-5

• Auto Control Tasks page on page A-10

Shutdown page
Click Edit Shutdown or Startup from the MassLynx Instrument Shortcut bar.
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Shutdown page:

By default the Shutdown page appears with the following parameters.

Shutdown page parameters:

Parameter Description
Enable startup before 
batch 

Enables/disables the running of a task file before 
the start of a batch of samples. Startup Enabled 
will appear on the right of the Status bar on the 
bottom of the MassLynx window when selected.

Startup file (text box) The file name of the task file that is run before the 
start of a batch. 

Browse (startup file) Displays a file dialog allowing you to select a task 
file for the startup before batch procedure. 

Enable shutdown after 
batch 

Enables/disables the running of a task file after the 
end of a batch of samples. Shutdown Enabled will 
appear on the right of the status bar on the bottom 
of the MassLynx window when selected.

Shutdown file (text box) The file name of the task file that is run after the 
end of a batch. 
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Configure Shutdown on Error 

Clicking the Configure Error Shutdown button displays the Shutdown on 
Error Configuration dialog box.

 

Browse (shutdown file) Displays a file dialog box where you select allowing 
a task file for the shutdown after batch procedure. 

Shutdown Time The delay (in minutes) between the batch finishing 
and the shutdown procedure initiating. 

Shutdown On Error Allows shutdown on error to be enabled/disabled 
and to determine whether the shutdown tasks 
should be initiated immediately, or after the time 
entered in the Shutdown Time edit box. 

Configure Error Shutdown Displays up the Shutdown on Error Configuration 
dialog.
See also: Configure Shutdown on Error on 
page A-7. 

Optimization Optimizes the procedure. 

E-mail on Error Shutdown Enter the e-mail address to send the shutdown 
information. 

Parameter Description
MS error Enables/disables running a task file when an MS 

error occurs. 

Shutdown page parameters: (Continued)

Parameter Description
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Configure contact closures 

Clicking on the Configure CCs displays the following dialog.

Use this dialog to configure the Event In contact closures on the back of the 
MS. These can be used to detect errors in external devices enabling the 
External device error flag to be set. Only contact closures not used to signal 

MS error shutdown file The task file to run on an MS error. 

MS Comms Error Enables/disables running task file when an MS 
comms error occurs 

MS comms error shut-
down file 

The task file to run on an MS comms error. 

Inlet fatal error Enables/disables running a task file when an LC 
error occurs. 

Inlet error shutdown 
file 

The task file to run when an LC error occurs. 

Ext. device error Enables/disables running a task file when an 
external device error occurs. 

Ext. device shutdown 
file 

The task file to run when an external device error 
occurs. 

Gas Threshold Opens the Gas Threshold dialog.
See also: Gas thresholds on page A-9.

Configure CCs Opens the Configure Event In dialog.
See also: Configure contact closures on 
page A-8). 

Parameter Description
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the completion of an injection, or not used by MUX systems, are enabled. Each 
available CC has the following controls. 

Gas thresholds 

Clicking Gas Thresholds in the Configure Shutdown on Error dialog box opens 
the Gas Threshold dialog box.

An MS error is flagged if the source gas flow rate falls below the value entered 
in the Low Threshold text box. 

Tip: The Gas Thresholds button is available only when the MS error option is 
selected.

See also: Shutdown page on page A-5

Parameter Description
Event In Number Relates to the Event In number on the rear of the 

MS. 

Availability This can either be Used By Inlet, Available, Used 
by MUX or Not Configured. The controls are only 
enabled if the CC is Available. 

Use For Ext Dev Error Enables/disables the use of this contact closure to 
signal an error in an external device. 

State when in error Determines what state the CC will be in when an 
error is present in an external device. 
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Auto Control Tasks page 

Parameter Description
Task Lists all the available tasks. 

Pre-Delay The length of time that will elapse before the 
current task is performed 

Post-Delay The length of time that will elapse after the 
current task has been completed and before the 
next task is started. E.g. a Post delay of 60s, in 
the Tune File task above, means that there will 
be a delay of 60 seconds before the next task is 
started, to allow the machine to stabilize with the 
new Tune window settings. 

Ion Mode Lists all the available ionization modes. 

File Name The name of the Tune file to be used. The file 
name can be typed in, including the full path 
name, or selected from the browser displayed 
when the Browse button is clicked. 
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To add a task:

1. Select a task from the Task list.

2. Enter the required parameters.

3. Click the add  button.

Tip: If this is a new task timetable the task will be added to the end of the list. 
If a task has been inserted into the task timetable then all subsequent tasks 
will be added after the inserted task. To add a task to the end of the timetable 
after inserting a task, double click below the last entry in the timetable and 
then add the new task.

To insert a task:

1. Click the entry in the task timetable before which you want to insert the 
new task.

2. Select a task from the drop down Task list box.

3. Enter the required parameters.

4. Click the add button. The task will be inserted before the selected entry.

To modify a task:

1. Click the entry in the task timetable. The details for the task will be 
displayed in the fields on the left of the screen.

2. Change the required parameters.

3. Click the modify  button. The details will change in the task 
timetable.

To delete a task:

1. Click the entry in the task timetable. The details for the task will be 
displayed in the fields on the left of the screen.

2. Click the add  button. The task selected will be deleted from the task 
timetable.

To delete all Tasks

Click the add  button. All tasks will be deleted from the task timetable.
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Running startup and shutdown files 

If Startup or Shutdown is selected from the MassLynx Shortcut bar or from 
the Shutdown editor Control List menu, then the automatic startup and 
shutdown files are run. 

To run a different startup or shutdown file: 

1. Open the required file in the Shutdown Editor and click the toolbar 
button or select Run List from the Shutdown Editor Control List menu. 

2. Click the toolbar button or select Stop List from the Shutdown editor 
Control List menu to stop running this file. 

Alternatively if the Enable startup before batch or Enable shutdown after 
batch options are selected on the Shutdown Page, the files will be run before 
or after a Sample List run.

See also: Shutdown page on page A-5.

Shutdown / Startup Log 
The Shutdown / Startup Log keeps a record of the most recent startups and 
shutdowns. Select Shutdown Log > Recent Shutdowns and Startups opens the 
Shutdown Startup Log. Selecting the most Recent Shutdowns and Startups in 
the top pane will show the tasks carried out in the bottom pane. 
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Log parameters 

Selecting Shutdown Log > Log Parameters from the main menu bar opens the 
Shutdown Log Parameters dialog box. You can alter the number of startups 
and shutdowns recorded in the Startup / Shutdown Log by changing the 
number in the text box.
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B Tune Window

This appendix adds more detail to the Tune window already described in 
Instrument Operation on page 2-1 and Chapter 3, Calibration.

Contents:

Topic Page
Tune window basics B-2

Controlling the display of readback windows B-4

Changing Tune parameter settings B-5
B-1



Tune window basics

Selecting the operating mode
The various operating modes are selected from the Mode menu. The currently 
selected modes have a check mark next to them.

Controlling gas flows
To toggle the nebulizer, desolvation, and cone gasses on and off, click .

Controlling the syringe pump
To toggle the syringe pump on and off, click .

To select the syringe type

1. Click  to open the Syringe Selection dialog box.

2. Select the syringe type currently being used from drop-down list.

3. If the required syringe type is not available, click Edit to open the 
syringe list, and then add the required details.

4. Click OK.
B-2 Tune Window



Tuning setup

To set parameters for tuning:

1. Click  or select Setup > Acquisition Settings to open the Tuning Setup 
dialog Box.

-

2. Enter the Start Mass and End Mass.

3. Enter the Scan Time and Inter Scan Delay.

Tip: Scan Time (s) and Inter Scan Delay (s) control the speed with which 
the tune peak display is updated.Tuning is more responsive when these 
parameters are set to low values.

4. Select a data format.
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Controlling the display of readback windows

There are three options for displaying system readbacks on the Tune window:

• Readbacks displayed continuously (Always On)

• Readbacks hidden (Always Off)

• Readbacks displayed only when differing from their defined values by 
more than 10% (On out of range)

A number of the readbacks are for diagnostic purposes only, their function 
being to confirm that a voltage is present. The acceptable variation between 
the set value and the readback value varies depending on the particular tune 
parameter. If you are concerned about any reading, contact Waters for advice 
(see Section 9.4, Contacting Waters).

To change the readback behavior:

1. Select View > Readback Behavior to open the Readback Behavior dialog 
box.

2. Select one of the three options.
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Changing Tune parameter settings

You can modify most parameters in the following ways:

• Drag the slider bar using the mouse.

• Click the slider bar and use the left and right arrow keys to change the 
value by one increment.

• The edit window updates as the slider bar is activated.

• Type a new value into the edit window.

Other parameters have only an edit window and are changed by direct typing.

The speed with which the system responds to changes depends on the speed 
with which the peak display refreshes. For the fastest response, set the 
Tuning Setup dialog box Scan Time (s) and Inter Scan Delay (s) values to be as 
short as possible.

Instrument parameter files
Instrument tuning parameters can be saved in an instrument parameter file 
(*.ipr), which can be recalled later.

An instrument parameter file contains all the parameters for all supported 
ionization modes, not just the ionization mode currently selected. Instrument 
parameter files also contain settings for the analyzer, inlet set points, and 
peak display.

Printing tune information
To print a report containing a copy of the tune peak information displayed on 
the screen and with a record of each parameter setting, click  or select 
File > Print.

You cannot configure this report.

Selecting the span of a displayed peak

To select the span of a peak:

1. Click and drag the mouse horizontally from one end to the other of the 
region of interest.
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As the mouse is dragged, a “rubber band” stretches out to indicate the 
selected range.

Do not go beyond the bounds of the axis.

2. Release the mouse button to redisplay the selected range so that it fills 
the current window.

You can repeat this as often as required.

Clicking  once, displays the previous magnification range, clicking it 
again returns to the default settings.

To select the span of a peak using the Span box:

1. Enter a value in the Span box for the required peak.

2. Click Return.

This becomes the default, so if the range is altered with the mouse and 
you click  twice, Span returns to this value.

Changing the gain of a displayed peak

To change the gain of a peak, either:

1. Double-click the line displaying the gain value (e.g., 2×) above the peak, 
to double the gain applied to that peak.

2. Double-click below the peak display to halve the gain.

Or:

1. Click and drag the left mouse button vertically from one end to the other 
of the region of interest.

As the mouse is dragged, a “rubber band” indicates the selected range.

Do not go beyond the bounds of the axis.

2. Release the mouse button to redisplay the selected range so that it fills 
the current window.
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Customizing the peak display

Opening the Peak display menu
Use the Peak display menu to customize the peak display. Open it by 
right-clicking in the appropriate peak display window on the Tune window.

Tip: You can customize the display window for each peak customized, e.g., the 
peak color for peak 1 can be red, for peak 2 green, etc.

Peak display menu:

Customizing the colors and numbers of displayed traces
To change the color of the background and traces, and to change the number of 
traces displayed, select Customise > Plot Appearance from the Peak Display 
pop-up menu to open the Customise Plot Appearance dialog box.

Customise Plot Appearance dialog box
Changing Tune parameter settings B-7



To change the colors on the display: 

Click the color box adjacent to Newest Trace, Background, or Trace Fill as 
required, and select a new color from the Color dialog box.

To change the number of displayed traces: 

Enter the required value in the Visible traces box, within the range 2 to 20.

If more than one trace is displayed, the older traces can be displayed in color 
shades different to the newer ones. Drag the Colour Interpolation slider 
toward the full position. The colors of the older traces appear in the 
Trace colour sample (new->old) field.

Customizing the peak trace line appearance
Each trace may be displayed as an outline, with the area below the line filled, 
or as maximum and minimum points only.

To display the peak outline only, select Trace > Outline from the Peak Display 
pop-up menu.

To display the filled trace, select Trace > Fill from the Peak Display pop-up 
menu.

To display the trace as minimum and maximum data points only, select 
Trace > Min/Max from the Peak Display pop-up menu.

The currently selected option has a check mark displayed next to it in the 
Peak Display pop-up menu.

Customizing the peak intensity display
To display the peak intensities as absolute values (cps), select Intensity > 
Absolute Intensity from the Peak Display pop-up menu.

To display the peak intensities as percentage values relative to the intensity 
of the highest peak, select Intensity > Relative Intensity from the Peak 
Display pop-up menu.

The Peak Display pop-up menu Intensity > Normalise Data option can be 
selected in conjunction with either of the above options. It controls the way in 
which the peak display is scaled. When enabled, the display scales to the 
value of the intensity of the highest peak; when disabled, the display scales to 
the default value set in the MassLynx software. It is recommended that the 
Intensity > Normalise Data option is normally enabled.
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The currently selected options have a check mark displayed next to them in 
the Peak Display pop-up menu.

Customizing the peak display grid
The Peak Display vertical and horizontal grid lines may be independently 
displayed or hidden.

To display the horizontal grid lines:

Select Grid > Horizontal from the Peak Display pop-up menu.

To display the vertical grid lines:

Select Grid >Vertical from the Peak Display pop-up menu.

The currently selected options have a check mark displayed next to them in 
the Peak Display pop-up menu.

Selecting the instrument name

To select the instrument name:

1. Select Options > Instrument Name to open the Instrument Name dialog 
box.

2. Enter the required name in the ID text box.

3. Click OK.
Changing Tune parameter settings B-9



B-10 Tune Window



C Setting-Up the Syringe Pump

This appendix describes how to set-up the syringe pump, which is used for 
infusing the standard solution during the tuning process.

To setup the syringe pump:

1. Plug the syringe grounding cable into the socket marked ‘syringe’ on the 
front connection panel.

2. Mount the syringe onto the pump

3. Attach the syringe grounding cable to the syringe needle

4. Connect the syringe pump to the required probe using a fused silica 
syringe line

5. Before using the syringe pump, ensure that the type of syringe used is 
selected in the MassLynx software (see Appendix B)

To prepare the fused silica:

1. Screw the Valco syringe adapter into the peek union.

2. Slide a syringe into the syringe adapter.

3. Tighten the syringe adapter nut until it grips the syringe.

4. Pull out the syringe.

5. Use a ceramic silica cutter to make a square, even cut on both ends of 
the sample capillary (supplied in the ESI probe installation kit) before 
installing. Examine new cuts for squareness using and eye glass. When 
cutting the capillary, allow enough length to form loops at angles and 
corners.

6. Connect the capillary to the PEEK union, using Upchurch® Scientific 
nut, ferrule and PTFE tubing.

Warning: To avoid electric shock (non-lethal), the syringe must be 
grounded.
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D Materials of Construction and 
Compliant Solvents

b

Warning: To avoid possible excessive leakage of solvent into the 
laboratory atmosphere, you must address any safety issues 
raised by the contents of this Appendix.

Contents:

Topic Page
Items exposed to solvent D-2

Common ingredients used to prepare mobile phases D-3
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Items exposed to solvent

The items detailed in Table titled “Items exposed to solvent” on page D-2 may 
be exposed to solvent; you must evaluate the safety issues involved if the 
solvents used in your application differ from the solvents normally used with 
these items. See Common ingredients used to prepare mobile phases on 
page D-3 for details of the most common ingredients used to prepare mobile 
phases.

Items exposed to solvent

Item Material
O-rings Viton or PTFE-encapsulated Viton

Gas tubes PTFE

Ion block Stainless steel

Ion block support PEEK

Corona discharge pin mounting 
contact

PEEK

Gas exhaust port Aluminium

Isolation valve Gold-plated aluminium/bronze

Push-in gas fittings Nickel/brass

Source enclosure Alochromed aluminium

Source enclosure view port Toughened plate glass

Probe adjustment flange Anodized aluminium, glass filled 
acetal, and stainless steel

Probe shaft PEEK

Probe adjuster bellows PTFE

Waste bottle Polypropylene
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Common ingredients used to prepare mobile phases

The following lists the most common ingredients used to prepare mobile 
phases for reverse-phase LC/MS (API):

• Water

• Methanol

• Acetonitrile

• Formic acid (<0.1%)

• Acetic acid (<1%)

• Trifluoroacetic acid (<0.1%)

• Ammonium acetate (<10 mM)

• Ammonium formate (<10 mM)

These solvents are not expected to cause any problems with the materials 
identified in Items exposed to solvent on page D-2.
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Glossary
AFAMM All File Accurate Mass Measure.

API Atmospheric Ionization

APCI Atmospheric Pressure Chemical Ionization

APPI Atmospheric Pressure Photoionization

Atomic mass The mass of an atom, or isotope, usually expressed in atomic 
mass units

Atom mass unit 
(amu)

A unit of mass 1/12 of the mass of the most abundant isotope 
of carbon, carbon 12, which is assigned a mass of 12. Also 
called Dalton.

Atomic number The number of protons in an atomic nucleus.

Average mass The mass of an ion calculated using the relative average 
isotopic mass of each element (where C=12.0111, H=1.00797, 
O=15.9994, etc.).

Base peak The peak in a mass spectrum corresponding to the m/z value 
that has the greatest intensity.

BPI Base Peak Intensity.

CID Collision Induced Dissociation.

cps Counts per second.

CVF Cone Voltage Fragmentation.

Dalton See Atomic mass unit.

DDA Data Directed Analysis.

Dead Time The data acquisition system for the instrument is a Time-to-
Digital Converter (TDC). This is an ion counting system that 
generates a mass spectrum by storing the ion arrival times in 
a histogram memory. After the arrival and registration of an 
ion by the TDC there is am minimum time interval before a 
subsequent ion arrival can be registered. This is called the 
“dead time” of the TDC and is of the order of 5 nanoseconds.

Desolvation The action by which a nebulized (or sprayed) sample is dried 
to remove the solvent component.
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DXC Dynamic eXternal Calibration. On a time-of-flight mass 
spectrometer, if the temperature of the lab changes, the mass 
position of a peak detected also changes due to expansion of 
the flight tube. To compensate for this, Waters instruments 
can be equipped with DXC technology.

EPC Embedded PC; the computer inside the instrument that 
connects to the control PC and the instrument electronics.

EPCAS Embedded Personal Computer Acquisition System.

ESCi ElectroSpray Chemical Ionization

ESI ElectroSpray Ionization.

FWHM Full Width at Half Maximum.

GFP Glu1-FibrinoPeptide B.

HPLC High Performance Liquid Chromatography

Ion An atom or a group of atoms, that has acquired a net electric 
charge by gaining or losing one or more electrons.

IPP Ions Per Push

Isotope One of two or more atoms having the same atomic number 
but different atomic masses.

Isotopic 
abundance

The naturally occurring distribution of the same element 
with different masses, e.g. 12C-12.0000=98.89%, 
13C=13.0034=1.1%.

Inlet file Stored in the AcquDb folder of the MassLynx project, the 
inlet file stores the parameters for the inlet system of your 
choice.

Inlet Method
Editor

Accessed from the MassLynx instrument shortcut bar or the 
Sample List, it is used to create and edit the Inlet file.

LED Light-Emitting Diode

LC Liquid Chromatography.

MALDI Matrix-Assisted Laser Desorption Ionization

MCP Micro-channel Plate (ion collector).

Method Editor Accessed from the MassLynx instrument shortcut bar or the 
Sample List, it is used to create MS method files.
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MRM Multiple Reaction Monitoring.

MS Mass Spectrometer.

Nebulization The process by which the sample solution is transformed into 
a fine mist in the source. The sample mist is also referred to 
as the spray.

Nominal Mass The mass of an ion calculated using the integer mass of the 
most abundant isotope of each element (i.e. it neglects the 
mass defect, where H=1, C=12, O=16 etc.).

oa-Tof Orthogonal acceleration Time-of-flight.

Operate mode (Of an instrument), the instrument mode in which high 
voltages are switched on. Data can be acquired in this mode. 
The instrument maybe left in this mode.

PEG Polyethylene glycol.

Penning gauge Gauge used to measure pressures from approximately 10-3 to 
approximately 10-8 mbar, the range in which the 
turbomolecular pumps operate.

Pirani gauge Gauge used to measure pressures from approximately 
atmospheric to approximately 10-3 mbar, the range in which 
the roughing pumps (rotary pumps and scroll pumps) 
operate.

Sample List The area in the main MassLynx window by which all the 
necessary parameters (MS method, Inlet, Tune, etc.) are 
defined for a list of samples.

Standby mode (Of an instrument), the instrument mode in which high 
voltages are switched off. Data cannot be acquired in this 
mode.

TDC Time-to-Digital Converter.

TIC Total Ion Count.

Tof Time-of-flight.

Tune file Stored in the AcquDb folder of the MassLynx project, the 
tune file stores the parameters for the mass spectrometer.
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Tune window The MassLynx module where the mass spectrometer is 
controlled. Tune parameters can be set and the instrument 
calibrated for exact mass.

UPLC Ultra Performance Liquid Chromatography.
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Symbols
*.exp 4-4, 6-5
*.ipr 2-7, B-5

A
Acceleration 2 voltage 2-19
accurate mass

calibrating 3-11
acquiring data

analog 4-29
calibration 3-12
monitoring 2-24
Sample List 4-2
Tune window 2-23

acquisition functions 4-17
Acquisition page 4-19, 6-6
Acquisition Setup 3-5
actual mass 4-7
adding

functions 4-27
tasks A-11

Adducts page 6-29
adjuster assembly 5-21
analog data

acquiring 4-29
Analog Data dialog box 4-29
analog input channel 1-22
analyzers

quadrupole 1-4
Tof 1-4

APCI 1-3
APCI baffle installation 7-8
APCI see also IonSABRE
aperture 5-7
Aperture 2 voltage 2-19
APPI 1-3, 7-4

dual mode 7-4

lamp status 7-19
source optimization 7-20

APPI connection 1-10
APPI lamp

drive assembly mounting shaft 
numbered indexing indents 
7-17

maintaining 8-50
replacing bulb 8-50

APPI lamp assembly 7-17
assembling

source ion block 8-22
source T-Wave assembly 8-22

Atmospheric Pressure Chemical 
Ionization, see APCI

Atmospheric Pressure photoionization, 
see APPI

Auto Control Tasks page A-10
Auto Fixed 2-22
Auto Profile 2-22

B
baffle

assembling 5-10
cleaning, LockSpray 8-52
cleaning, NanoLockSpray 8-58
installation, APCI 7-8
positions 7-10
removing 5-9, 8-7

benchmark tests 2-7
biological hazards iii
bulb, replacing 8-50

C
calculating

mass accuracy 4-6
resolution 2-26
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calibration
acquiring data 3-12
calibration graph 3-17
reassigning peaks 3-20
residuals 3-16
using monoisotopic peaks 3-21

calibration graph
data and reference files 3-17
mass difference 3-18
residuals 3-19

calibration solution 3-21
Calibration window 3-16
camera

controls 5-7
lens 5-7
setting up 5-23

Capillary connection 5-5
capillary connection 1-14
Capillary connections 1-9
Capillary voltage 2-12
capillary voltage

divider box 5-7
CE Int connection 1-23
Cell Entrance voltage 2-13
Cell Exit voltage 2-13
centroid data 4-18
Centroid Threshold 3-5
centroiding parameters 3-5
changing the source configuration 1-12
Charge State

peak selection 6-32
Charge State files 6-21
Charge State Recognition 6-23
checking

resolution 2-26
chemical hazard iii
chemical noise 9-6
Chromatogram real-time update 2-25
cleaning

cone gas cone 8-19
corona discharge pin 8-41
ESI probe tip 8-26
IonSABRE probe tip 8-42
isolation valve stem 8-21
oscillating baffle 8-52
probe tip 8-27
sample cone 8-19
source components 8-5
source ion guide assembly 8-20
the oscillating baffle 8-58

collision cell 2-21
Collision Cell Gas Flow voltage 2-13
Collision Energy page

DDA 6-16
MS/MS 4-26

Collision Energy Ramp 6-24
Collision Energy voltage 2-13
COM1/2 connection 1-24
complete shutdown A-3
conditioning the detector 8-24
cone gas cone, cleaning 8-19
cone gas flow rate 2-12
Cone Ramp dialog box 2-21
Cone Voltage page 6-25
configure contact closures A-8
Configure Shutdown on Error A-7
connections

APPI 1-10
Capillary 1-9, 5-5
capillary 1-14
CE Int 1-23
Comm 1/2 1-24
Desolvation 1-14
Desolvation gas 1-9
EPC Link 1-24
exhausts 1-20
front panel 1-8
gas 1-18
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Heater Interlock 1-14
Heater/Interlock 1-9
IO board 1-22
mains power 1-18
mains power unit 1-17
MALDI 1-10
Motor 1-10, 5-5
NanoLockSpray 5-4
NanoSpray 1-9, 5-6
Nebuliser 1-10, 5-6
nebulizer 1-14
nitrogen 1-19
Service Bus 1-24
Video Out 5-5
waste bottle 1-20

connections Heater/Interlock 5-5
contact closure 1-23
contact closures

configure A-8
contacting Waters 9-7
continuum data 4-18
controlling

gas flows B-2
syringe pump B-2

copying
functions 4-27

corona discharge pin
cleaning 8-41
replacing 8-41

creating
Charge State files 6-21

D
data

centroid 4-18
continuum 4-18

DATA LED 1-24
DDA

Acquisition tab 6-6
Adducts page 6-29
I

Collision Energy page 6-16
Cone Voltage page 6-25
Exclude page 6-25
Include page 6-12
MS Survey page 6-6
MS/MS page 6-8
Neutral Loss 6-40
Peak Detection page 6-30
Product Ion page 6-38
Variable Flow page 6-37

DDA, using 6-3
deleting

functions 4-27
tasks A-11

Desolvation connection 1-9
Desolvation gas connection 1-14
desolvation gas flow rate 2-12
Desolvation Temperature 2-12
detector conditioning 8-24
detector voltage 2-14, 3-8
detectors

MCP 1-6
PMT 1-6

Diagnostics page 2-6
dialog boxes

Analog Data 4-29
Cone Ramp 2-21
Readbacks B-4
Solvent Delay 4-28
Syringe Selection B-2

disassembling
source ion block 8-13
source T-Wave assembly 8-12

disconnecting 8-59
divider box 5-7
dual APPI

source optimization 7-23
dual LockMass 6-30
dual mode
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APPI 7-4
DXC temperature compensation 3-6
dynamic peak exclusion 6-26

E
EDC 4-11
EDC settings 3-6
editing

exclude list 6-28
tasks A-11

electrical connections
CE Int 1-23
COM 1/2 1-24
Events I/P 1-23
Events O/P 1-23

electronic noise 9-6
electronics maintenance 8-4
Electronics switch 1-17
ElectroSpray ionization, see ESI
emergency shutdown A-3
Engineering controls 2-6
EPC & Auxiliary 1-18
EPC Link 1-24
Error

Shutdown A-7
ESCi

source optimization 7-27
ESI 1-2

tuning 2-7
ESI probe

stainless steel capillary, replacing 
8-31

ESI probe tip
cleaning 8-26
replacing 8-26

Events I/P connections 1-23
Events O/P connections 1-23
Exclude page 6-25

dynamic peak exclusion 6-26

fixed peak exclusion 6-27
exhaust valve 1-21
exhausts 1-20
Extraction Cone voltage 2-12
eye protection iv

F
fault finding 9-1

chemical noise 9-6
electronic noise 9-6
high backpressure 9-5
high noise levels 9-6
instrument stops responding 9-2
isotope distributions 9-6
LockSpray 9-7
no beam 9-4
sensitivity 9-6
unsteady beam 9-4

fitting
ion block 8-23
ion source enclosure 8-23
nebulizer tip, Nano-LC 5-28

fixed peak exclusion 6-27
flammable solvents hazard iii
focus 5-8
formic acid 3-22
front panel connections 1-8
function list

adding a new function 4-27
changing the order of functions 

4-27
copying a function 4-27
modifying a function 4-27
opening a saved list

opening
function list 4-30

removing a function 4-27
saving 4-30
setting a solvent delay 4-28
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setting the maximum retention 
time 4-28

function types 4-17

G
gas connections 1-18
Gas Fail 1-23
gas flows, controlling B-2
gas supply, NanoSpray 5-21
Gas Thresholds A-9
Glass capillary 5-29

H
hazards

biological iii
chemical iii
flammable solvents iii
high temperature iv
high voltage iv

Heater/Interlock connection 1-9, 1-14, 
5-5

high backpressure 9-5
high noise levels 9-6
high temperature hazard iv
high voltage hazard iv
HM Resolution 2-13

I
Include page 6-12
indicated mass 4-7
Inlet Method editor 4-13
inserting

tasks A-11
installation

APCI baffle 7-8
instrument control

pages 2-6
instrument name, selecting B-9
Instrument page 2-6
Instrument page parameters 2-13
I

instrument parameter files B-5
instrument tuning parameters 2-21
intended use xii
inter-scan delay 4-21
IO board 1-22
ion block

cartridge heater, replacing 8-28
fitting 8-23
removing 8-9

Ion Energy voltage 2-13
ion guide 2-21
Ion Guide Gas Flow voltage 2-13
Ion Guide voltage 2-12
ion optics 1-4
ion source enclosure

fitting 8-23
removing 8-9

ionization techniques
APCI 1-3
APPI 1-3
ESI 1-2

ions per push (IPP) 2-6
IonSABRE

dual mode 7-4
IonSABRE APCI operation 7-5
IonSABRE probe

heater
replacing 8-49

stainless steel capillary, replacing 
8-43

tip, cleaning 8-42
IPP A-2
isolation valve

stem, cleaning 8-21
isotope distributions, incorrect 9-6
items exposed to solvent D-2

L
lamp
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replacing bulb 8-50
turning on 7-17

lamp status 7-19
LC Inlet

setting up 4-13
LC waste 1-20
LED

operate 1-15
vacuum display 1-15
vent sequence 1-16

LM Resolution 2-13
LockMass

dual 6-30
MS/MS 6-30

LockMass page 4-24, 6-30
LockSpray maintenance 8-52
log parameters A-13
loss of sensitivity 9-6

M
mains power

connecting to 1-18
isolating from 1-18

mains power socket 1-18
mains power unit 1-17
maintenance

handling 8-3
LockSpray 8-52
NanoLockSpray 8-58
safety 8-3
schedule 8-2
source 8-5

MALDI connection 1-10
Manual Fixed 2-22
Manual Profile 2-22
mass accuracy

calculating 4-6
nominal 3-7

mass range 2-14

MassLynx
Main window 2-2
opening 2-2
security 2-2

maximum retention time 4-28
MCP

conditioning 8-24
voltage 2-14

Minimum Points 3-5
minimum scan times 4-21
mobile phases, common ingredients 

D-3
modifying

functions 4-27
tasks A-11

modular LockSpray source 1-10
monitoring the acquisition 2-24
Motor connection 1-10
Motor connector 5-5
MS Function Editor 7-30
MS Method Editor 7-30
MS Method editor 4-16, 6-37

Acquisition page 4-19
Adducts page 6-29
Collision Energy page

DDA 6-16
MS/MS 4-26

Cone Voltage page 6-25
Exclude page 6-25
Include page 6-12
LockMass page 4-24
MS/MS page 6-8
Neutral Loss page 6-40
Peak Detection page 6-30
Product Ion page 6-38
Sensitivity page 4-25
Tof MS page 4-20
Tof MS/MS page 4-22

MS Profile 2-22
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options 2-22
MS scan 4-18
MS Scan function 4-17
MS Survey page 6-6
MS/MS page 6-8
MS/MS scan 4-18
MSMS LockMass 6-30

N
nano reference probe, assembly 5-11
nano-baffle 5-8
NanoFlow options 5-23
Nano-LC

nebulizing tip 5-28
PTFE support 5-25

Nano-LC sprayer 5-24
NanoLockSpray

baffles 5-8
camera lens 5-7
data processing 5-23
overview 5-2

NanoLockSpray maintenance 8-58
NanoLockSpray probe 8-59
NanoSpray connection 1-9, 5-6
Nebuliser connection 5-6
Nebuliser gas connection 1-10
nebulizer gas connection 1-14
Neutral Loss page 6-40
Nitrogen Gas In 1-19
no beam 9-4
noise levels

chemical 9-6
electronic 9-6

nominal mass 3-7
Np Multiplier 3-5

O
obtaining an ion beam

APPI 7-20
dual APPI 7-23
I

ESCi 7-27
opening

MassLynx 2-2
Peak display window B-7

operate LED display 1-15
operating

glass capillary 5-32
NanoFlow 5-28

operating mode, selecting B-2
overnight shutdown A-3

P
parameters

Centroid Threshold 3-5
Instrument page 2-13
log A-13
Minimum Points 3-5
Np Multiplier 3-5
resolution 3-5

PC Link 1-24
pDRE 3-6, 4-8
peak detection

DDA 6-30
how it works 6-34

peak display
customizing, display grid B-9
customizing, intensity B-8
menu B-7

peak display, customizing
colors B-7
numbers B-7
trace line appearance B-8

peak exclusion
dynamic 6-26
fixed 6-27

peaks
changing gain B-6
selecting the span B-5

photomultiplier tube 1-6
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pico-baffle 5-8
assembling 5-10
with glass capillary 5-29

pinging the EPC 9-2
PMT 1-6
power off, reboot 9-3
ppm error 4-7
Pre-Filter voltage 2-13
printing

tune information B-5
probe

removing 8-6
Product Ion page 6-38
Puller voltage 2-20
pump control socket 1-18
pump override 1-18
pump-down LED sequence 1-16
pump-down sequence

LED 1-16
Pusher Offset voltage 2-20
Pusher voltage 2-20

Q
quad peak display 2-5
quadrupole 1-4
Quadrupole MS Profile 2-22
quadrupole options 2-22
quick tuning 2-8

R
readback B-4
readback windows

display B-4
Readbacks dialog box B-4
real-time update

Chromatogram 2-25
Spectrum 2-25

reboot
power off 9-3
TELNET 9-3

reference probe capillary
LockSpray 8-52
NanoLockSpray 8-58

removing
baffle 5-9, 8-7
existing capillary 8-31
ion block 8-9
ion source enclosure 8-9
nebulizing gas line, 

NanoLockSpray 8-59
probe from source 8-6
sample cone 8-7
source ion guide 8-10

repeller electrode 7-3
replacing

corona discharge pin 8-41
ESI probe stainless steel capillary 

8-31
ESI probe tip 8-26
ion block cartridge heater 8-28
IonSABRE probe heater 8-49
IonSABRE probe stainless steel 

capillary 8-43
reference probe capillary

LockSpray 8-52
NanoLockSpray 8-58

resolution 2-6
checking 2-26
parameter 3-5

RF settings 2-21
collision cell 2-21
ion guide 2-21
MS Profile 2-22
quadrupole options 2-22

running Startup and Shutdown files 
A-12

S
Safety
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Information iii
Symbols vi

safety and handling 8-3
sample cone

cleaning 8-19
fitting to instrument 8-24
removing 8-7

Sample List
acquisition 4-2

Sampling Cone voltage 2-12
scan time 4-21
scan time, selecting B-3
scans

MS 4-18
MS/MS 4-18

scroll pump 1-22
Security, MassLynx 2-2
selecting

instrument name B-9
source 5-20

selecting the peak span B-5
sensitivity

decrease 9-6
Sensitivity page 4-25
Service Bus 1-24
setting

detector voltage 3-8
setting a solvent delay 4-28
settings

EDC 3-6
TDC 3-6

setup
acquisition 3-5

shutdown
complete A-3
emergency A-3
overnight A-3

Shutdown Editor A-5
Shutdown Log A-12
I

Shutdown page A-5
sockets

mains power 1-18
pump control 1-18

sodium formate solution 3-22
sodium hydroxide 3-22
solvent

items exposed to D-2
Solvent Delay dialog box 4-28
source configuration 1-12
source exhaust 1-20
source ion block

assembling 8-22
disassembling 8-13

source ion guide
removing 8-10

source ion guide assembly
cleaning 8-20
disassembling 8-12

source optimization
APPI 7-20
dual APPI 7-23
ESCi 7-27

Source page 2-6
Source page settings 2-12
Source Temperature 2-12
source T-Wave assembly

assembling 8-22
source waste 1-20
source, cleaning 8-5
Spectrum real-time update 2-25
SPEED LED 1-24
sprayers

glass capillary 5-29
nano reference 5-11
nano reference, tip position 5-22
Nano-LC 5-24

starting the instrument A-2
status display 1-15
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Steering voltage 2-20
switches

electronics 1-17
EPC & Auxiliary 1-18
vacuum 1-17

syringe pump
controlling B-2
setting-up C-1

syringe pump rate 2-12
Syringe Selection dialog box B-2
syringe type, selecting B-2

T
tabbed pages

Acquisition 4-19, 6-6
Adducts 6-29
Collision Energy 4-26, 6-16
Cone Voltage 6-25
Exclude 6-25
Include 6-12
LockMass 4-24
MS Survey 6-6
MS/MS 6-8
Neutral Loss 6-40
Peak Detection 6-30
Product Ion page 6-38
Tof MS 4-20
Tof MS/MS page 4-22
Variable Flow 6-37

TDC threshold settings 3-6
TELNET, reboot 9-3
Threshold 3-5
tip position 5-22
Tof analyzer 1-4
Tof MS page 4-20
Tof MS/MS page 4-22
Tof peak display 2-5
Transport 1 voltage 2-19
Tube Lens voltage 2-20

Tune Acquire dialog box 2-24
tune information, printing B-5
tune parameters

changing B-5
Tune window 2-2, 2-3, B-1

acquisition 2-23
changing display colors B-8
changing number of traces B-8

tuning
APPI 7-20
compounds 2-8
dual APPI 7-23
ESCi 7-27
ESI 2-7
quick 2-8
setting parameters 2-9
setup parameters B-3

Tuning page 2-6
tuning parameters 2-21

Instrument page 2-13
types of contact closure 1-23

U
Uncal.cal 3-17
unsteady beam 9-4
use

intended xii
using

DDA 6-3
UV lamp

replacing bulb 8-50
turning on 7-17

V
vacuum LED display 1-15
Variable Flow page 6-37
Veff 3-6
vent LED sequence 1-16
venting A-3
Video Out connection 5-5
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V-mode
ion optics 1-5

W
waste bottle 1-20
Waters, contacting 9-7
windows B-4

Main 2-2
Tune 2-2, 2-3, B-1

wizards
Inlet Configuration 4-13

W-mode
ion optics 1-5

Z
zoom 5-8
I
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